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Introducing MacGraphX 
MacGraphX is the essential Macintosh graphics, charting, and 
presentation tool for business and science. Using MacGraphX, you can 
load data from a wide range of sources, and graph any subset of 
records or fields. Create scatter, line, area, bar, stacked bar, table, and 
pie charts. Easily transpose or overlay charts, annotate them, change 
their colors, shade them, stretch them, or move them - with just a 
few mouse-clicks. 

Dramatic, Vivid Display 
MacGraphX's color capabilities offer the smoothest graduated fills 
around (from aqua to cobalt blue, for example). MacGraphX uses 
true colors, not dithered patterns, so your graphs are free of blotching, 
moire patterns, or banding. You can even impose patterns over 
graduated colors, to create customized visual effects. 

Open Data Architecture 
MacGraphX offers an underlying extensible, recalculating data 
architecture. Fields can be based on formulas. Whenever you revise 
your data, fields are recalculated and graphs are updated 
automatically. 

Because MacGraphX is built on an open data architecture, you can 
extend the set of file types MacGraphX can load. Translate and 
download data from a mainframe or scientific instrument in one step. 
Add in your own curve fits, statistical analyses, and data 
transformation routines, for increased clarity and precision. 

One-Step Operation 
MacGraphX brings you an uncluttered interface, with most commands 
directly accessible from the menus; functions aren't hidden within a 
maze of dialog boxes. MacGraphX's interface provides speed of use 
for the power user along with ease of use and learning for the novice. 
Select records with one click and drag. Create a graph in one step. 
Change fonts, colors, and patterns, with lightning speed. You get 
complete control of what's on your screen, thanks to logical menu and 
floating palette commands . 

Introducing MacGraphX 1 



Using MacGraphX 
Enter your data directly, using the familiar row-and-column layout in 
the Data Window; or import data from your favorite spreadsheet or 
database (such as Excel, MacCalc, Lotus 1-2-3, or FileMaker); or 
download data from a mainframe or scientific instrument. 

To create your graph, with one click of the mouse select the records 
you want graphed. Click to select the X-axis, and click again to select 
the categories for the Y-axis. Choose the type of graph you want 
from the menu, and your graph is done. Once you've created a graph, 
you can use its format as a template for additional graphs. Arrange 
your graphs on MacGraphX's Page Layout window, and print them to 
your Image Writer, laser printer, or film recorder. 

Introducing MacGraphX 2 
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About This Manual 
This manual contains everything you need to know about using 
MacGraphX. To learn how to install MacGraphX on your system and 
the basic concepts behind MacGraphX, read MacGraphX Basics first. 

If you're ready to get started using MacGraphX with your own data, 
read MacGraphX Quick Start. Even if you never read manuals, look 
over these few pages to get up and running. 

To learn how to use MacGraphX, work through the tutorials in 
Leaming MacGraphX and Additional Exercises. 

Working in the Data Window, Creating a Graph, Stntcturing Your 
Graph, and Formatting Your Graph describe in detail the common 
operations of MacGraphX. Working in the Layout and Letterhead 
Windows and Building Fonnulas discuss special features of 
MacGraphX. About the Palette and Menus and Dialogs illustrate the 
menu commands and dialog boxes. 

The Appendix contains illustrates parts of a graph, and the Glossary 
contains an explanation of terms used in this manual. The Quick 
Reference card contains a summary of shortcuts and keyboard use. 

This manual assumes that you have a basic working knowledge of the 
Macintosh, including how to open and close files, use a mouse, and 
perform actions such as double-clicking and shift-clicking. If you do 
not have familiarity with Macintosh fundamentals, consult the owner's 
manual that comes with your Macintosh. 

About This Manual 3 



Chapter 1: MacGraphX Basics 
In this chapter, you'll learn the basic concepts of MacGraphX, as well 
as how to properly install it in your system. You should read this 
chapter before working through any of the tutorials. 

Minimum Requirements 
Using MacGraphX requires the following: 

• A Macintosh Plus with one megabyte of RAM 

• Two SOOK disk drives, or one SOOK disk drive and a hard drive 

• System 6.0.3 or later 

• 32-Bit color QuickDraw for use with a color system if using 
system 6.0.3 or 6.0.4 

Checking Your MacGraphX Package 
Your MacGraphX package should include the following: 

• One MacGraphX disk containing the application; the file 
translation specification folder (MG.FSPECsf); the transforms 
folder(MGJCFRMs.f); the help file (MacGraphX.Help); and the 
tutorial files (Tutorial and Tutorial II) 

• One manual 

• One Quick Reference card 

• One registration card 

If your MacGraphX package doesn't include all of the above, contact 
Bravo Technologies. 

Installing MacGraphX 
Before doing anything, copy your MacGraphX disk to another floppy 
and store the MacGraphX original in a safe place. Use the backup 
copy for the installation. This way, if anything should happen to your 
working copy, you'll have the original disk intact. 

MacGraphX Basics 4 

r::: 



::::::::.:!.1====-:}~ 

==1::::::=~:i 
l 

Installing MacGraphX: On a Hard Disk 
To install MacGraphX on a hard disk do the following: 

• Create a new folder on your hard disk to contain your 
MacGraphX files. 

• Copy the MacGraphX application from the MacGraphX disk to 
your new folder. 

• Copy MacGraphX.Help from the MacGraphX disk to your new 
folder. 

• Copy the Tutorial files from the MacGraphX disk to your new 
folder. 

If you're not sure how to copy from one disk to another, see your 
Macintosh owner's guide for help. 

On a Double BOOK Floppy Setup 
To use MacGraphX on a double SOOK floppy disk setup, do the 
following: 

• Keep your System Folder containing the System, Finder, and 
printing resource on one BOOK disk (do not use an original 
system disk). 

• Copy the MacGraphX application and its accompanying files 
and folders from your MacGraphX disk to the second BOOK disk. 
Make sure the Help file stays in the same folder as the 
application. 

Becoming a Registered User 
To become a registered MacGraphX user, fill out and send in the 
registration card in the back of this manual. As a registered user, you 
can use Bravo Technologies' technical support line (415/841-8552, 
between 10 a.m. and 5 p.m. PSU. You will also receive notification of 
product upgrades and new product releases. 

About MacGraphX Documents and the ""Desktop" 
When MacGraphX opens, it presents you with its own special 
"desktop." Several icons are located in an untitled docking window at 
the left of your screen. In the center of the screen, partially obscuring 
the docking window, is an open window entitled Data. 

MacGraphX Basics 5 
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A MacGraphX document consists of both the data used to create 
graphs and the graphs themselves. 

Shrinking Windows and Icons 
Graphs and data comprising a MacGraphX document are contained in 
their own windows. These windows can be shrunk to icons contained 
in the docking window on the left side of the screen. When reduced 
to icons, inactive windows won't clutter the screen. You can open 
windows or shrink them into icons in the docking window at any 
time. Your data and graphs always remain intact when appearing as 
icons. Clicking in the close box of a window will shrink it to an icon. 
Double-clicking on an icon will open it to a window. You can also 
use commands on the Windows menu to open or close a window. 

About the Docking Window 
If the docking window is obscured by the data window, graph 
windows, or any other window, you can bring it to the front by 
clicking on the docking window title. When the docking window is in 
front, you can resize it by clicking and dragging its lower right comer. 

To reorganize icons in a newly resized docking window so that they 
all appear in the window, hold down the Option and Command keys 
and double-click anywhere in the docking window, or use the Clean 
Up Icons command from the Windows menu. 

MacGraphX Basics 6 
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About the Data Window 
Each time you launch MacGraphX from the Finder, you'll have a blank 
data window in which to enter your data or import data from another 
application. 

Your data is always contained in this data window. The data window 
has three main components. Each individual piece of data is contained 
in its own cell. Data can be either numeric or alphabetic. 

Each row of cells forms a numbered record. 

__ 4_~1 ..................... 93)East ................... 1 ................... 1.80) ................ 3600_l 

Afield (column) is a set of information of one type vertically spanning 
all the records. 

Revenue I 
. 20001 
1 2500\ 
1 ................ 31.00) 
1 3600\ 
1 22001 
1 2400) 
1 2900) 
1 3300) 
1 19001 
i 2100) 
l 21001 
l ................ 3000.l 
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The set of records and fields comprise the dataset for the file. Each 
record contains related numeric or alphabetic information organized 
by field and contained in cells. An entire dataset looks like this: 

g Doto 

•RHs• Y•air Region S,alrs R•venue, Costs Profits 
I o hst 1001 20001 13001 7001 
2 91 IEut 1251 25001 15751 925! 
3 92!hst 1~1 31001 19051 119SI 
4 93I£ut 1801 36001 21801 14201 
5 90iVut 1101 22001 14101 7901 
6 91!'w'ut 1201 24001 1S20I 8801 
7 92\'WHt 14SI 29001 17951 11051 
0 931Vut 1651 33001 20151 12851 
9 90INorth 951 19001 12451 65S! 

91 INorlh 1051 21001 13551 7451 
92/North 13SI 27001 16851 101sI 
93INorth 1S0I 30001 18501 11501 

I I I I I 

You select different combinations of records and fields--rows and 
columns--to generate your graphs. 

Getting Data Into MacGraphX 
Your first step is always to get your data into MacGraphX's data 
window. You have two ways to do so: manually enter the data cell by 
cell, creating new rows and columns as you go along., or import it 
from other applications. MacGraphX can read in files created by 
MacCalc or Excel and can read files created in WKS or WKl formats 
from Lotus 1-2-3, or tab-delimited ASCII or SYLK from a database or 
spreadsheet application. For a description of these file formats, see the 
Import Data command in the chapter Menus and Dialogs. You can 
also extend the set of file types that MacGraphX can recognize by 
using the small CreateFFIX application that is on your MacGraphX 
disk. 

Selecting Fields 
You'll select a field to define the data for the graph along the 
independent axis (in the horizontal or x direction), and one or more 
other fields to define the values that are measured on the dependent 
axis (in vertical or y direction). 

You'll also need to select a range of records to graph. With both a 
range of records selected and the fields chosen, one command from 
the Graph menu will create the desired graph. 

MacGraphX Basics B 
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About Graphs and the Graph Window 
Every graph has two frames which define the positions of graph items, 
the graph frame and the data frame. Only the data frame is visible 
when you create a graph. The data frame encloses the data that make 
up the graph. All field elements such as bars, marks, lines, and areas 
are contained within this frame, as are grid lines. 

The graph frame contains the data frame and overlaps the axes. It can 
be enlarged independently of the data frame to create a margin 
around the graph. The graph frame can't be made smaller than the 
data frame, nor can the data frame be made larger than the graph 
frame. 

._ placement 
ln,me 

g,oph rifle ------ Gr11ph •2 g,oph 1n,,.. 

; 
data 1n,,.. } """11;" botw.cn 

gn,ph&clcta lnunet 

independent 
major grid 

The largest frame in the graph window is the placement frame. This 
frame contains everything in the graph window. A graph object can't 
be moved outside of the placement frame. The placement frame is 
useful for placing your graph in the window or on the page. The 
placement frame can be enlarged to enclose an entire page or a 
number of pages. Enlarging the placement frame makes it possible to 
make the graph much larger, even by as much as several pages. 

MacGraphX Basics 9 



Selecting Graph Objects 
You select graph objects before you can give commands that affect 
those objects. An object is any part of a graph or any user-drawn 
graphic that appears in the graph window. To select on object that is 
part of the graph (frame, axis, tick, etc.), you can choose it from a 
submenu on the Objects menu. 

•I I 

Show :■:I 

llicle :•:) 
Reset Rttrlbutes 
fle~l' t l (I( ll tlon 
Reset Grnph Order 

✓Rnchor to Frome 
Cinm• ro rrnm1' 
Align ► 

D1ing 1 o rrnn t :•:II 
Sl'llll to llo1:l:: :■:,J 

Select All ► 
Full Groph ► 
Fields ► 
Independent AHIS ► 
Dependent AHIS ► 

You can also select an object by clicking on it with the mouse. Field 
elements (bars, lines, marks, areas, and pieces of pies) must be 
selected by clicking on their indicators in the legend. When selected, a 
field indicator is surrounded by a faint dotted line. 

l ■ R~enue l 
=···············~····················= 
ml Costs 

When labels or titles, grid lines, ticks, or axes are selected, a faint 
dotted line appears around them. Resizable objects such as frames, the 
legend, and user-drawn graphics have resizing handles at each corner 
and side. User-drawn lines have a resizing handle on each end. Click 
and drag these handles to resize an object. 

Also, you can select objects via special power selection keys that 
specify classes of object. For example, typing the letter "g" and a 
Return will select all grid lines on the frontmost graph. 

MacGraphX Basics 10 
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The Floating Palette 
Graphs are contained in windows. Floating above a graph window, 
initially on the right, is MacGraphX's palette. The palette provides you 
With tools to change the appearance of objects in a graph window. 
The palette has three commands: Color (useful for those with a color 
system), Pattern, and Mode. There is a list of selectors such as Fill, 
Line, Drop, and so forth on the palette as well. These enable you to 
spcify the aspect of a selected graph object to change when you give 
a command from the palette. 

4 ob ·•cts 

I ► 

.. .J~ i..~:J~ 

Left :395 Top :58 
Width :85 Height :68 

CLJ ► □Gr-id 

[D ► 

Using the palette is similar to using standard menus. First, select an 
object to change in the graph. Then choose the part of the object to 
modify (Fill, Line, Drop, etc.) by clicking on the selector in the palette. 
Finally, give a command by clicking on the arrow (next to a menu's 
current value indicator) and dragging the cursor to the desired new 
value on the menu. When you release the mouse, the selected object 
in the graph changes its appearance. 

□Gr-id 

[D ► 

When you're not using the palette, you can roll it up by clicking in the 
palette zoom box in the upper-right corner of the palette's title bar. 
You can also move the palette anywhere on the screen by clicking 
and dragging the palette's title bar. 

MacGraphX Basics 11 



About the Legend 
Every graph has a legend (also called the key) which shows the 
correspondence between data elements and fields. The legend 
normally appears on the upper right side of the graph window. Field 
items such as bars, areas, marks, and lines can be selected by clicking 
on a field indicator in the legend. 

'West 

mill Costs 

li1 Revenue 

The legend can be shown and hidden 1ike any other graph object. It 
can also be moved anywhere in the graph window and resized. 

The Next Step 
You've now installed MacGraphX and learned many of its basic 
concepts. Understanding the basics before starting either tutorial will 
make learning MacGraphX much easier. Move on to MacGraphX 
Quick Start if you want to get started with your work as quickly as 
possible, or tum to Leaming MacGraphX for a more in-depth 
introduction to this program. 
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Chapter 2: MacGraphX Quick Start 
If you're reasdy to get started right away, keep reading. (For a more 
thorough introduction to MacGraphX see Learning MacGraphX) 

Launch MacGraphX by double-clicking on its icon in the Finder, or 
select the icon and choose Open from the Finder's File menu. 

Before you can create a graph, you need to type in data, or import it 
into MacGraphX. 

To Manually Enter Data 
You'll need to type in data for each record one cell at a time. 
(Because the emtpy top-left cell will be already selected, you won't 
need to select a cell to enter data.) Here's how to enter data, record 
by record: 

1. Enter data for first cell 
Type in the data for the first cell. 

~ •Recs• 
9 

2. Create new cell 
Press the Tab key to create a new cell. 

MacGraphX Quick Start 13 



3. Enter data for first record 
Continue entering data; use the Tab key to create 
new cells until you've finished entering the data for 
one complete record (row). 

4. Start seco11d record 
When you've finished entering data for the first 
record (row), tab twice. Now, you're in the first field 
(column) of the second record. 

69 32 •t 961 

4. E11ter datafor other records 
Begin entering data for the new record. 

Continue using the Tab key to create cells and 
records, making sure you enter cell data in the same 
sequence as you've entered data in preceding 
records. 

You can create up to 2500 records and 125 fields in the data 
window. If you want to enter data field-by-field (filling one column 
with data before moving over to the next column), you can use the 
Return key to create a new cell and move down to the next record in 
the same field (column); press Return twice to end the current field 
and begin a new one. 

To Import Data 
MacGraphX lets you import prepared data in many different file 
formats. (For a description of those file formats, see the Import 
Data command in the Menus and Dialogs chapter; you can define 
new file formats for MacGraphX to load and translate with the 
CreateFFJXutility.) Here's how to import data: 

1. Select file format 
From the File menu, choose Import Data; from the 
Import Data submenu, choose the desired file 
format, or choose All. 

2. Open file 
Locate the file in the dialog and click Open. 

MacGraphX Quick Start 14 ~ 
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3. Make dialog choices 
In the Load dialog, you have several choices. (See the 
Import Data command in the Menus and Dialogs 
chapter for an explanation of the options.) 

Click OK. 

You can import up to 2500 records and 125 fields into the data 
window. 

Select Fields and Records 
With the data either manually entered or imported into the 
MacGraphX data window, you're now ready to create a graph. The 
procedure for defining a graph consists of four easy steps: 

• Choose the records to graph. 

• Define the independent (x) field. 

• Define the dependent (y) fields. 

• Choose the graph type. 

Choose the Records to Graph 
Select the desired record numbers from the Recs# column. 

• To select a single record, place the cursor on its number in the 
Recs# column and click. 

• To select a range of records, click and drag the cursor vertically 
over the desired record numbers. 

• To select several discontinuous records, click on the desired 
record numbers while holding down the Command key. 

• To select all records at once, place the cursor at the top of the 

Recs# column and click. The cursor will look like this: ~-

Define the Independent (x) Field 
The independent field is the category against which your data will be 
plotted. The independent field usually is graphed along the horizontal 
(x) axis. 

MacGraphX Quick Start 15 



1. Select independent.field 
Place the cursor in the thin horizontal box just above 
the name of the desired field. When you do this, the 
cursor turns to: -·-. (Note the horizontal shape of this 
cursor, to remind you that you're selecting the field 
for the horizontal axis.) Click to specify a field; this 
box turns gray. 

Year Region 

...................... 90)East ................... · 

...................... 90)North ............. ...1 

...................... 90)'w'est ............... J 

Deline the Dependent (y) Field 
The dependent field, which is usually plotted along the vertical (y) 
axis, indicates the values of selected data. 

1. Select dependent.field 
Choose one or more fields by clicking and dragging 
the cursor across the desired field names. The cursor 

■ 

will look like this: ii. (Note the vertical shape.) 

To extend the selection of fields, click the mouse on 
a field name while holding down the Shift key. To 
select non-adjacent field names, or deselect fields, 
click on the field names while holding down the 
Command key. 

Revenue Costs ------ ;I 
. 2000 1 1300 1 
! 1900) 1245) 

1 ................ 2200.1.. .............. 1.41.0) 

0' 

lr, 
t 
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Create the Graph 
With one command, you create the graph. 

1. Choose the desired graph type 
From the Graph menu, select New Graph; from the 
New Graph submenu, select the desired graph type. 
(For a list and description of available graph types, 
see Types of Graphs in the Appendix.) 

Your first MacGraphX graph appears on-screen in a graph window. 
To specify formulas and formats for your data, make formatting and 
structural changes to your graph, or lay out and print your graph, see 
the relevant chapters in this manual. 

MacGraphX Quick Start 17 



Chapter 3: Learning MacGraphX 
rn this chapter, we'll cover how to open a prepared MacGraphX file 
containing hypothetical financial data, select the desired 
information co graph, create three graphs, and make formatting and 
structural changes to two of these graphs. 

Before you begin, you need to install MacGraphX and the Tutorial 
and Graphs files. To do so, see the lv/acGrapbX Basics chapter. To 
get the most from this tutorial, read MacGrapbX Basics first. 

You'll use the sample Tutorial file included with MacGraphX. You'll 
learn how to create graphs, and how to make several basic 
formatting and structural enhancements to your graphs. 

This tutorial takes about one hour to complete. If you want to take a 
break from the tutorial, you can save your changes to a file and quit 
MacGraphX at any time. To continue working later, just double-click 
on this saved file from the Finder to open it. 

Launch MacGraphX 
First things first. 

1. Lau11ch the program 
Launch MacGraphX by double-clicking on its icon 
in the Finder, or select the icon and choose Open 
from the Finder's File menu. The MacGraphX 
desktop and a blank data window will appear on­
screen. 

r S FIie Edit Groph 1111)<,< t, TeHI I.in,.•, llrPIIS Windows 
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2. Open the Tutorial document 
Select the Open command from the MacGraphX 
File menu. In the dialog, select the Tutorial file in 
the MacGraphX folder; open it by clicking on the 
Open button or by double-clicking on the file 
name. 

The data window, displaying the financial information you'll use to 
create graphs, appears on-screen. 

, • File Edit Groph Ohje, ts TeHI LitH)S llrt!llS Windows 

3. Save a copy of the Tutorial file 
You'll use a copy of the Tutorial file for your work. 
This will preserve the Tutorial file for future use, or 
in case you make a mistake and want to start over. 
From the File menu select Save As. In the dialog, 
give the file a different name of your choosing. 
Click Save. 

In the first part of this tutorial, you'll create a commonly used graph 
called a bar graph. Bar graphs display data as vertical or horizontal 
bars. The first graph you'll make will compare the value of two fields, 
Revenue ,fnd Costs, for the fiscal year 1990 in each of three regions. 

The independent axis, usually appearing as the x (horizontal) axis, 
will plot the regions. The dependent axis, usually they (vertical) 
axis, will display values for the Revenue and Costs fields. 
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Creating a Bar Graph 
I. Enlarge the data window 
Click on the zoom box in the upper-right corner of 
the data window. The window now completely 
displays all the fields and records it contains. 

2. Sort the records by year 
Place the cursor over the name of the field "Year·· 
while holding down the Option and Shift keys. The 

cursor now looks like this: I;;. (Note the shape of 
the cursor, which indicates moving or sorting rows.) 
To sort the records by year, click the mouse. 

•Recs• Ye~- Region I 
1---1=--_,....,_11::_......;9,,.;;0'"'East ................... · 
__ 2_--t••····················91_.l East ................. ..l 
__ 3_--t••····················92.lEast ................... • 
.....__4 _ __. ...................... 93.\East ................... l 
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3. Select the records 
Select the first three records in your newly sorted 
dataset by clicking and dragging on numbers 1, 9, 
and 5 in the Recs# column. Your cursor now 
functions as a record selector, and looks like this: 

~ 

•Recs• Vear Region 

...................... 90.iEast ................... · 

...................... 90.iNorth ................ i 

...................... 90)'w'est ............... ..l 

4. Define the independentfield (x axis) 
First, you'll define the field "Region" as the field to 
be plotted on the horizontal x axis. To do so, place 
the cursor in the thin box above the name of the 
field "Region"; the cursor turns to: -·-. (Note the 
horizontal shape of this cursor, to remind you that 
you're selecting the field for the independent axis, 
which is usually horizontal.) Click once. The thin 
box above the field name turns gray. 

Vear Region 

...................... 90.iEast ................... · 

...................... 90)North .............. ..l 

...................... 90)'w'est ............... ..1 

5. Define the dependent.fields (y axis) 
Now define the fields that will be measured by 
values on the vertical y axis and will appear as the 
bars in your graph. Place the cursor over the name 

■ 

of the field "Revenue"; the cursor turns to: ■. (The 
vertical shape reminds you that you're selecting 
fields for the verical axis.) Click and drag to the 
right over the "Costs" field. 

Revenue Costs 51 
· ................ 2000.1.. .............. 1.300) 
i ................ 1.900.i ................ 1.245) 
i ................ 2200.1.. .............. 1.41.0_i 
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Your data window now looks like this: 

't'•.tir Rlf9lon S.111.-s Profits 
901Cut I 1001 20001 t3001 1001 

---9-0l~l---951~1~1~1----
90l~l ___ 1_1_ol~l~l~l----
911cut I 1251 2500[ 1=1 9251 ___ _ 

f--=-+---~9~1: INo,th [ 1051 2100[ 1=1 145[ 
91 [~1---1-2-0i-- 2400[~1~1----

1----+----9-21~-,---l-4-5l~l~l~-l----

92lcut ! 1551 31001 19051 1195[ 
92[No,th j 135i 2700I 1685[ 1015I 

,-....~e~-+---c9-=-31vut ! 1651 33001 20151 12es1 

93[Cut I 1001 36001 21001 1<20I 
f-...,.;,,-+----=9~3[11orth 1--1501 30001 18501 11501 ___ _ 

i---i---,---1---1---1---

6. Create the bar graph 
From the Graph menu, choose New Graph; from the 
New Graph submenu, choose Bar. 

Op lions ► 
Bl1mk IOrow) XO 

1JI•I1•tl' r,rnI>h Sc11tter XI 
1'1111:e lil'ilph ► Line X2 

Print l)uli:k ... 
Rreo 003 

Sm•e f'i< t n, ... Stocked Bor 3&5 
11.•mplnte ... Pie 3&6 

lrnnspo~I' 
Tobie 007 

l.il!Jel'~ ► 
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Your first MacGraphX graph appears on-screen and is automatically 
titled Graph #l. 

' s . F_l.le Edit Graph Objects Te HI Lines Areas Windows 

m 

.. .. 
Q 

Tutorlol 

Graph #1 
Graph• 1 

2:500 1 -------'-------- 1n:i;;.~ ~~~: 

2000 

1:500 

1000 

:500 

0 

E.s:t Nor-th 

Region 

t rn l"1o,cH 

►~ ► 

1~11 • 

Format the Graph 
In this part of the tutorial, you'll take the graph just created and 
change its appearance. 

Text Formatting 
1. Select the title 
Select the graph title, "Graph#}," by clicking on it 
once. The graph title is now surrounded by a faint 
dotted line, which indicates that it is selected. 

2. Change font to New York 
From the Text menu, choose Font; from the font 
submenu, choose New York. 

3. Make the text imderlined 
From the Text menu, choose Style; from the Style 
submenu, choose Underline. 

4. Highlight the title 
Click again on the title "Graph #l," highlighting all of 
its text. 
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5. Cha11ge the title 
Type in the new graph title: 1990 Costs and Revenue. 
To deselect the title, click once in a blank part of the 
graph window (click anywhere, but not on a graph 
object). 

Click in the palette's zoom box in the upper-right corner of the 
palette's title bar to close it and clear it from view. Once you've closed 
the palette, it looks like this: 

Your graph looks like this: 

19..90 OS and even e 
2500 

2000 ■ R.vf'nUf' 

D Costs 
1500 . . 

Q 

1000 

500 

0 
East North Y•st 

Region 

Reordering Bars 
To see the data for "Costs" before the "Revenue" data in the graph, 
you can change the order of the bars in groups. 

1. Select the Revenue field 
From tl1e Objects menu select Fields; from the Fields 
submenu select Revenue. Or you may click on 
"Revenue" in the legend, to the right of the graph. 
Once you've selected the field, it's surrounded by a 
faint dotted line. 

Learning MacGraphX 24 



-

~ 
::..:~ 
" -
l/ I! ,i.__J ~ _. 

-=~~'.T""'--l.J,,;:;:::~ 

I ' 
I , ,, 

™ _- . 
i,.,P I 1 1...--:,-· 

''✓' • ;L-

2. Reorder the fields 
Click and drag Revenue over Costs in the legend and 
release the mouse. The field elements (bars) will be 
reordered in the graph. To deselect the fields, click 
once anywhere in the graph window, but not on a 
graph object. 

I ■ R'l"enue I 
················"t'····················· 

lfHJI Costs 

--■--R~¥N.~-----------

--fill--€-~-----------------

■ Revenue 

lfHJI Cc-~ts 
................ ~······--··········· 

iffi Costs 

(.■ __ Revenue ________ ..] 

Your graph now looks like this: 

.l.9_90 Costs and Revenue 
2500"T'"---------------, 

D Costs 

■ R♦nnu• 

1500 

1000 

500 

0 

Notice that the Costs field now precedes the Revenue field in the 
graph_ 
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Formatting the Dependent Axis Labels 
To make it easier to read values along the dependent axis, you can 
reformat the axis labels. 

Since the dependent axis represents large dollar amounts, you'll 
reformat it by giving it the "Currency 0" numeric format. This format 
places a dollar sign in front of each figure, leaves off decimals, and 
puts a comma before every three digits. 

1. Select the dependent axis labels 
From the Objects menu select, Dependent Axis; from 
the Dependent Axis submenu, choose Near Labels. 
Or you may click once on the dependent axis labels 
(the numbers along the vertical axis). Once you've 
selected them, the labels are surrounded by a faint 
dotted line. 

I' 

\how 
llld<! 
Reset Attributes 
IICH't Lorntlon 
Reset Gr11ph Order 

TIiie 
v'Anchor to Fr11me M11Jor Grid 

Grou• To Frnme Minor Grid 
Rllgn ► B11sellne 

U1ing to rront Ne11r AHIS 
\en1l to llnck . '. 
Select All ► 

Neer M11Jor Ticks 
Ne11r Minor Ticks 

Full Gr11ph ► 
Fields ► F11r AHIS 
Independent RHIS ► F11r L11bels .,.,. 

' Far Major Ticks 
Far Minor Ticks 
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2. Format the labels 
From the Text menu, select Num Format; from the 
Num Format submenu, select Currency 0. 

► 
Size ► 
Style 
llllgnnu•nt 
Rotation 

► 
►,,_------,. 
► New Format ... 

-'Same 11s Field 

Rnnot11te Type ► General 
Rnnot11te Pince ► FIHell 0 
Rnnot11tlon 611p... FIHell 1 

FIHell 2 
_s_1a~9=11e_1_· ---►-t FIHell 3 

FIHell 4 
Sci 2 

Hiding the Dependent Axis Title 

Sci 4 
I 1111rn111 O 
Currency 2 
Percent o 
Percent 2 

Since it's obvious to the viewer that the dependent axis displays data, 
you can hide the dependent axis title "Data." In addition, adding 
dollar signs and commas to the dependent axis labels with the 
Currency O format has placed the labels too close to the title, almost 
overlapping it. To rectify matters, do the following: 

1. Select the dependent axis title 
From the Objects menu, select Dependent Axis; from 
the Dependent Axis submenum select Title, or click 
on the axis title "Data" once. Once you've selected 
the dependent axis title, it's surrounded by a faint 
dotted line. 
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2. Htde the dependent axts tttle 
From the Objects menu, choose the Hide command, 
which hides (but dosen't actually eliminate) the 
dependent axis title. 

Show 

Reset Attributes ·it 

Reset Loc11tlon 
Res_et Gr11ph Order 

~nchor to Fr11me 
Grow To Fr11me 
Rllgn ► 

Bring to Front 
Send to B11ck 

Select All ► 
Full Gr11ph ► 
Fields ► 
Independent RHls ► 
Dependent RHIS ► 

Drop Shadows 
Now, you can enhance your graph's visual impact. You'll start by 
putting a drop shadow behind the field elements (bars) of your graph. 
To do so, you'll need the palette described earlier. To open the 
palette, click in the zoom box in the upper-right corner of the palette's 
title bar. If the palette now hides the legend (which it will on a small 
screen), click and drag the palette over to the left side of the screen. 

J. Select the fields 
Click once on the field name "Cost" in the legend, 
and then hold down the Shift key and click on 
Revenue. Once you've selected them, each field name 
will be surrounded by a faint dotted line when 
selected. (In MacGraphX, you can select multiple 
graph objects by clicking on them while holding 
down the Shift key.) 

Leaming MacGrophX 28 

cf.:: 
~ 
1-
L 
~ 
~ 

11 



:-j r; , 
/I, 

I I 

2. Specify the shadow pattern 
Click on Drop in the palette, and then click on the 
black arrow next to Pattern to open the Pattern 
menu. Drag the cursor to the following diagonal 
pattern (third row from top, third from left) and 
release the mouse: 

3. Specify shadow color ( optional) 
If you're using a color system, you can select a color 
(other than Black) from the Color menu on the 
palette. To open the Color menu, click on the arrow 
next to the Color status field. From the menu, select 
any color by clicking and dragging your mouse to the 
desired color, and then releasing it. 

4. Give the shadow a 3-D effect 
Select 3-D Shadow from the Areas menu. 

Rouncl Corners ► 

Shoclow Uert ► 
Shoclow Horlz ► 

I 

Surrouncl Shoclow 
Fonuorcl Shaclow 

&rou11 Size ► 
field \IZI' ► 
field Ofho~t. .. 
field Ordeo· ► 

Color Position ► 
Color Reuersal 
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Puning a 3-D drop shadow behind the bars makes the bars and 
legend look like this: 

Yest 

Enhancing Grid Lines 

1§1 Costs 

liJ Revenue 

You can further enhance your graph by making the major grid lines 
more visible, which makes interpreting the data easier. 

1. Select the depe11dent major grid 
Select the dependent major grid (the faint horizontal 
grid lines that correspond to the numbered ticks on 
the dependent axis) by going to the Objects menu 
and selecting Dependent Axis; from the Dependent 
Axis submenu, select Major Grid. You can also click 
once on a dependent major grid line to select the 
dependent major grid. Once you've selected the grid 
lines, they'll have faint dotted lines around them. 

I 1 • 

~hDUJ 

Hide 
Reset Rttrlbutes 
fJCH't lucotlllll 
Reset Graph Order 

v'flnchor to Freme 
<irc1111 Tu rruml' 
Rllgn 

Bring to Front 
Send to Boele 

Select Rll 
Full Graph 
Fields 
Independent RHIS 

Title 

Neer RHIS 
Neer Labels 

► Neor Major Ticks 
► Neor Minor Ticks 

► 
► 

For RHIS 
Far Labels 

Orprndrnl RIii\ ► Far Major Ticks 
Far Minor Ticks 
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2. Widen the grid lines 
From the Lines menu, choose Line Width; from the 
Line Width submenu, choose 3. These steps specify a 
line width of 3 points for the dependent major grid. 

TI< k length ► -;-
Length llrljusf ► _ 
TI< k Position ► 2 
Complete Grid 

Mane Type 

Cun•c flt ► '"r 
Cun•e :; Steps ► -
er Mnnrml 1lec<11< & 

_c_r c_n_lc_N_'o_w_----1 •?• 

3. Pattern the grid lines 
Choose this 100% black panern from the Panern 
menu on the palene (top row, second from left): 

4. Color the grid lines ( optional) 
If you have a color system, you can color the grid 
lines. Choose a color (other than White) from the 
Color menu on the palene. 
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Roll up the palette by clicking in its zoom box, and then click once 
anywhere in the graph window, but not on a graph object. These 
steps deselect the dependent major grid lines you've been working 
on. Your graph now looks like this: 

SI .ooo 

1500 

so 
Ea.st 

.1.9..90 costs and Reyonuo 

North 

Region 

■ Cost, 

• Rtvtf\Uf' 

Giving Yourself More Space 
You can now separate the axes from the graph's data frame by 
shrinking the data frame in from the graph frame which overlaps it. 
Shrinking the data frame creates a margin between the data frame and 
the axes, giving the graph a clean and elegant look. 

1. Select the dataframe 
From the Objects menu, choose Full Graph; from the 
Full Graph submenu, choose Data Frame. Or you 
can click on the data frame which is visible on your 
graph. Once you've selected the data frame, it's 
surrounded by a faint dotted line, and has resizing 
handles which appear on each comer and side of the 
frame. 
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$2,500 

$2,000 

$1,500 

$1,000 

$!500 

$0 

2. Reduce the data frame horizontally 
Press the Command key and click on the resizing 
handle on the left side of the data frame. Drag it 
horizontally inward (to the right) about a quarter of 
an inch. Doing so shrinks the data frame in from the 
dependent axis and the (currently invisible) graph 
frame. (The command key tells MacGraphX to move 
or resize one frame without modifying any other 
frame; in this example, the data frame is reduced 
while the graph frame retains its size.) As you reduce 
the data frame, you see: 

E.ast 

.l..9_90 Costs and Revenue 

North 

Region 

3. Shri11k the data.frame vertically 
With the data frame still selected, press the Command 
key and click on the resizing handle on the lower 
edge of the frame. Drag it up a quarter of an inch. As 
you reduce the frame, you see: 

l.9_90 Costs and Revenue 

Region 

OJ Costs 

Ill R• y.,.,. 
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Click once anywhere in the graph window but not on a graph object 
to deselect the data frame. Your graph now looks like this: 

S2,:soo 

S2,ooo 

St,:soo 

.,.ooo 

s:soo 

so 

1.9_90 costs and Revonue 

Cast North 

ReQton 

You've just finished formatting your first graph in MacGraphX. To 
recap, you've successfully done the following: 

• selected fields and records 

• created a bar graph showing Costs and Revenue by Region for 
1990 

• reordered fields (bars) 

• reformatted the dependent axis labels to display large dollar 
values 

• widened and patterned (and optionally colored) the grid lines 

• put 3-D drop shadows behind the bars 

• patterned (and optionally colored) the drop shadows 

• separated the data frame from the x and y axes to create 
margins 

The graph 1990 Costs and Revenue shows Costs and Revenue, two 
dependent fields, organized by Region, the independent field. In the 
following graph, you'll graph a single dependent field, Profits, over 
four years for three regions. Region will again be the field displayed 
on the independent axis, but it will be subdivided into years. Year will 
be a second independent field. Note that this doesn't mean another 
independent axis line, but rather a subdivision of the independent 
axis. 
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Bar Graph with Second Independent Axis 
Close Graph #1 by clicking in the close box in the upper-left corner of 
the window. You can also select Close Window on the Windows 
menu. The data window is now on-screen. To create a bar graph with 
a second independent axis, do the following: 

1. Restore the sort order 
Hold down the Option and Shift keys and place the 
cursor over the field name "Recs#." The cursor now 

looks like this: ~. Click the mouse. The records will 
be sorted by record number, and will return to their 
original positions. 

2. Select the records 
Place the cursor on record 1 and click and drag the 
mouse down to record 12. The numbered record 
indicators will blacken. 

3. Defi11e the independent.field (x axis) 
The independent axis, Region, is still selected from 
the first graph. Leave it that way. 

4. Defi11e the seco11d i11depe11dent field 
While holding down the Option key, place the cursor 
in the thin box above the name of the field "Year" 
and click once. The thin box turns a lighter shade of 
gray than that of the (primary) independent field, 
indicating that this is the secondary independent 
field. 

5. Define the depe11de11tfield (y axis) 
Place the cursor in the "Profits" field and click once. 
The field name will blacken. The two previously 
selected dependent field names are now deselected. 
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Your data window now looks like this: 
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6. Create the bar graph 
From the Graph menu ,choose New Graph; from the 
New Graph submenu, choose Bar. 

Your new graph looks like this: 

D ... 
0.. 

1500------------------------------------

1000 

500 -

0 -

-

-
Eaist North 

Region 

Ve-st 

■ 90 

0 91 

C n 
0 93 

Notice how each region is subdivided into four years with each bar 
representing profits for one year. In your first bar graph, no subgroups 
existed. You had only Costs and Revenue graphed by Region. 

Make any formatting changes you like to this graph to enhance its 
appearance. You may want to experiment with changing patterns, 
colors, and line widths. When you're ready to proceed with the 
tutorial, close Graph #2. The data window reappears on-screen. 
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Creating a Line Graph 
For your third graph. let's try a line graph. This is a common graph 
useful for showing how one continuous variable (a variable that can 
take any value in a range) changes in relation to another variable, 
such as trends over time. In this line graph, you'll demonstrate how 
three fields, Revenue, Costs, and Profits, change over four years, '90-
'93. 

Follow these steps below to select the fields and records you'll use to 
create the graph. 

I. Select the records 
Select records 1 through 4 in the data window by 
clicking and dragging on them in a downward 
motion. Your cursor tum into the record selector, 

which looks like this: e8,t. 

2. Define the independent.field (x axis) 
With the desired records selected, make Year the 
independent field. Place the cursor in the thin 
horizontal box above the name of the field "Year" 
(the cursor now looks like: - • -.) Click. The box turns 
gray. 

3. Define the dependent.fields (y axis) 
Select the dependent fields, Revenue, Costs, and 
Profits, by placing the cursor over the name of the 

■ 

field "Revenue" (the cursor now looks like this: .). 
Click in this field, and drag the cursor to the right 
across the Costs and Profits fields. The field names 
will blacken. 
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4. Create the graph 
From the Graph menu, choose New Graph; from the 
New Graph submenu, choose Line. 

Options ► 
Blank [Drawl XO 

Oelt~te &rn1>h scatter XI Plocc GraJJh ► 

Prln t Oulck ... 
Area X3 
Bar X4 Sm•c Pie t lls ... Stacked Bar XS lemplote ... Pie X6 

lrunSJ)OH' 
Table X7 

l<>!JCln ► 

A window titled Graph #3 appears on your screen. The graph looks 
like this: 

4000 

3000 

. . 2000 
0 

1000 

0 
,o 
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,. 
Year 

,2 ,3 

___. Costs 

~ Profits 

Text Formatting 
1. Select the title 
Select the graph title, "Graph #3," by clicking on it 
once. Once you've selected it, the graph title is 
surrounded by a faint dotted line. 

2. Change font to New York 
Select New York from the font submenu on the Text 
menu. 

3. Make the text underlined 
From the Style submenu, choose Underline. 

4. Highlight the title 
Click again on the title "Graph #3," highlighting the 
text. 
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5. Change the title 
Type in the new graph title: Financial Totals: 90-2.2. 

Click once anywhere in the graph window, but not on a graph object 
to deselect the graph title. Your graph title now looks like this: 

Financial Totals: 90-9..3. 

Number Formatting 
Because the dependent axis measures dollar values, as it did in the 
first bar graph, you will want to format the numbers along this axis 
appropriately. 

1. Select the dependent axis labels 
From the Objects menu, choose Dependent Axis; 
from the Dependent Axis submenu, choose Near 
Labels. You can also click once on the dependent 
axis labels to select them. Once you've selected them, 
the dependent axis labels are surrounded by a faint 
dotted line. 

\how 
lllde 
Reset Attributes 
ne~et lornllon 
Reset Graph Order 

TIiie 
~nchor to Freme Major Grid 

Grow To rrnme Minor Grid 
Align ► Baseline 

D1in9 10 rront 
\l!nd lo Bilek 

Neer RHIS 

Select All ► 
Neer Major Tlcl:s 
Neer Minor Ticks 

Full Graph ► 
Fields ► Fer AHIS 
Independent A His ► Fer Labels -, '. Fer Major Ticks 

Fer Minor Ticks 
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2. Change the number formatting 
From the Text menu, choose Num Format; from the 
Num Format submenu, choose Currency 0. 

Font ► 
Size ► 
Style ► 
lllll]llllll!llt ► New Format... 
Rotation ► 

-'Same as Field 

Annotate Type ► General 
Annotate Place ► FIHed 0 
Annotation Gap ... FIHed I 

► 
FIHed 2 

S11l!HJC!I' FIHed 3 
FIHed 4 
Sci 2 
Sci 4 

I 

Currency 2 
Percent D 
Percent 2 

As before, Currency O puts a currency sign in front of a number, 
leaves off decimals, and puts a comma before every three digits. Since 
the numbers along the dependent axis are large dollar amounts, this 
number format is most appropriate. 

Hiding an Axis Title 
The axis title "Data" isn't necessary, since it's obvious that the 
dependent axis displays data. When you reformatted the dependent 
axis labels, the labels came too close to the axis title, almost 
overlapping it. To solve this dilemma, do the following: 

1. Select the dependent axis title 
From the Objects menu, choose Dependent Axis; 
from the Dependent Axis submenu, choose Title, or 
click on the axis title "Data" once in the graph 
window. Once you've selected it, the title is 
surrounded by a faint dotted line. 

2. Hide the dependent axis title 
From the Objects menu, choose the Hide command. 
Doing so hides the dependent axis title. 
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Changing Fill Patterns 
You 'II need to open the palette to perform the following formatting 
changes. If the palette is currently closed, click in its zoom box (in the 
upper right of the palette's title bar) td open it. You'll use the palette 
to add a light fill to the data frame. 

1. Select the data frame 
From the Objects menu, choose Full Graph; from the 
Full Graph submenu, choose Data Frame. You can 
also click once on the data frame to select it. Once 
you've selected it, the data frame is surrounded by a 
faint dotted line. The data frame is the frame which 
surrounds the graph's field elements-lines, bars, 
marks, and the like -and overlaps the graph frame. 

, , . 
S(HllJJ 

111<1<, 
Reset Attributes 
fle~1Jt lo< ntlon 
Reset Graph Order 

~nchor to Frame 
Grow To Frnmr. 
Align ► 

ll1in9 1 o rrnn t 
SL•nl.l tn Hno:k 

Select RII 
Full (;1 aph 
Fields 
Independent RHIS 
Dependent RHIS 

Placement Frame 
► TIiie 

► ~~o~h Frame 

: Legend 
HI Mark 
Lo Mark 

2. Change the fill to a light gray 
With Fill on the palette selected, choose the lightest 
gray pattern from the Pattern menu (top row, second 
from right): 
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Formatting Grid Lines 
I. Select the dependent major grid 
Select the dependent major grid (the faint horizontal 
grid lines that correspond to the numbered ticks on 
the dependent axis) by going to the Objects menu 
and choosing Dependent Axis; from the Dependent 
Axis submenu, choose Major Grid. You can also click 
once on a grid line to select the dependent major 
grid. Once you've seleced them, the grid lines are 
outlined by faint dotted lines. 

\how 
llidc 
Reset Rttrlbutes 
llcii>t locnthlll 
Reset Graph Order 

TIiie 
~nchor to Frame 

Gl'Olll To Frnml' Minor Grid 
Rllgn ► Baseline 

DI1n9 1o Front Near RHIS 
\enll tD Onck Near Labels 

Select RII ► 
Near Major Ticlcs 
Near Minor Ticlcs 

Full Graph ► 
Fields ► Far RHIS 
Independent RHIS ► Far Labels 

Far Major Ticks 
Far Minor Ticlcs 

2. Widen the grid lines 
From the Lines menu, choose Line Width; from the 
Line Width, submenu choose 3. These steps specify a 
line width of three points for the dependent major 
grid. 
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3. Color the grid lines 
From the Color menu on the palette, choose White, 
or if you have a color system, any color other than 
Black. 

Left :71 Top :63 
Width :300 Height :97 

□Grid 

[CJ ► [O 

Adding a Drop Shadow 
1. Reveal the legend 
If necessary on a small screen, move the palette to 
the upper left side of the screen by clicking and 
dragging the palette's title bar. Doing so reveals the 
graph's legend. The legend for this graph looks like 
this: 

-- Revenue 

----- Costs 

--- Profits 
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2. Select the lege11d 
From the Graph menu, choose Full Graph; from the 
Full Graph submenu, choose Legend. You can also 
click once on the legend's border to select it. The 
legend's border is now outlined with a faint dotted 
line. 

I • 

\how 
llld<! 
Reset Attributes 
ne~et Leu utlon 
Reset Gn1ph Order 

✓Anchor to Freme 
Grau• ro rrnmr. 
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Select All 
run r.1 aph 
Fields 
Independent AHIS 
Dependent AHIS 

► 

Placement Freme 
► Title 

Graph Freme 
► D11t11 Freme 
► 
► HI Merle 

Lo Merl:: 

3. Specify the shadow patten, 
With Drop selected on the palette (the Drop selector 
indicates the drop shadow attribute for the legend), 
choose the 100% black pattern indicated below on 
the Pattern menu (top row, second from left). 

4. Specify shadow color ( optio11al) 
If you're using a color system, you can also select a 
color other than Black from the Color menu on the 
palette. Don't select White, which won't show up 
against the white background. 
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5. Give the shadow a 3-D effect 
Select 3-D Shadow from the Areas menu. 

Round Comers ► 

Shadow Uert ► 
Shadow Horlz ► 

I , I I 

Surround Shadow °" 
Forward Shadow 

1;rou1> SiZ(! ► 
lln(i \ize ► 
Line Clfhe t. .. 
Linn \hilt... 
ll1H Urller ► 

Color Position ► 
Color Reuersnl 

Your legend now looks like this: 

- Revenue 

--- Costs 

~ Profits 

Setting Line Widths 
Follow the steps below to widen the field lines in your graph, which 
makes them appear more clearly. 

1. Select the.fields 
Select all the graph's fields by clicking on Revenue in 
the legend, and then holding down the Shift key 
while clicking on Costs and Profits. Field names are 
now outlined with faint dotted lines. 
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2. Widell the li11es 
From the Lines menu, choose Line Width; from the 
Line Width submenu, choose 2. These steps specify a 
width of two points for the field lines. 

Rreos Windows 

nc k l.<Hl!J1h ► 7 
I-TI_< k_P,_,s_11_1o_n __ ►--l;;a 

Grow To Frome ~ 
CurnplC!ICl Grid 

► • Mork Type -1---------1 s 
Cun•<, flt 
Cun•o :; \ tt~ps ►-► 6 

er Mlllllllll tll)till( •?• 
er [nil: Now 

Line Patterns and Colors 
You can further enhance your graph via the following formatting 
cha~ges. 

I. Deselect the fields 
Click once anywhere in the graph window, but not 
on a graph object. 

2. Select the Revenue field 
Click on the field name Revenue in the legend. The 
field name Revenue is now outlined with a faint 
dotted line. 

3. Change the patter11 
From the palette's Pattern menu, choose this gray 
pattern (top row, fourth from the left): 

4. Change the line color ( optional) 
If you have a color system, you can also choose a 
color other than Black from the Color menu on the 
palette. Do not choose White. 
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5. Select the Costs field 
Select Costs in the legend by clicking on it once. The 
field name Costs is now outlined with a faint dotted 
line. 

6. Change the pattern 
From the palette's Pattern menu, choose this gray 
pattern (top row, third from the left): 

7. Change the line color ( optional) 
If you have a color system, you can also choose a 
color (other than Black) from the Color menu on the 
palette. Do not choose White. 

Changing Mark Types 
1. Select the Revenue field 
Select Revenue in the legend, by clicking on it once. 
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2. Change the mark 
From the Lines menu, choose Mark Type; from the 
Mark Type submenu, choose this mark (top row, 
second from right): 

m• ■ 

D □ 

TI< k length 
Ll'Ol_jlh lllljust 
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3. Select the Costs field 

► 
► 
► 
► 

► 
► 

Click on the Costs field name in the legend to select 
it. 

4. Change tbe mark 
From the Lines menu, choose Mark Type; from the 
Mark Type submenu, choose this mark: 

► 
11<klcn9th ► 
lt)n1Jlh lldjust ► 
TI< k Position ► 
Complete G11d 

m . • 
• Cun•c flt ► 
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♦ ♦ II 
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5. Select the Pro.fits field 
Select the Profits field from the legend, by clicking on 
the name of this field. 

6. Change the mark 
From the Lines menu, choose Mark Type; from the 
Mark Type submenu, choose this mark (third row 
from bottom, second from left): 

line Width ► 
nc k length ► 
ll~ng ti, lllljus1 ► 
nc k Pnsllion ► 
eomplu1 C G1icl 

m ■ 

0 eun•c flt ► 

+ m eun•c i; S te1>s ► 
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• ~ ♦ ■ 
lll Cl ♦ 0 

O 0 • 

Your graph now looks like this: 
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s2,ooo 
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Where to Go From Here 
Congratulations! You've just finished creating one line graph and two 
bar graphs. You've also made several formatting and structural 
changes using menu commands and commands on the palette. You 
now know how to: 

• select records and fields in the data window 

• create a graph 

• change patterns for filled objects 

• change line widths 

• reorder fields along the independent axis 

• add margins to a graph 

• add drop shadows to a graphic and give them a 3-D effect 

• format axis labels 

Now that you've mastered the basics of creating graphs, you're ready 
to use MacGraphX with your own data. For information about the 
other types of graphs you can create in MacGraphX, see the 
Appendix. For a complete explanation of basic graph terminology, see 
the Glossary. If you're already knowledgeable about graphs and 
would like more information about MacGraphX's formatting and 
structuring capabilities, read Structuring Your Graph and Fonnatting 
Your Graph. If you want to learn more about working in the data 
window, including sorting and grouping, see Working in the Data 
Window. If you're interested in calculating field values with formulas, 
or in using curve fits with scatter graphs, read Building Fonnulas. 
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Chapter 4: More Basics 
This chapter introduces more concepts and features that will help 
you use MacGraphX. 

Data Window 
Two important capabilities MacGraphX gives you when you're 
working with data are sorting and searching. These two features make 
it easy for you to find and organize your data for graphing. 

Sorting 
MacGraphX lets you sort your data in the data window, to put your 
data in the order you want for selecting and graphing. You can 
order records in the data window by ascending record number, or 
by another ascending field value, with one mouse click. You can 
also use the Sort command on the Edit menu to sort with up to 
three fields as keys in ascending or descending order. 

Searching 
You can search your data for the right information to graph. The 
Search command gives you the ability to select records matching 
specified criteria. Records meeting the criteria are automatically 
selected, and can be immediately graphed. You can gather these 
records and move them to the top of the dataset with the Move To 
Top command, or move them as a group to any part of the dataset 
with a click of the mouse. 

Graph Window 
When you create a graph, some parts of it are automatically visible. 
The graph has several elements, however, which aren't automatically 
shown, but which you can make visible. 

For example, every graph has sides that are symmetric images of 
each other: top/bottom and left/right. The left and bottom sides are 
called the near sides of the graph. The top and right sides are the 
far sides. When MacGraphX creates a graph, it automatically shows 
the axis, axis labels, ticks, and axis title for the near sides only. The 
identical far-side objects remain hidden until you decide to show 
them. 

Any part of a graph can be shown or hidden. A hidden grnph 
object may be selected and made visible using commands from the 
Objects menu. 
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Transposing Axes 
MacGraphX usually produces graphs with the independent axis 
running horizontally (as the x axis) and the dependent axis nmning 
vertically (as they axis). All values increase from left to right on the 
horizontal (x) axis, and from bottom to top on the vertical (y) axis. 

You can, however, transpose the axes when you create a graph, or 
transpose them in the graph window. You'll learn how in Creating a 
Grapb and Formalli11g Your Graph. 

Overlaid Graphs 
MacGraphX lets you create two graphs from the same dataset and 
overlay them. It's often useful, for example, to create a bar chart to 
emphasize individual quantities, and lay a line chart over it to show 
a trend over time as well. You can even graph different fields and 
records in each of the two graph layers. 
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On-line Help 
MacGraphX provides on-line help. To access it, double-click on the 
Help icon in the docking window, or by select Help from the Open 
Window submenu on the Windows menu. 

When Help appears, scroll through topics until you come to one 
that relates to what you're trying to do, and select it. Topics are 
organized by heading and subheading. If there's another topic 
closely related to one you select, it will appear on the See Also 
pop-down menu. To open this menu, click on the arrow next to "See 
Also." 
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General introductory information is first, pertaining to the desktop, 
the data window, and so forth. The second part of Help is a 
reference section devoted to menus. All MacGraphX menu 
commands are described in detail there. (Dialog boxes are 
described in Menus and Dialogs). Step-by-step how-to information 
follows. Finally, Help provides you with suggestions for getting the 
most out of MacGraphX, with Hints, Tips, and Tricks, and an 
explanation of error messages. 

You can move and resize the help window as you would any window. 
Size and position the help window for easy access while doing 
something unfamiliar in MacGraphX. Click on the help window to 
activate it when you need help, and then return to the task you were 
working on. This way, you can easily alternate between your work 
and the on-line help without opening and closing the help window. 

If Help and this manual should fail to answer a question, call Bravo 
Technologies' Help Line Monday through Friday from 10 a.m. to 5 
p.m. Pacific Standard Time. The number is 415/841-8552. Have your 
disk's registration number handy. 

Preferences 
MacGraphX lets you set a few basic parameters for how the program 
works. For example, by changing settings in a Preferences dialog, 
you can tell MacGraphX to alert you when you're performing an 
operation that can't be undone (such as modify or delete a field). 

The Preferences dialog also lets you specify the minimum distance 
between ticks on the axes of your graphs, and lets you name the 
dependent axis. If you do not enter a name of your own, "Data" will 
be used. 
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Chapter 5: Additional Exercises 
In this chapter, we've provided you with additional formatting 
practice using two of the graphs you finished in the Learning 
MacGraphX chapter. (Copies of the completed graphs are 
contained in a second tutorial file, Tutorial II, located in the 
MacGraphX folder.) To further refine your graph formatting skills, 
read on. 

Open Tutorial II 
Begin by opening Tutorial II. This file contains duplicates of the 
same graphs you created and formatted in the Learning MacGraphX 
chapter. 

1. Ope,i the file 
From the MacGraphX File menu select Open. In the 
dialog, select the Tutorial II file in the MacGraphX 
folder, and open it by clicking on the Open button 
or by double-clicking on the file name. 

2. Save a copy of the file 
So that you will have the original Tutorial II file for 
later use, choose Save As from the File menu. 
Rename the file as you wish, and select Save. 

Open the Bar Graph 
Bar Graph is a duplicate of the first bar graph you created and 
formatted in the Tutorial file. 

1. Open Bar Graph 
Open Bar Graph by double-clicking on its icon in 
the docking window, or by selecting it from the 
Open Window submenu on the Windows menu. 
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Your mission: to reformat Bar Graph so that it looks like this: 

$2,SD0-

$2,000-

$1,S00-

$1,000 -

$S00-

$0-

1990 Costs and Revenue 

East North West 

('.:]Co>lo 

■ Revenue 

Create More Room 
You'll want to enlarge the graph's title, which requires you to move 
the graph down to create more space for the title. First, you'll hide 
the independent axis title (at the bottom of the graph) to make 
some room. Next, you'll move the graph down to make room for the 
title. Follow these steps below to do so: 

1. Select independent axis title 
Click on the independent axis title "Region." 

2. Hide axis title 
Choose Hide from the Objects menu. 

3. Select graph frame 
Click on the data frame. It appears outlined with a 
faint dotted line and with resizing handles on each 
side and corner . 
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4. Move graph down 
Click and drag the data frame down toward the 
bottom of the placement frame (about a quarter of 
an inch on your screen). Do not push the 
independent axis labels into the surrounding 
placement frame, or allow the labels to touch the 
frame (otherwise you may accidently force the 
labels to be pushed up into the graph). 

1_9_90 Costs and Revenue 

The entire graph (except for the graph title) moves with the data 
frame. Objects such as axis titles, labels, and the legend are 
automatically anchored to the graph frame, which is linked to the 
data frame. When you move or resize the data frame, the graph 
frame usually moves or grows with it, which causes anchored objects 
to move. (The graph title isn't automatically anchored.) 

5. Move graph title down 
Because you're going to enlarge the graph title, first 
make more space for it by clicking and dragging the 
graph title down halfway between the graph and the 
top of the placement frame. 

Reformat the Graph Title 
1. Enlarge point size 
With the graph title still selected, go to the Text 
menu and choose Size; from the Size submenu, 
choose 18. 

2. Change font 
From the Text menu, choose Font; from the Font 
submenu, choose Helvetica. 
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3. Eliminate underline 
From the Text menu, choose Style; from the Style 
submenu, choose Underline to toggle off the 
underline. 

Reformat the Axis Labels 
Follow the steps below to give the graph's axis labels new text 
formatting. 

1. Select dependent axis labels 
Click on the dependent axis labels. 

2. Enlarge font size 
From the Text menu, choose Size; from the Size 
submenu, choose 12. 

3. Change font 
From the Text menu, choose Font; from the Font 
submenu, choose Helvetica. 

4. Change alignment 
From the Text menu, choose Alignment; from the 
Alignment, submenu choose Right. 

5. Select independent axis labels 
Click on the independent axis labels. 

Now repeat steps 1 through 3 above for the independent axis labels. 
Leave the independent axis labels center-aligned. 

Widen the Ticks 
To widen the dependent axis ticks (which makes them more visible), 
do the following: 

1. Select ticks 
Click on a dependent axis tick 

2. Widen ticks 
From the Lines menu, choose Line Width; from the 
Line Width, submenu choose 2. These steps increase 
the width of the ticks to 2 points. 

Click once anywhere in the graph window, but not on a graph 
object, to deselect the ticks. 
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Clean Up the Graph 
To give the graph a clean, uncluttered look, you can now hide many 
of its components. 

1. Select data frame 
Click on the data frame (the visible frame which 
surrounds the bars and grid lines). 

2. Hide dataframe 
Choose Hide from the Objects menu. 

3. Select other objects 
Select the independent axis by clicking on it once. 
Next, with the Shift key pressed, select the 
dependent axis, independent major and minor 
ticks, and dependent major grid lines. 

4. Hide objects 
Choose Hide from the Objects menu. 

Reformat the Bars 
Now let's give the bars new fill patterns and change their drop 
shadows. If you have a color system, you can give the bars new 
colors as well. If your palette isn't currently open, open it by clicking 
in the zoom box on the palette's title bar. 

1. Select Costs 
Click on Costs in the legend. 

2. Change bar pattern 
With the Fill selector chosen on the palette, choose 
this pattern from the Pattern menu (bottom row, 
fourth from right): 

3. Change bar color ( optional) 
If you have a color system, select a color of your 
choice from the Color menu. 
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4. Change drop shadow 
With the Drop selector chosen on the palette, 
choose the black solid pattern from the Pattern 
menu. 

5. Select Revenue 
Click on Revenue in the legend. 

6. Change bar pattern 
With Fill selected on the palette, choose this 
diagonal pattern from the Pattern menu (third row, 
on the left): 

7. Change bar color ( optional) 
If you have a color system, you may select a color 
of your choice from the Color menu. 

8. Change drop shadow pattern 
With Drop selected on the palette, choose the black 
solid pattern from the Pattern menu. 

Reformat the Key 
Your final step in formatting this graph will be to reformat and 
move the legend closer to the graph, which makes the legend easier 
to see. 

1. Select legend 
Click once on the legend boundary to select it. 

2. Change font in the legend 
From the Text menu, choose Font; from the Font 
submenu, choose Helvetica. 

3. Enlarge point size 
From the Text menu, choose Size; from the Size 
submenu, choose 10. 
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4. I-fide legend boundary 
With Line selected on the palette. choose the clear 
pattern from the Pattern submenu (top ro,v. on left): 

5. Move lege11d closer to graph 
Click and drag the legend lefrward, closer to the 
graph. (\Xlhen you click on the legend, make sure 
that you click on the edge, and not on a black 
resizing handle.) 

You have nov,1 finished reformatting your bar graph. 

You can no,-v change your nc.:wly formatted bar graph into a 
borizo11ta/ bar graph by tr:111spo 'ing the axes: the independent axis 
will change from the horizontal orientation to the vertical. 
Horizontal bar graphs are useful for displaying non-sequential or 
discrete data (such as East. North, and \X est regions) on the 
(vertical) independent :.ixis. A (normal) horizontal independent 
axis. since it reads from left to right, often implies a progression of 
continuous values. Because the , ertical axis doesn't suggest a 
sequence as strongly, it lends itself most readily to such discrete 
data as geographical regions. 
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The horizontal bar graph you're going to create will look like this: 

1990 Costs and Revenue 

Ill Rennu.e 

0 Cosl3 

SD SSD0 SI ,000 SI ,500 S2,000 $2,500 

Transpose Axes 
With Bar Graph active (the frontmost window), you'll first transpose 
the axes. All it takes is a single command: 

1. Transpose axes 
From the Graph menu select Transpose. 

New Groph 
Options 
Delete Groph 
Transpose , 

Templote ... 

► 
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Remoue Loyer 
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Doto Front 
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Show and Hide Graph Objects 
For a cleaner-looking, more dramatic graph, you'll want to show 
and format some graph objects currently hidden (grid lines and 
axes), and then hide the dependent ticks. 

I. Select grid lines 
From the Objects menu, choose Dependent Axis; 
from the Dependent Axis submenu, choose Major 
Grid. 

2. Show grid lines 
Choose Show from the Objects menu. 
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Format Text 

3. Give grid lines a solid patter11 
With Fill selected on the palette, choose the black 
solid pattern from the Pattern menu. 

4. Select i11depe11de11t axis 
From the Objects menu, choose Independent Axis; 
from the Independent Axis submenu, choose Near 
Axis. 

5. Show axis 
Choose Show from the Objects menu. 

6. Widen axis 
From the Lines menu, choose Line Width; from the 
Line Width submenu, choose 3. 

7. Select depe11de11t axis 
From the Objects menu, choose Dependent Axis; 
from the Dependent Axis submenu, choose Near 
Axis. 

8. Show axis 
Choose Show from the Objects menu. 

9. Widell axis 
From the Lines menu, choose Line Width; from the 
Line Width submenu, choose 3. 

10. Choose depe11de11t axis ticks 
Click on a dependent major tick (a tick with a label 
by it), and then hold down the Shift key and click 
on a minor tick (a smaller tick between labelled 
ticks). 

11. Hide ticks 
Choose Hide from the Objects menu. 

To change the font for all the text associated with this graph, and 
rotate the independent axis labels so they're positioned 
horizontally, follow these steps: 

1. Select graph title 
Click once on the graph title. 
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2. Change font 
From the Text menu, choose Font; from the Font 
submenu, choose Times. 

3. Select independent axis labels 
Click on the (vertical) independent axis labels. 

4. Rotate labels 
From the Text menu, choose Rotate; from the Rotate 
submenu, choose None. (In this menu, "Left [CCW)" 
means counter-clockwise, turning to the left; "Right 
[CW)" means clockwise rotation, or turning to the 
right.) 

Font ► 
Size ► 
Style ► 
Alignment ► . ' ' 

left (CC 
llnno tn tl' T1_l(H! ► Right (CW) 
llnnotntl' Plnr.<i ► Upside Down 
llnno t11 tlon f,1111. .. 

Num Format ► 
Stagger ► 

5. Select depe11de11t axis labels 
With the Shift key pressed, click on the dependent 
(horizontal) axis labels on the bottom of the graph. 

6. Change font 
From the Text menu, choose Font; from the Font 
submenu, choose Times. 

7. Select legend 
From the Objects menu, choose Full Graph; from 
the Full Graph submenu, choose Legend. 

8. Change font 
From the Text menu, choose Font; from the Font 
submenu, choose Times. 

9. Change style 
From the Text menu, choose Style; from the Style 
menu, choose Bold. 
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Format Field Elements 
Formatting changes to this graph's field elements (bars) consist of 
eliminating the drop shadows and overlapping the Revenue bar with 
the Costs bar. 

1. Select field elements 
Click on Revenue in the legend, and then, with the 
Shift key pressed, click on Costs. 

2. Hide drop shadows 
With Drop selected on the palette, select the clear 
pattern from the Pattern menu (top row on left, 
indicated with an "X" in the menu). 

3. Deselect fields 
Click once anywhere in the graph window but not 
on a graph object. 

4. Select Costs field 
Click on Costs in the legend. 

5. Overlap Revenue with Costs field 
Choose Bar Offset. .. on the Areas menu. In the Sizes 
dialog, click in the "Neg" check box. Click and drag 
the black bar to the right along the ruler until -124 
appears in the "Percent" window. The Bar Offset 
dialog should look like this: 

B11r Offset 

,------, ® In ch 
O Absolute l-0.292 IO Cm. 

QPolnls 
@ Percent ,....j--, 2-4----, 

Q(;llp I 
~-~ 
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OK 

( C11ncel ] 

[ Reset 

q t ~ ~ 4 

I, I I I, I I I I I I, I I I, I I I, I I I, I I I, I ,T 
r. I 
j'~l I I I I I I I I I I I I I I I I 
q ~ i ~ !!. !.!!. 

[B11r Size O I OO"i'o (27 pis)) 

Click OK. (The options in this dialog are fully 
explained in Menus and Dialogs. You'll see this 
dialog when you want a special size, such as for line 
width or bar size.) 

Additional Exercises 64 



r __ 
\ == 
\ 

r 

~ I, I 

:3 

Move the Legend 
The last step in reformatting the graph is to move the legend closer 
to the graph. 

1. Select lege11d 
From the Objects menu, choose Full Graph; from 
the Full Graph submenu, choose Legend. 

2. Move legend 
Click and drag the legend leftward, closer to the 
field elements, so that the field names in the legend 
are positioned within a half an inch of the 
right-most grid line. 

You've now reformatted your bar graph for the second time. If you 
wish to further modify the graph, make any formatting changes you 
like. When you are ready to proceed, close Bar Graph. 

Open the Line Graph 
Open the line graph you created in the Learning lv/acGraphX 
chapter, by double-clicking on the Line Graph icon in the docking 
window. You can also select it from the Graph Window submenu on 
the Windows menu. Your next mission: to reformat the graph to 
make it look like this: 

Eastern Financial Totals: 90-93 
$4.000 

--------------- $0 
90 91 92 93 

Hide Graph Objects 
One of the most obvious differences between the graph you'll 
format now and the one you originally made is the absence of 
several graph objects-namely, the data frame, the axes, and all 
ticks. To hide these components of your graph, follow these steps: 

1. Select data frame 
Click on the data frame. 
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2. Hide dataframe 
Choose Hide from the Objects menu. 

3. Select ticks 
From the Objects menu, choose Select All; from the 
Select All submenu, choose Ticks . 

. , , 
\how 
llldc1 
Reset Attributes 
ReH' t lo< 11 tlon 
Reset Graph Order 

✓Anchor lo Frome 
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Align ► 
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\t.'llll to Buck TeHI 
Lines 
Rreos 

Full Groph ► Reels 
Fields ► Grids 
Independent AHis ► 
Oependenl RHiS ►, TI lies 

Lobels 

4. Hide ticks 
Choose Hide from the Objects menu. 

5. Select depe11de11t axis 
Click on the dependent (vertical) axis. 

6. Hide depe11de11t axis 
Choose Hide on the Objects menu. 

Indent Field Data (Zones) 
Another big difference between this graph format and the original 
one is that the first and last values for each dependent field don't 
overlap the data frame (which is now hidden). The field data (lines) 
have been "indented" from the data frame, by an amount equal to 
the size between minor ticks. Here's how to make this formatting 
change. 

1. Open Graph hifo dialog 
From the Graph menu, choose Options; from the 
Options submenu, choose Graph Info. 
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2. Select setting 
In the Graph Info dialog, click in the "Staggered 
(Zones)" check box. 

Graph Info 

GrophType-I _e_or __ ~I 
D Numbers 11s Lobels D N/R's -> O 
181 Stoggerecl (Zones) O Negs-> 0 
0 Running Totols O Seporate negs 

,r OK 

Cancel ) 

D Percentoges O Chonge Sort 
SortType'I -:-cN-o-=-chc-o-n-ge-.1 

Click OK. (We call this option "Staggered (Zones)" 
because it staggers the data inward from the data 
frame. This option is the default for bar and stacked 
bar graphs. When in effect, the field data are not 
flush against the data frame, but are centered within 
"zones" which the independent axis is divided into; 
the independent major ticks and grids are located 
in the center of each zone.) 

Reformat Grid Lines and Independent Axis 
Below, we'll tell you how to return your grid lines to their default 
formatting, and then you'll reformat the independent axis to make it 
look the same as the grid lines. 

1. Select grid lines 
From the Objects menu, choose Dependent Axis; 
from the Dependent Axis submenu, choose Major 
Grid. 

2. Reformat grid lines 
Choose Reset Attributes on the Objects menu. 
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Reset Groph Dreier 
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Align ► 
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3. Select independent axis 
Click on the independent (horizontal) axis. 

4. Reformat independent axis 
Choose this gray pattern from the Pattern menu on 
the palette (top row, third from left): 

Show Far Labels 
(Every graph has sides that are mirror images of each other: 
top/bottom and left/right. The left and bottom sides are called the 
near sides of the graph. The top and right sides are the far sides. 
When MacGraphX creates a new graph, it automatically shows the 
axis, axis labels, ticks, and axis title for the near sides only. The 
identical far-side objects are hidden until you decide to show them. 
When you overlap one graph on another, the far-side objects are 
shown for the top graph layer.) 

The graph you're creating will have its dependent (vertical) axis 
labels displayed on the opposite side from where they are now. 
You'll need to hide the near dependent axis labels that are currently 
showing, and show the far dependent axis labels that are currently 
hidden. Here's how to do so: 

1. Select near dependent axis labels 
Click once on the dependent (vertical) axis labels. 

2. Hide dependent axis labels 
Choose Hide from the Objects menu. 
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3. Select far depe11dent axis labels 
From the Objects menu, choose Dependent Axis; 
from the Dependent Axis submenu, choose Far 
Labels. 

\hllUJ 
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Fle~l'l Loe ntion 
Reset Graph Order 

Title 
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Fer Minor Titles 

4. Show far depe11dent axis labels 
Choose Show from the Objects menu. 

At this point, your far dependent axis labels, though visible, are 
partially hidden behind the legend. In due time, you'll move and 
reformat the legend. 

But first, since you have a new set of dependent axis labels, you 'II 
need to give them the same numeric formatting that the near-side 
labels had. You will also left-align these far dependent axis labels. 

1. Give axis labels new numeric formatting 
With the axis labels still selected, from the Text 
menu, choose Num Format; from the Num Format 
submenu choose Currency 0. 

2. Change alignment 
From the Text menu, choose Alignment; from the 
Alignment submenu, choose Left. 

Lower the Graph 
You'll need to first hide the independent axis title to make more 
room for the graph. Then, you'll lower the graph to make room for 
a larger graph title. Here's how: 
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J. Select independent axis title 
Click on the independent axis title, "Year." 

2. Hide i11depe11de11t axis title 
Choose Hide on the Objects menu. 

3. Select graph frame 
From the Objects menu, choose Full Graph; from 
the Full Graph submenu, choose Graph Frame. 

4. Move graph dow11 
Click and drag the graph frame down toward the 
bottom of the placement frame about a quarter­
inch. Don't push the independent axis labels into 
the surrounding placement frame, or allow them to 
touch the frame, or you might accidently force 
them up into the data frame. 

The entire graph except for the graph title moves with the graph 
frame; objects such as axis titles and labels, and the legend, are 
automatically anchored to the graph frame. (The graph title isn't 
normally anchored.) 

Format Text 
J. Move graph title down 
Click and drag the graph title down about a quarter 
of an inch. 

2. Change font 
From the Text menu, choose Font; from the Font 
submenu, choose Helvetica. 

3. Enlarge point size 
From the Text menu, choose Size; from the Size 
submenu, choose 18. 

4. Select other text 
Click on the dependent (vertical) axis labels, and 
then, with the Shift key pressed, click on the 
independent (horizontal) axis labels and the 
boundary of the legend. 

5. Change font 
From the Text menu, choose Font; from the Font 
submenu, choose Helvetica. 
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6. Enlarge point size 
From the Text menu, choose Size; from the Size 
submenu, choose 12. 

To deselect all objects, click once anywhere in the graph window, 
but not on a graph object. 

Move and Format the Key 
Here's how to move the legend to the opposite side of the graph 
window and reformat it: 

1. Select legend 
Click on the boundary of the legend. 

2. Hide 3-D shadow 
With the Drop selector chosen on the palette, 
choose the blank pattern from the Pattern menu 
(top row, far left). 

3. Select placement frame 
With the Shift key pressed, click on the placement 
frame, the outermost frame which surrounds the 
contents of the graph window. 
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4. Left-align legend 
From the Objects menu, choose Align; from the 
Align submenu, choose Left. 
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To deselect the placement frame and legend, click once anywhere 
in the graph window, but not on a graph object. Your legend now 
appears on the opposite side of the graph, and in the same vertical 
position. 

Eastern Financial Totals: 90-93 
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5. Widen legend 
Double-click on the legend boundary. Or, from the 
Graph menu, choose Options; from the Options 
submenu, choose Legend Info. In the Legend Info 
dialog, click on the "Row Major" radio button. 
Doing so will put the field names into a wide row 
rather than a column. 

legend Info 
lnyout 
@ Row M11Jor O Column M11Jor 
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181 Show Hidden Fields 

I 
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I[ OK ll 
[ Cancel ) 

HI-Lo--------------~ 
0 Show Hi-lo 

. 0 Absolute 
HI ~I c-0-st-s----~1• B® Percentage 

Lo Reuenue - 0 O Std Deu'ns 

Click OK. 

6. Give legend a clear background 
With Fill selected on the palette, choose the blank 
pattern from the Pattern menu (top row, far left). 

7. Give legend a clear boundary 
With Line selected on the palette, choose the blank 
pattern from the Pattern menu (top row, far left). 

8. Move legend up 
Drag the legend up slightly to move the field names 
away from the nearest grid line. 

That's it. .. you've finished reformatting your line graph. 
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For the final graph in this exercise, you will take the graph you have 
just finished formatting and, through paring it down, create this 
graph: 

Eastern financial Totals· 90-93 
Revenue 

$4,000 

$3,000 

===------------7 $1,000 

$0 
90 91 92 93 

Show the Far Dependent Axis 
Your first step will be to show the far dependent axis, which is 
currently hidden. 

1. Select far depe11de11t axis 
From the Objects menu choose, Dependent Axis; 
from the Dependent Axis submenu, choose Far 
Axis. 

2. Show far depe11de11t axis 
Choose Show from the Objects menu. 

Format the Axes 
With both axes now visible, you'll reformat them by making them 
wider, and give the independent axis a solid pattern. 

1. Select i11depe11de11t axis 
With the Shift key pressed, click on the independent 
axis. Both axes are now selected. 

2. Wide11 axes 
From the Lines menu, choose Line Width; from the 
Line Width submenu, choose 2. 

3. Give i11dependent axis a solid pattern 
Select the solid black pattern from the Pattern menu 
on the palette. 
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Hide Field Marks 
Because the graph you're formatting will emphasize trends in the 
data rather than specific field values, you'll want to hide the marks. 
To do so, follow these steps: 

1. Select field marks 
Click on Revenue in the legend, and then, with the 
Shift key pressed, click on Costs and Profits. 

2. Hide field marks 
From the Lines menu, choose Mark Type; from the 
Mark Type submenu choose "N" (which indicates 
no mark). 
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Hide Grid Lines 
To give your graph a cleaner look, you'll hide the dependent major 
grid lines. 

1. Select depe11de11t major grid 
Click on a dependent major grid line. 

2. Hide depe11de11t major grid 
Choose Hide from the Objects menu. 

Show and Format Independent Maior Ticks 
1. Select i11depe11de11t major ticks 
From the Objects menu, choose Independent Axis; 
from the Independent Axis submenu, choose Near 
Major Ticks. 
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2. Show i11depe11de11t major ticks 
Choose Show from the Objects menu. 

3. Widen i11dependent major ticks 
With the ticks still selected, from the Lines menu, 
choose Line Width; from the Line Width submenu, 
choose 2. 

Overlap Data Frame with Field Values 
Next you'll turn off the "Staggered (Zones)" formatting option that 
that shifted the field data in from the data frame. 

1. Open Graph Info dialog 
From the Graph menu, choose Options; from the 
Options submenu, choose Graph Info. 

2. Turn off "Staggered (Zo11es)" 
In the Graph Info dialog, click in the "Staggered 
(Zones)" check box, to turn off the option. 

Click OK. 

Reformat the Legend 
You'll now return the legend to its default columnar configuration. 

1. Open the Key Info dialog 
From the Graph menu choose Options; from the 
Options submenu choose Legend. 

2. Select columnar formatting 
Click on the "Column Major" radio button in the 
Legend Info dialog. 
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Click OK. 
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3. Select data frame 
With the Shift key pressed, from the Objects menu, 
choose Full Graph; from the Full Graph submenu, 
choose Data Frame. 

4. Align legend to data frame 
From the Objects menu, choose Align; from the 
Align submenu, choose Left. 

5. Select legend 
Click on the boundary of the legend. A set of 
resizing handles will appear on the corners and 
sides of the legend. 

■ - ■ 
Revenu 

I Costs I 

Profits 

■ - ■ 

6. Enlarge legend 
Click and drag the right-side handle outward (to the 
right), enlarging the legend so that all the text in the 
legend will be visible. Release the handle. 

Eastern Fin~ 

[ Revenue i 
I Costs j~ 
1 - Profits 1 : ,..-,-
t ...... ~-~1 

Right-align Dependent Axis Labels 
Your final formatting step will be to right-align the far dependent 

axis labels. 
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1. Select far depe11dent axis labels 
Click on the far dependent axis labels (on the right 
side of the graph). 

2. Right-align far dependent axis labels 
From the Text menu, choose Alignment; from the 
Alignment submenu, choose Right. 

To deselect the far dependent axis labels, click once anywhere in 
the graph window, but not on a graph object. 

You've now finished formatting four variations on two of the graphs 
you created in the previous tutorial. As you learn more about 
working with MacGraphX, you may want to come back to these 
graphs and practice your new skills. 
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Chapter 6: Working in the Data Window 
The first step in using MacGraphX is to create a dataset containing 
the numeric and alphabetic data from which to generate your 
graphs. You do this in two ways: by typing data into an empty 
MacGraphX data window or by importing data into the data 
window. The imported data can come from spreadsheet (such as 
MacCalc, Excel, or Lotus 1-2-3), or from your favorite database or 
accounting application. No matter how you create your dataset, the 
data window will always hold your data. 

About the Data Window 
When you open a new MacGraphX document, you're presented with 
an empty data window. You can close the data window by clicking in 
the close box in the upper left corner of the window or choosing 
Close Window from the Windows menu. Your window will shrink to 
an icon in the docking window. To open the data window, either 
double-click on the data window icon from the docking window at 
the left of your screen, or select Data from the Open Window 
submenu on the Windows menu. 

' s FIie Edit C111jc,c ts TeHI l.ini,s llrL•ns Windows 
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The data window has three major components: records, fields, and 
cells. A cell contains one unit of numeric or alphabetic information. 
A record (row) is a set of cells. A field (column) is information of 
one type spanning all the records in a dataset, e.g., name, date, 
amount, or year. Each record is seen to contain related numeric or 
alphabetic information presented in cells and organized by field. 
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The Entry Cell 
The current cell in which data may be entered or edited is the entry 
cell. The entry cell is part of the current selected range. The entry 
cell is distinguished by a black border around a white cell. If the 
current selected range is bigger than one by one, this range (without 
the entry cell) will be black. When you begin typing, the entry cell 
opens up for editing, indicated by a flashing insertion bar. 
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When creating a graph with a range selected in the dataset (instead 
of the usual way of selecting records and fields separately), the field 
which contains the entry cell becomes the independent (x) field in 
the new graph. 

To edit data previously entered in a cell, click once on the cell to 
make it the entry cell, and then click again to open the cell for 
editing and create an insertion point (indicated by the flashing 
insertion bar). You can use the arrow keys to move within a cell 
when editing. The enter key, tab or return end editing and will enter 
the new value in the dataset. The escape or clear key ~ancels editing 
without changing the dataset. New data entry will cause MacGraphX 
to recalculate fields based upon formulas and update graphs which 
include changed data. 

Getting Around in the Data Window 
You can move the entry cell to the right by pressing Tab or using 
the right arrow cursor key. Move the entry cell to the left by pressing 
Shift-Tab or using the left arrow cursor key. When you reach the last 
field(column) in a record (row), which is empty, pressing tab or 
right arrow will place the entry cell in the first field of the next 
record. 

Similarly, you can move the entry cell up or down, to the same field 
in a record directly above or below, by using the up or down arrow 
cursor keys, or by pressing Return to move down and Shift-Return to 
move up. When you reach the last record (row) in a dataset, which 
is empty, the entry cell will continue to move to the first record of 
the next field. 

The entry cell's movement can be confined to a range of selected 
cells. Select the range by clicking and dragging across cells. The 
entry cell will then move through only those selected cells. 

Working in the Data Window B 1 



Selecting Cells, Fields, and Records 
To work with your dataset, MacGraphX gives you many ways of 
selecting cells, fields, and records. They are:· 

To select a single cell Place the cursor over a cell and click. 

To select a group of Place the cursor over a cell, click, and 
contiguous cells drag to other cells. 

To extend the range of Hold down the Shift key, click, and drag 
a selected group of the cursor over adjacent cells. 
cells 

To select a single field Click on a field name. 

To select several Click and drag the cursor over field 
contiguous fields names. 

To extend the range of Hold down the Shift key, click, and drag 
a selected group of the cursor over adjacent field names. 
fields 

To select or deselect Hold down the Command key and click 
several discontinuous on the field names. 
fields 

To select a single Place the cursor on the record's number 
record in the Recs# column and click. 

To select a range of Click and drag the cursor vertically over 
records record numbers. 

To extend the range of Hold down the Shift key, click, and drag 
selected records the cursor over contiguous record 

numbers. 

To select or deselect Click on the record numbers while 
several discontinuous holding down the Command key. 
records 

To select all records at Place the cursor at the top of the Recs# 
once column and click. Your cursor will turn 

to:~. 
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Manually Entering Data 
The most direct way of putting data in the data window is to enter it 
manually. 

One Record at a Time 
Enter the data for your first cell. Press Tab to create a new cell in 
the same record. Continue using the Tab key to create new cells 
until you have finished entering the data for one complete record. 
With the cursor in the final cell with data, Tab twice. Begin entering 
data for a new record. At this point MacGraphX has titled your 
fields "Field#l,","Field#2," and so on. You can change these names 
at any time. 

Continue using the Tab key to create cells and records, making sure 
you enter cell data in the same sequence as you've entered data in 
preceding records, so that field values correspond. You can create 
up to 2500 records and 125 fields in the data window. 

One Field at a Time 
Enter the data for your first cell. Press Return to create a new cell in 
the same field. Continue pressing the Return key after entering each 
cell until you finish a complete field (column). With the cursor in 
the final cell with data, press the Return key twice. The cursor will 
appear at the top of the next column. Begin entering data for the 
second column as you did for the first. You can create up to 2500 
records and 125 fields in the data window. 

In a Preset Dataset 
You can arrange all the fields and records in your dataset before 
entering any data. Select Fields from the Data submenu on the Edit 
menu. In the Define Field dialog, name a field by typing the name 
in the "New Name" field and clicking Add. (While you are setting up 
your fields this way, you can also specify data types. For more 
information about doing this, see Specifying Data Types, this 
chapter.) Use the Insert or Duplicate command on the Edit menu to 
create as many records as you need. You can then start entering 
data. You can create up to 2500 records and 125 fields in the data 
window. 

Building Formulas 
When you create fields in the data window, you may want some of 
them to contain values from a formula based on data in other 
fields. Building a formula is performed in the Define Field dialog. 
Using formulas is discussed in Building Formulas. 
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Recalculating Formulas and Transforms 
Normally, MacGraphX automatically recalculates formulas and 
transforms when data are changed or added. If you wish to turn off 
this automatic recalculation for the entire dataset, you can use the 
Manual Recalc command from the Edit menu. If you later want to 
recalculate for new or changed values, use the Recalc Now 
command from the Edit menu. 

To turn off recalculation for selected fields only, select the field 
names and use the Fld No Recalc command from the Edit menu. 
You can also disable recalculation when initially defining a field, by 
selecting the "Constant" option in the Define Field dialog. 

Importing Data 
The other method you use to get your data into the MacGraphX 
data window is importing it from other applications. MacGraphX 
can read files created by MacCalc or Excel for Macintosh or IBM 
PC, and files output in WKS or WKl fonnats from Lotus 1-2-3 for the 
IBM PC, or tab-delimited ASCII or SYLK from a database, 
spreadsheet, or accounting application. For a description of these 
file formats, see the Import Data command in the Menu Commands 
and Dialogs chapter. 

To import a file into MacGraphX, select Import Data from the File 
menu and choose the desired file format from the_submenu, or 
choose All. Locate the file in the resulting dialog and click OK. In 
the Load dialog, you have many choices. See the Import Data 
command in the Menu Commands and Dialogs chapter, for an 
explanation of the options. 

When you have finished making your choices, click OK. When you 
open the data window, you will see your data. You can import up to 
2500 records and 125 fields into the data window. 

Adding Fields and Records 
MacGraphX allows you to add imported data to an existing dataset. 
New data can be added as records or as fields, depending on the 
data. Use the "Add New Fields" and "Add New Records" settings in 
the Load dialog to make your choice. For an explanation of these 
settings, see the Import Data command in the Menus and 
Commands chapter. 
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Tab-delimited Files 
Many Macintosh or PC applications can output tab-delimited files. 
Tab-delimited files are text-only files in which each field is 
separated from the next by a tab character, and each record is 
separated from the next by a carriage return. 

The first line of a tab-delimited file may contain the names of each 
field separated by tabs. If formulas are involved, they are placed 
immediately under the field names and preceded by a "#". For 
example ("<tab'. indicates a tab separator; "<ret>" indicates a 
carriage return): 

Yeor<tob> Rev<tob> Exp<tab> Profil<rel> 

#Profit = Rev - Exp<rel> 

<rel> 

1990 100 70<rel> 

1991 120 80<rel> 

1992 l l 8 83<rel> 

In the above example, the first line contains field names. The next 
line contains a formulas for the Profit field. The last lines are 
tab-delimited data for the fields not defined by formulas, with each 
column corresponding to the appropriate field name. 

Specifying Data Types 
MacGraphX can treat field data as numeric or alphabetic 
information. When you create a new field by typing in the data 
window, or by importing data in from a file, MacGraphX will choose 
between numeric or alphabetic data types automatically, depending 
on whether numbers or letters are first entered in a field. If a cell 
contains both, e.g., 123 Main St., MacGraphX will use the alphabetic 
type. Alphabetic data can never be entered in a numerically 
formatted field, but numeric data may be entered as text in a text 
field. 

To change the type of a field, select the Fields command from the 
Data submenu. In the Define Field dialog, select the desired field 
name. When chosen it will appear in the name box. You may also 
open the Define Field dialog by double-clicking on the field name. 
When you do this, the chosen field name will automatically appear 
in the name box. Click in the '·Number'· or ·Text .. radio button, 
then click Reset. Note that if you change a field type, all data in it 
will be lost. 
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Changing and Creating Numeric Formats 
MacGraphX defaults to the General display format for numeric data. 
For special business or scientific purposes, however, you may want 
to create your own custom numeric format, or choose from among. 
several preset options. MacGraph.X can format numeric data with a 
specified number of decimals, for example, 9r put numbers into a 
scientific format. It can also define date fields. 

To change numeric formats, highlight a field name and select a 
preset format from the Num Format submenu on the Text menu. To 
create a new numeric format, use the New Format command from 
the Num Format submenu on the Text menu to bring up the New 
Format dialog. Make the desired settings and click Add when 
finished. Any new format is appended to the submenu and can be 
selected there. For an explanation of your choices on the Num 
Format submenu and in the New Format dialog, see the Num Format 
command in Menu Commands and Dialogs. 

Renaming Fields 
To rename your fields, select Data from the Edit menu; from the 
Data submenu, select Fields. In the Define Field dialog, select a 
name from the list of field names. It will appear in the name box. 
You may also open the Define Field dialog by double-clicking on 
the field name in the data window. When you do this, the field name 
will automatically appear in the name box. Type in the new name 
and click the Rename button. 

Cutting, Copying, and Pasting Records and Cells 
To cut records in the data window, select the desired record 
numbers from the Recs# column and give the Cut command from 
the Edit menu. When cutting records, MacGraph.X collapses the 
dataset and renumbers the remaining records accordingly. You can 
also cut a single cell or range of cells by selecting them and giving 
the Cut command. In the selected cells, numeric values will be 
deleted and will be replaced with null values (often formatted to 
appear as "NI A"), and alphabetic cells will be deleted and left blank 
(the empty text string). 

To copy records, select the desired record numbers and give the 
Copy command from the Edit menu. To copy cells, select the cell 
or range of cells, and give the Copy command. 

To paste records into the data window, use the Paste command on 
the Edit menu. Pasted records are entered at the end of the dataset. 
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Cut or copied cells which are pasted back into the datset replace a 
range of cells of equal size as the original cut or copied range, 
starting at the entry cell. 

Clearing and Deleting Records and Cells 
The Clear command under the Edit menu turns cells with numeric 
values to null values, and turns cells with an alphabetic text type to 
blank. The Clear command is like Cut, except that it doesn't change 
the clipboard. You can clear a record or range of records by 
selecting the desired record numbers Recs# column and giving the 
Clear command. You can clear a single cell or range of cells by 
highlighting them and giving the Clear command. 

The Delete command on the Edit menu only deletes records. Select 
the desired record numbers Recs# column and give the Delete 
command. Unlike the Cut command, Delete does not change the 
Clipboard, so you cannot paste records or cells back into the 
dataset. You must use Undo immediately after using Delete to return 
deleted records to the dataset. 

Duplicating and Changing Records 
You have the ability to duplicate records and enter blank records at 
the end of your dataset using the Duplicate command under the 
Edit menu. When duplicating selected records, you can specify how 
many times you want them duplicated. You can also change the 
value of one field by a percentage, an absolute value, or according 
to a formula. This capability allows you to do what-if analyses with 
your data by enabling you to methodically change it, then graph it 
out to see the what your changes mean. 

Begin by selecting the record or range or set of records to 
duplicate. Give the Duplicate command. Make your choices in the 
Duplicate dialog. For a list and explanation of the choices, see the 
Duplicate command in the Menu Commands and Dialogs chapter. 

If you selected the Fill Field option, you will get another dialog with 
several choices. For a list and explanation of the choices, see the 
Fill Field command in the Menu Commands and Dialogs chapter. 

After finishing with the Duplicate and Fill Field dialogs, you will 
return to the data window with the duplicated records appended to 
your dataset. 
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Sorting, Finding, and Moving Records and Fields 
Sorting, finding, and moving records and fields are helpful 
operations enabling you to graph the data you want. You can sort 
records in the data window by record number or any field. When 
you hold down the Option and Shift keys while the cursor is over 

the record numbers, the cursor changes to the sort cursor: ~- Use 
this tool to: 

Sort all records by Press Option and Shift, then click at the 
record number top of the Recs# column. 

Sort all records by a Press Option and Shift, then click on the 
field in ascending field name that you want to sort by. 
order 

Move several selected With several records selected, press 
records elsewhere in Option and Shift, then click on the 
the dataset desired destination record in the Recs# 

column. 

Note that you can only sort by one field with this method (which is 
called a "direct sort"). You cannot "cascade" your sorting to sort by 
more than one key (field), as you can using the Sort command, 
below. 

Multiple Sorting 
You can use the Sort command to sort your dataset by more than 
one field simultaneously. This command allows you to sort a dataset 
by up to three fields. Give the Sort command from the Edit menu's 
Data submenu. In the Define Sort dialog, specify the data fields to 
sort by and their order by entering their names in the sort fields. 
You can type in the names or select them from the Fields menu. 
Specify a descending sort order for the field by selecting the "Desc" 
check box for any field. 

Searching 
To search your dataset for records that meet desired criteria, use the 
Search command on the Data submenu. In the Define Search 
dialog, specify the field to search by typing the field name into the 
first field or selecting it from the Fields menu. Enter the value or 
text string to search by in the second field. (The Define Search 
dialog will automatically display the name of the field containing 
the entry cell and the entry cell's contents.) Click on the 
appropriate radio buttons or check box to define the search. (For a 
complete list of choices in the Define Search dialog, see the Define 
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Search command in Menu Commands and Dialogs.) Found records 
will appear in the data window and will be selected. You can 
coalesce these records and move them to the top of the dataset with 
the Move To Top command on the Data submenu, or you can 
move them anywhere in the dataset by using the option-shift click 
method. 

Summarizing Records 
You can determine the total, average, maximum, or standard 
deviation for all fields in selected records. Select a set of records, 
and use a command from the Summarize submenu on the Edit 
menu. The result is entered in a new record at the end of the 
dataset. The new record will have a "T", "V", "M", or "2." next to 
the record number to indicate whether the result is a total, average, 
maximum, or a standard deviation. 

MacGraphX's intrinsic statistical functions are total, average, 
maximum, and standard deviation. MacGraphX allows the 
programmer or sophisticated user to add in other statistical 
functions for calculations. Geometric mean and sum of squares are 
two examples of these add-on statistics that are included with 
MacGraphX in the "MG.XSTTs.f" folder. For more information 
about how to program you own add-in statistics for MacGraphX, 
contact Bravo Technologies. 

Changing Text Formats 
When working in the data window, you may want to change 
typefaces, fonts, sizes, and text alignment for a particular field. 
Working with text in the data window is similar to working with text 
in any standard Macintosh application. MacGraphX changes the 
text formatting for entire fields; you cannot change the attributes of 
individual cells or records. 

To change text formats or alignments in the data window, select the 
desired fields and give one of the Font, Style, Size, or Alignment 
commands from the Text menu. You cannot rotate text in the data 
window. 

Resizing Columns 
Columns can be resized to enable you to see all your data clearly. 
When you place the cursor directly on a vertical line separating two 
fields, the cursor turns to: +J ~-Use this to move the line either to the 
right or left to widen or narrow the field, as needed. 
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Resizing the Data Window 
To view all your data or focus in on a certain part of it you may 
want to resize the data window. As in any standard Macintosh 
window, you can click and drag in the window's grow box (in the 
lower right-hand comer) to resize the window, or click in the 
window's zoom box (in the upper right) to enlarge the window to 
the full size of the Macintosh screen. ,... 

Exporting a File 
To share data with other applications, MacGraphX lets you export 
your data in a variety of standard formats. For example, you may 
want to load you data into the MacCalc spreadsheet for finer 
analysis, or share a MacGraphX file with someone who has Excel or 
Lotus 1-2-3. MacGraphX gives you the capability to output 
documents as WKS, tab-delimited text, or SYLK files. 

To export a file, use the Export Data command from the File menu. 
From the dialog, choose the desired file format, and select the 
options. For an explanation of options, see the Export Data 
command in Menu Commands and Dialogs. 
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Chapter 7: Creating a Graph 
You use the data you have created in or imported to the data window 
to generate graphs. MacGraphX was created to make this process 
simple and quick. The procedure for defining a graph consists of four 
easy steps: 

• Choose the records to graph 

• Define the independent (x) field 

• Define the dependent (y) fields 

• Select the desired graph type 

Choosing the Records 
To choose the data to work with in creating your graph, first select the 
desired record numbers from the Recs# column. 

To select a single record Place the cursor on its number in 
the Recs# column and click. 

To select a range of records Drag the cursor vertically over 
the desired record numbers 
while holding down the mouse. 

To select or deselect several Click on the desired record 
discontinuous records numbers while holding down the 

Command key. 

To select all records at once Place the cursor at the top of the 
Recs# column and click. The 

cursor will appear as: ~-

Defining the Independent (x) Field 
The independent field is generally used as the measurement of some 
continuous interval (such as time) or discrete categories (such as 
geographic regions). It is usually the horizontal (x) axis in a graph. 

Place the cursor in the thin horizontal box just above the field name. 
When you do this, the cursor turns to - • -. (Note the shape of the 
cursor, indicating the horizontal axis.) When you click to specify a 
field, this box above the filed name turns gray. That field will become 
the independent field for the graph. 
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Defining a Second Independent Field 
Selecting a second independent field enables you to group data by a 
second field. For example, if you select Year as the first independent 
field, you might want Quarter (a part of a year) as the second. This 
will group each quarter within the year. 

To specify a second independent field, follow the same procedure as 
selecting the primary one, but also hold down the Option key while 
clicking in the thin horizontal box above the field name. The bar will 
tum a lighter shade of gray (than the independent field) to distinguish 
it. Note that you may have only one dependent (y) value when you 
select a second independent field. 

Defining the Dependent (y) Field 
The dependent field, usually the vertical axis, indicates the values of 
selected data. Choose one or more fields by clicking and dragging the 

■ 

cursor across the desired field names. The cursor will look like: ii. 
(Note the vertical shape of the cursor, indicating the dependent, 
vertical, axis.) 

Other Ways to Define the Fields 
MacGraphX gives you two additional ways to select the fields and 
records that will comprise your graph. 

Contiguous Range 
If the fields and records you wish to graph are a contiguous 
rectangular range, you can define independent and dependent fields 
by simply clicking and dragging across that range. By dragging the 
cursor both horizontally and vertically, you specify both the graph 
fields and the records. The entry cell defines the independent field. 
You may move the entry cell by clicking in a new cell while holding 
down the Command key. You may also use the cursor keys or Tab 
and Return keys to move the entry cell around. See The Entry Cell in 
Working in the Data Window. 

Note that selecting a range of cells takes precedence over previously 
selected fields. This means that if you highlight field names to define 
fields and records, as described earlier, then use the range-click and 
drag technique to select a range to graph, the latter selection (the 
range) will be used to generate your graph. 
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By Dialog 
If you attempt to create a graph without having fields properly 
selected in the data window, MacGraphX will produce a dialog that 
allows you to select fields from a list. 
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The settings in this dialog are: 

"Independent Axis" Selects one field to define the 
independent axis for the graph you 
are creating. 

"Dependent Axis" Selects one or more fields to define 
the dependent axis for the graph you 
are creating. 

"All Records" Use all the records for graphing. 

"Records 1 to" Use a records from 1 to a number 
you type in the edit field. 

"Selected Records" Use of records selected in the data 
window for graphing. 

"Overlay" Overlays the graph you are creating 
on one that already exists. 

If you attempted to create a graph, and this dialog appeared instead, 
look carefully at your data window. Make sure you have indicated a 
set of records to graph by selecting their numbers from the Recs# 
column. Make sure you have chosen an independent field and at least 
one dependent field, which is different from the independent field. 
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Creating a Graph 
When you have chosen one or two independent fields, and one or 
more fields for the dependent axis, and selected your records, choose 
the graph type you desire from the New Graph submenu on the 
Graph menu. MacGraphX can create several types of graphs. For a list 
and description of graph types, see the New Graph command in the 
Menu Commands and Dialogs chapter. 

Transposing Axes 
To switch the independent and dependent axes from their normal 
horizontal and vertical orientations when creating a graph, hold down 
the Option key while choosing the graph type from the New Graph 
submenu. The independent axis will appear as the vertical (y) axis, 
and the dependent axis will appear as the horizontal (x) axis. You 
may also switch the axes after you have created the graph, by using 
the Transpose command from the Graph menu; see Fonnatting Your 
Graph. 

Overlaying Graphs 
You can overlay two graphs of different types in one graph window. 
For example, you can create a bar chart, and then overlay a line chart 
or scatter chart. To do this, create your first graph in the normal 
manner. Then for the second graph, select the data window again and 
choose a new graph type from the New Graph submenu while 
holding down the Shift key. The second graph will be laid over the 
front-most graph. 

You can graph new records and fields over the first graph, if you 
wish, or leave the same records and fields selected in the data 
window. 

When you have two overlaid graphs, the far axes, ticks and labels (at 
the top and right) are used for the second graph. These are across 
from the (near) axes, ticks and labels of the first graph (at the left and 
bottom of a graph). 
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Chapter 8: Structuring Your Graph 
MacGraphX gives you the ability to change your graph in many ways, 
customizing it down to the smallest detail. This chapter covers how to 
make structural changes to your graph. In the chapter after this one, 
you will learn how to make formatting changes to enhance the visual 
impact of your data. 

Making structural changes to your graph means making changes that 
alter the way your data is arranged in the graph. MacGraphX gives 
you many choices on how to sort the order of data points, handle 
negative values, and so forth. You can also add fitted curves to scatter 
charts that help show overall trends in your data. 

You can bring up the dialogs discussed in this chapter in two ways. 
All dialogs are accessible from menu commands or through 
double-clicking on specific graph objects. 

Updating Your Graphs 
In MacGraphX, as you make changes to information in the data 
window using the keyboard or editing commands, all formulas are 
recalculated and changes propagated to any graphs you have created. 
Curve fits will also be updated with the new information. (See also 
Recalculating Formulas and Transforms in Working in the Data 
Window.) 

Running Totals 
You may wish to show running totals for your data. Running totals 
show all objects in a field of your data as the accumulated total of the 
field. This feature is the default with stacked bar, area, and pie charts. 
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To use running totals, from the Graph menu seiect Options; from the 
Options submenu select Graph. In the Graph Info dialog, click on the 
"Running Totals'· check box. 

The Graph Info dialog is also accessed by double-clicking on the 
graph frame or the data frame of the graph. 

Percentages 
You can show each value on your graph as a percentage of the total 
or maximum value. This setting is a default with a pie chart. The 
graph below is a stacked bar graph with with nmning totals and 
percentages: 
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To show values as percentages, from the Graph menu select Options; 
from the Options submenu select Graph. Click in the "Percentages" 
check box in the Graph Info dialog. The dependent axis will show a 
scale of Oto 1 (0 to 100 percent). 

The Graph Info dialog is also accessed by double-clicking on the 
graph frame or the data frame of the graph. 
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Working with Negative Numbers and Nulls 
MacGraphX gives you three options for handling negative values in a 
graph to make it easier to display them or leave them out when they 
are not useful. The choices are: 

"Negs-> 0" Treats all negative values in a graph 
as zero. 

"Separate Negs" Default setting for bar, stacked bar, 
and area graphs, and running totals, 
showing negative values as values 
less than zero. Deselecting "Separate 
Negs" causes negative values be 
added in with the values of other 
fields, lessening the total. 

''NI A's -> 0" Treats any null value in the dataset as 
0 for graphing. 

"Negs-> 0" and "Separate Negs" should not be used together. To use 
any of these options, from the Graph menu select Options; from the 
Options submenu select Graph. In the Graph Info dialog, click on 
"Negs-> 0", "Separate Negs", and/or "N/A's ->0". 

The Graph Info dialog is also accessed by double-clicking on the 
graph frame or the data frame of the graph. 

This graph has the "Separate Negs" setting selected. Negative values 
are shown as bars extending below zero. 
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This is the same graph with "Separate Negs" deselected. Negative 
values are added in with the positive values of the other fields, 
decreasing the total. 
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With "Negs-> O" active, negative values are treated as zero, and don't 
affect the total. 
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Reordering Fields in the Graph 
You can reorder the fields in a graph to change the relative position 
of bars, stacked bars, pie wedges, and areas. As demonstrated in 
Learning MacGraphX, you can click on the field name (in the legend) 
and drag the field name up or down to reorder fields in the graph. 
The last field in the legend is usually plotted at the bottom of a 
stacked bar chart or area graph, and at the right within a group of 
(parallel) bars. 

Reordering Records in the Graph 
Reordering data points for line graphs determines how field marks will 
be connected, and determines the right-to-left positions of groups of 
bars in a bar chart. 

You can change the sort order of records (data points) in the graph in 
several ways. Select Options from the Graph menu; from the Options 
submenu, select Graph. 
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Under the "Change Sort" check box, select a new sort type from the 
pop-up menu. 

The Graph Info dialog is also accessed by double-clicking on the 
graph frame or the data frame of the graph. 
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In the first graph, data points are connected by lines that follow the 
ascending order of values on the independent axis. This is Natural 
order. 
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In the next graph, marks are connected in ascending record number 
order. This is called Record# order. 
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You can choose the "List Order" option to connect the marks in the 
order that the records are currently listed in, as shown in the data 
window. The "List Sort" option uses the order of the last direct sort 
chosen (that is, when you last used option-shift-click to sort by a field 
in the data window). 

You can also change the sort order for records (groups of bars) on a 
bar graph. Bars are ordered along the independent axis according to 
the order of records in the graph, as marks are connected in a line 
graph based on the order of gr.1ph records. 
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Even Spacing on the Independent Axis 
MacGraphX can create regular spacing between intervals on the 
independent axis even when the independent field is numeric (which 
would normally have uneven spacing between record values). The 
"Numbers as Labels" option in the Graph Info dialog guarantees even 
spacing between data points regardless of the numeric value of the 
independent field. This setting is a default for bar and stacked bar 
charts. Deselecting ·'Numbers as Labels" with numeric independent 
field may cause bars to be spaced unevenly on bar charts. 

To select or deselect "Numbers as Labels," from the Graph menu 
select Options; from the Options submenu select Graph. In the Graph 
Info dialog. click in the "Numbers as Labels" check box. 

The Graph Info dialog is also accessed by double-clicking on the 
graph frame, a frame overlapping the data frame of the graph. 

Preventing Data from Overlapping the Data Frame 
When you create a graph some points of the data may overlap the 
data frame. If you wish to move the position of the major grid and 
ticks for your data in from the data frame, by an amount equal to the 
minor tick spacing, use "Staggered (Zones)." Bar, stacked bar, and pie 
charts default to this setting. 

From the Graph menu, select Options, from the Options submenu, 
select Graph. In the Graph Info dialog, click in the "Staggered 
(Zones)" check box. 

The Graph Info dialog is also available by double-clicking on the 
graph frame or data frame. 

(We call this option ·'Staggered (Zones)'" because it staggers the data 
inward from the data frame. When in effect, the field data are not 
flush against the data frame, but are centered within "zones" which the 
independent axis is divided into; the independent major ticks and 
grids are located in the center of each zone.) 

Scaling and Formatting the Axes 
MacGraphX gives you many ways to scale and format a gr.iph·s axes. 
You can determine where to start the baseline, where to put labels. 
how many intervals to have, how many minor ticks to have between 
intervals, and what range of values the axes will represent. For more 
information about formatting a graph's axes, see Scale in Making 
Grapbs witb Impact. 
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To use any of these options, from the Graph. menu select Options; 
from the Options submenu select either Independent Axis or 
Dependent Axis and make your choices. For a list and explanation of 
the choices, see the Independent/Dependent Axis command in the 
Menu Commands and Dialogs chapter. 

You can also access the Independent and Dependent Axis dialogs by 
double-clicking on the axis labels or axis titles. 

Creating Curve Fits with Scatter Charts 
You will often want to show trends or examine mathematical models 
in your data with a curve fit, that is, a line that closely approximates 
your data. To generate a curve fit with a scatter chart, you must first 
define the curve fit by a formula that includes the transform and its 
parameters. You then apply the curve fit to the field data by selecting 
the field and choosing the curve fit from the Curve Fit submenu of the 
Lines menu. 

To define a new curve fit, select Curve Fit from the Lines menu. From 
the Curve Fit submenu, choose Define Curve Fit. The dialog that 
appears has these choices: 

"New Curve Fit" Names a new curve fit. 

"Formula" Define a formula for the curve. To build 
the formula, use the transforms from the 
Curve Fits menu. 

"Delete" Deletes a named curve fit. 

"Add" Adds a new curve fit. 
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The standard transforms shipped with MacGraphX (in the 
MG.X:FRJvlsf folder) that may be used as curve fits are cubic spline 
(for interpolation), linear, logarithmic, and polynomial. 

You can specify the number of curve steps, that is, the number of line 
segments the curve is made of. Give the Curve# Steps command on 
the Line menu. From the submenu that appears, make the desired 
choice. The options are: 

Same Points As Graph Same number of points in the 
curve as data points on the 
graph. 

Use Major Count Same number of points in the 
curve as major ricks. 

Use Minor Count Same number of points in the 
curve as minor ticks. 

Use Size Same number of points in the 
curve as pixels in the width of 
the graph. 

1,10, 20, 25, 50 ... Specifies a number of points. 

You can change the number of curve steps ar any time by using the 
Curve# Steps command. 

If you change data in your graph, MacGraphX will automatically 
recalculate the curve fir for the new data. If you want ro disable this 
automatic recalculation and recalculate manually. select CF Manual 
Recalc on the Lines menu. To recalculate, give the CF Recalc Now 
command on the same menu. 

More About Curve Fits: Technical Details 
Technically, a curve fit is a specific instance of a general transform 
class, and is specified by the input parameters to the transfom1 
functions. 

For example, a quadratic curve fir is an instance of the more gener.11 
polynomial transform, specified with a degree (input pardmeter) of 
two. The polynomial approximation transform, called "PolyFir,·· takes 
one parameter, the degree of the polynomial for approximation. To 
define the quadratic curve fit, you'd enter the formula "PolyFit(2)" in 
the curve fit dialog box. 

Structuring Your Graph 103 



Other transforms may be simpler, and take no parameters. For 
example, the least-squares straight line transform needs no 
parameters, and .so the linear curve fit is defined by the formula 
"LinearFitO." For general information about using transforms in 
formulas, see Building Formulas. 

In addition to the transforms that came with MacGraphX, other 
developers may supply transforms and curve fits to work with 
MacGraphX; if you're a programmer, you can also create your own 
add-in transform. The parameters required to specify a curve fit 
depend on the transform being used. 

Except for the polynomial fit, the transforms supplied with 
MacGraphX that may be used as curve fits (cubic spline, linear, 
logarithmic) take no parameters. 

Large Graphs 
To enlarge graphs beyond one page, you will need to specify the 
number of vertical and horizontal pages that your graph will occupy. 
You can use the options available in the Window Info dialog to 
specify the largest possible size for the placement frame of your 
graph. From the Graph menu select Options; from the Options 
submenu, select Window. In the Window Info dialog, make your 
choices. For a list of choices, see the Window command in the Menu 
Commands and Dialogs chapter. 

You can also open the Window Info dialog by double-clicking on the 
graph title or anywhere in the window other than on a graph object. 
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Chapter 9: Formatting Your Graph 
You can control the appearance of items in your graph window with 
commands on the palette and menus. You can hide or show an 
object, resize parts of the graph or the whole graph itself, change 
colors and patterns, change outlines, create drop shadows, and add 
text. You can create custom colors. If you find settings you particularly 
like and want to transfer to future graphs, you can save them as a 
template. 

Graph Window Basics 
You can open a graph window by selecting it from the Open Window 
submenu on the Windows menu, or by double-clicking on the graph 
window icon in the clocking window. You can have up to 16 graph 
\vindows. 

To bring an open graph window to the front, either select the window 
by name from the Open Window submenu on the Windows menu; 
click once on the desired window; or double-click on the graph 
window's icon in the clocking window. 

To close a window, click in the close box in the upper left corner of 
the window. It will shrink to its icon in the graph window. You can 
also use the Close Window command on the Windows menu. 

Naming a Graph Window 
You can name or rename a graph window with the \'v'indow 
command from the Graph menu's Options submenu. In the Window 
Info dialog type in the desired name in the title field. (Doing this will 
not change the title for the graph itself, but will change the title of the 
graph window icon in the docking window.) You can also open the 
Window Info dialog by double-clicking on the grnph title, or 
anywhere in the window other than on a graph object. 

Deleting a Graph Window 
If you create a graph and then decide you don't want it, you can 
delete it. Open the window and select the Delete Graph command on 
the Graph menu. Deleting a graph window cannot be undone. 

Selecting Objects 
A graph object (such as a frame, axis, tick, or field element) can be 
selected via a submenu on the Objects menu. Selecting an object is 
necessary prior to giving menu or palette commands that change the 
object. 
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An object may also be selected by clicking directly on it, or by 
clicking and dragging out an area which completely surrounds the 
object. Field elements(bars, lines, marks, areas, and pieces of pies) 
must be selected by clicking on their indicators in the legend (at the 
right of the graph), or by selecting the field from the Fields submenu 
of the Objects menu. 

When labels, titles, grid lines, ticks, axes, or field indicators are 
selected, a faint dorted line appears around them. Resizeable objects, 
such as frames, the legend, and user-drawn graphics, have resizing 
handles that appear at each corner and side. User-drawn lines have a 
resizing handle on each end. 

To select all graph objects in the graph window, or all objects of one 
kind, choose one of the following from the Select All submenu: 

All Selects all graph objects. 

Text Selects all text. 

Lines Selects all lines. 

Rects Selects all rectangles. 

Grids Selects all grid lines. 

Ticks Selects all ticks. 

Titles Selects all titles. 

Labels Selects all labels. 

The Independent Axis and Dependent Axis submenus on the Objects 
menu let you select: 

• Title • Near Axis • Far Axis 

• Major Grid • Near Labels • Far Labels 

• Minor Grid • Near Major Ticks • Far Major Ticks 

• Baseline • Near Minor Ticks • Far Minor ticks 

Giving the Full Graph command lets you select: 

• Placement Frame • Graph Frame • Legend 

• Title • Data Frame • Hi Mark/Lo Mark 
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To select bars, marks, and lines in a graph (field elements), choose 
the desired field name from the Fields submenu on the Objects menu. 

Basic Graph Parts 
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Hidden Parts 
You may have noticed there are more objects to select on menus than 
are visible in the graph window. When you create a graph, certain 
elements are automatically visible, such as the data frame, the 
dependent major grid, the placement frame, near axes, major and 
minor ticks on these axes, labels and names, the legend, names in the 
legend, and lines, bars, and marks in the legend and graph. The graph 
has other parts, however, which are usually hidden: 

• Independent Major • Minor Grids • Far Minor Ticks 
Grid 

• Far Major Ticks • Far Axes • Far Labels 

• Baselines • Hi-Lo lines • Graph Frame 

To show or hide objects, select the desired object, and then use the 
Show or Hide command from the Objects menu. 

Using the Palette 
MacGraphX's palette tools enable you to perform much of the 
formatting and all of the drawing you will do in the graph window. 
The palette also gives you color draw capabilities enabling you to add 
graphic embellishments and text. For a detailed look at the palette, 
see About the Palette. 

When modifying a graph object, a palette command is similar to a 
menu command. You select the graph object to change, specify what 
attribute to change about the object, then issue the command from a 
menu. 

If the open palette interferes with your work in the graph window, 
click in the zoom box in the palette's title bar to close it, and click and 
drag the palette's title bar to move the palette out of the way. You can 
open the palette again by clicking in its zoom box. 

Cut, Copy, Paste, Clear, and Duplicate 
Graphics and text can be cut, copied, pasted, cleared, and duplicated 
with commands on the Edit menu. Cut and Clear commands hide 
standard elements of a chart (such as a bar, grid, tick, label), and 
delete user-drawn objects. The Duplicate command duplicates 
selected user-drawn objects only. 
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Printing 
You can print out the contents of an active graph window. Using the 
Print command on the File menu with the graph window active. The 
dialog you get will depend on what printer you have selected with the 
Chooser desk accessory. Make your choices and print out your graph. 

Moving and Resizing 
By clicking on and dragging the outline of any grnph object, you can 
position it where you like. Selecting the graph or data frame will result 
in the entire graph moving when you drag the frame. This includes 
the data frame, ticks, grid lines, annotations (if any), and axis labels. 
The graph title, will not automatically move along with the graph 
frame, however, unless anchored. If you hold down the Shift key 
while moving an object, motion will be constrained to the horizontal 
and vertical directions. 

You can keep track of the exact location of selected objects in your 
graph window with the coordinates indicator shown on the palette. 
This indicator shows what type of object you have currently selected, 
its dimensions, and where it is located relative to the left and top 
boundaries of the graph window. It also indicates where the object is 
relative to its initial location as you move it horizontally and vertically. 
All distances are measured in pixels. Negative numbers indicate 
movement to the left or up; positive numbers, to the right or down. 

To help in positioning graph objects more precisely. you can use your 
keyboard's cursor (arrow) keys. A selected object will move one pixel 
in the chosen direction each time you press the cursor key (or one 
grid unit, if the Grid option has been selected in the palette). 

Anchoring Objects to the Graph Frame 
If you want graph items or user-drawn objects to keep their positions 
relative to the graph frame as you move or resize the graph, select the 
object and use the Anchor to Frame command on the Objects menu. 
When you later move or resize the graph frame, these anchored 
objects will remain in position. However, if you move the grnph too 
close to the edge of the graph window such that an anchored object 
would fall outside of the placement frame, the object will be 
positioned closer to the graph. 

Even though an object is anchored to the graph frnme, you can still 
move it independently of the graph. Moving an anchored object will 
not move the graph. 
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Aligning 
The Align submenu on the Objects menu gives you several choices for 
aligning two or more selected objects. They are: 

To Grid Aligns the top left point of selected objects to 
invisible grid defined in the palette. You must 
have Grid selected in the palette. 

Top Aligns selected objects to the top of the top-most 
object. If a frame (data frame, graph frame, or 
placement frame) is one of the objects, aligns 
objects to the top of the frame. 

Middle Aligns the middle of each selected object to a 
point halfway between the top point of the 
top-most object and the bottom point of the 
bottom-most object. 

Bottom Aligns selected objects to the bottom of the 
bottom-most object. If a frame (data frame, graph 
frame, or placement frame) is one of the objects, 
aligns objects to the bottom of the frame. 

Left Aligns selected objects to the left of the left-most 
object. If a frame (data frame, graph frame, or 
placement frame) is one of the objects, aligns 
objects to the left side of the frame. 

Center Aligns the center of each selected object to a 
point halfway betvveen the right point of the 
right-most object and the left point of the 
left-most object. 

Right Aligns selected objects to the right of the 
right-most object. If a frame (data frame, graph 
frame, or placement frame) is one of the objects, 
aligns objects to the right side of the frame. 

Frames from overlaid graphs may be aligned. 

Resetting Locations 
Should you move a graph label or title and later wish to return it to its 
default position, select it and give the Reset Location command on the 
Objects menu. 
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Transposing Axes 
If you wish to exchange the x and y axes in a graph, use the 
Transpose command from the Graph menu. This command will toggle 
the independent and dependent axes between the horizontal (x) and 
vertical (y) positions. 

Resizing Objects 
You can easily resize the graph frame, data frame, placement frame, 
legend, and user-drawn graphics. Resizing is done by selecting the 
object and clicking and dragging on a resizing handle at a corner or 
side of the object. 

If you wish to turn a rectangular or oval object into a square or circle, 
respectively, hold down the Shift key while dragging a handle. 
(MacGraphX may not always draw the data frame or graph frame as a 
perfect square, however, depending upon the "Exact Frame Size'' 
option for each dimension, but will come as close as possible.) While 
resizing a line, the Shift key constrains it to be horizontal, vertical, or a 
45° diagonal. 

Resize an object in one direction only by clicking and dragging any 
handle. To resize it symmetrically, that is, equally in two directions, 
hold down the Option key while clicking and dragging any handle. If 
you want the square or circle to resize evenly in all four directions, 
hold down the Option and Shift keys while clicking and dragging a 
handle. 

Moving or Resizing Frames Separately 
The data frame, graph frame, and placement frame are normally 
linked so that when you move or resize one, the other moves or 
resizes proportionally. The exception is that the data frame and graph 
frame can be moved around and resized within the placement frame 
without causing the placement frame to change shape or position. The 
placement frame, however, cannot normally be moved or resized 
independently of the data frame and graph frame. 

You can disable the linkage between frames by pressing the 
Command key while moving or resizing a frame as previously 
indicated. With the Command key pressed, any moving or resizing 
affects only the selected frame. You still cannot enlarge the data frame 
past the graph frame, nor shrink the graph frame within the data 
frame, however. Nor can you enlarge these frames past the placement 
frame. 
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Key Modifiers 
To summarize, use the following modifier keys while resizing an 
object to get the designated result. 

Option Resizes an object symmetrically, that is, equally 
in two directions. 

Shift Constrains an object to a square or circle. 

Option/Shift Resizes an object with full symmetry, that is, 
equally in all four directions. 

Command Disables the linkage between frames so that 
they may be resized or moved separately. 

Resizing User-Drawn Graphics with Arrow Keys 
You can use your keyboard's arrow keys, the keys that normally move 
the cursor, to resize selected objects in one-pixel increments. The 
arrow keys are used with the Shift and Option keys to resize graphics. 
The key combinations are: 

Option-Arrow Left Reduces object to the left. 

Shift-Arrow Left Enlarges object to the left. 

Option-Arrow Right Enlarges object to the right. 

Shift-Arrow Right Reduces object to the right. 

Option-Arrow Down Enlarges object to the bottom. 

Shift-Arrow Down Reduces object from the top. 

Option-Arrow Up Reduces object from the bottom. 

Shift-Arrow Up Enlarges object to the top. 

Grow to Frame 
If you enlarge the graph frame past the data frame, you can extend a 
field elements (including drop shadow), grid line, axis, or baseline of 
your graph out to the graph frame. Select the object you want to 
extend from the Dependent Axis or Independent Axis submenu on 
the Graph menu. From the Objects menu, use the Grow to Frame 
command. You may select all fields to grow in both directions by 
selecting the legend before giving the Grow to Frame command. 
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Complete Grid 
The top dependent grid line and right-most independent grid line 
overlap the data frame (assuming the normal, non-transposed, 
orientation) and therefore are not shown. If your graph includes 
negative values, the left-most independent grid line and bottom 
dependent grid line also overlap the data frame and are not shown. If 
you are making a grid visible and want these grid lines to be shown, 
choose the Complete Grid command from the Lines menu with a grid 
selected. The top or right-most grid line (and bottom or left-most grid 
lines if the graph contains negative values) will be included with the 
corresponding grid. 

Adjusting Grid Lines and Ticks 
Ticks and grid lines that intersect a widened data frame or graph 
frame can be lengthened to accommodate the greater width so that 
they overlap the frame as much as before. (Grid lines must first be 
brought to the front for this to be useful.) If you widen the data frame 
to six points, for instance, ticks and grid lines will no longer extend 
fully into the frame. 

-I 
In the illustration above, the tick overlaps the frame perfectly. In the 
illustration below, the tick does not fully overlap a widened frame. 

-I 
In the next illustration, the Length Adjust feature has corrected for the 
added width of the frame, and now the tick overlaps the frame 
completely again. 

-I 
You can even extend grid lines and ticks beyond the data frame or 
graph frame, if you wish. Or grid lines can be shortened to avoid 
touching the data or graph frame for aesthetic purposes. 
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To adjust grid lines or a set of ticks for a widened frame, select the 
grid or ticks and choose Length Adjust from the Lines menu. From the 
submenu, choose the desired length in points. If you choose an 
adjustment length equal to the width of the intersecting line, the tick 
or grid line will adjust to exactly compensate for that width. Choose 
"?" to define your own length adjustment in points, inches, or 
centimeters. 

Setting Minimum Tick Spacing 
You can change the minimum distance between ticks on an axis with 
the Preferences command on the File menu. In the dialog, type in the 
desired distance in points in the "Minimum Tick Spacing" field for log 
and non-log graphs. The default distance is 12 points. The greater the 
minimum distance between ticks, the fewer minor ticks will appear on 
an axis. 
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Working with Layers 
In the graph window you can overlay graphs and graph objects. To 
make working with overlaid graphs and graphics easier, MacGraphX 
gives you these capabilities on the Graph menu: 

Swap Graph Layers Exchanges two graphs by moving the 
graph that is in front to the back. 

Remove Layer Removes the front-most graph layer. 

Graphs in Front Moves all user-drawn graphic objects 
such as lines, boxes, and text behind all 
graphs. 

Graphs to Back Moves all user-drawn graphic objects 
such as lines. boxes, text in front of all 
graphs. 

Data Front A default setting that puts field elements 
such as marks, lines, and bars in front of 
all grid lines. Deselecting it puts grid 
lines of forward graph in front of field 
elements of back graph. 

Align Horiz A default setting that ensures that 
overlaid graphs have the same width and 
horizontal position. Deselecting it allows 
you to move overlaid graphs separately 
from side to side. 

Align Vert A default setting that ensures that 
overlaid graphs have the same length and 
vertical position. Deselecting it allows 
you to move overlaid graphs separately 
up and down. 

Note: Deselecting Align Horiz and Align Vert simultaneously will allow 
you complete freedom in moving overlaid graphs separately. 
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You also can move objects to the front or back with two commands 
on the Objects menu. They are: 

Bring to Front Brings selected objects to the front of the 
window. This is useful for objects you want 
to be visible but which have been covered up 
by other objects. 

Send to Back Sends selected objects to the back of the 
window. 

For example, selecting a grid and using the Bring to Front command 
will bring that grid in front of the field data. This is a particularly 
useful look with the bar chart, as it allows the grid to delimit sections 
of each bar. 

Zooming 
To enlarge or reduce your graph for working purposes, the Zoom 
command on the Windows menu allows you to select the size of the 
graph relative to the normal window size. Normal Size is 100 percent, 
and Fit to Window shrinks the displayed infonnation so the whole 
graph fits in the current-sized window. All other sizes are measured in 
percent of Normal Size. 

Extending the Graph Window 
You can enlarge the active graph window by hiding the scroll bars. 
From the Graph menu select Options; from the Options submenu 
select Window. In the Window Info dialog, click in the "Hide Scroll 
Bars" check box. 

You can also open the Window Info dialog by double-clicking on the 
graph title or anywhere in the window other than on a graph object. 

Text and Numbers 
In MacGraphX, you can change the way text and numbers on the 
independent and dependent axis appear, add annotations formatted in 
a variety of ways, and type in your own text. 

Adding Annotations 
Annotations can add a great deal of clarity to your graph by displaying 
field names and values. 
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With the desired field selected, choose the Annotate Type command 
on the Text menu. From the submenu, select the desired annotation 
type: 

None Removes any existing annotation. 

Value Shows the value. 

Percent of Tot Shows the percent of total. 

Running Tot Shows a running total. 

Running% Shows a percent of the running total. 

Field Name Shows the field name. 

Record# Shows the record number. 

Other Shows the value of any other field in the 
dataset. Select one. 

To specify the location of an annotation, you can use the Annotate 
Place and Annotation Gap commands also on the Text menu. First 
select the field (by clicking on it in the legend), and then give the 
command. 

Annotate Place indicates placement for annotations relative to a 
selected category. Annotation positions in the top row of icons apply 
to a pie chart. Annotation positions from the second and third rows 
are useful for scatter, line, and area graph, so that the annotation will 
be close to the data point. Annotation positions from rows after the 
first apply to a bar or stacked bar chart. The choices are: 

.. 
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For example, the first choice in the third row puts the annotation text 
to the left near the top of the object. The center choice in the second 
row centers the annotation text above the point or bar. This is the 
default position for a non-pie annotation. 

Annotation Gap allows you to set the amount of space between the 
annotation and the boundary of a bar, edge of a pie wedge, or 
position of a mark. 
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Number Formatting 
When you add annotations to a graph, it is often useful to specify 
their numeric formatting. If you are dealing in percentages, for 
example, you will want annotations to display a % sign. Or if you 
have a financial chart, you will want the proper dollar formatting to 
appear. To make these and other. formatting changes, select the 
desired field by clicking on its name in the legend and use the Num 
Format command on the Text menu . On the Num Format submenu 
you have several predetermined settings to choose from. For a list and 
explanation of these settings, see the Num Format command in the 
Menu Commands and Dialogs chapter. 

If you choose the New Format dialog to create your own custom 
numeric format, you have several choices. For an explanation of these 
options, see Num Format command in Menu Commands and Dialogs. 

Formatting Axis Labels 
The numeric formats described above can also be used to change the 
way that numeric values on the dependent and independent axis 
labels are displayed. To use these formatting capabilities to make 
changes to the axis labels, select the desired labels and use the Num 
Format submenu from the Text menu. 

Staggering Labels 
If an axis has so many values plotted on it, or long labels, so that the 
axis labels run into one another, you can stagger the labels to separate 
them farther from each other. Staggering puts axis labels into more 
than one row so that many values appear clearly along an axis. This is 
useful is the horizontal axis mas many labels, or the vertical axis is 
crowded and its labels have been rotated. 

To stagger labels or change the way they are currently staggered, 
select Near Labels from the Independent or Dependent Axis submenu 
on the Objects menu, or click on the labels once. Then choose 
Stagger from the Text menu. A submenu gives you several choices: 

Auto Lets MacGraphX stagger axis labels as necessary. 

None Puts staggered labels into a single row. 

2 Lines, Staggers labels into t,vo or more lines. 

3 Lines, and so 
on 

Flipped Reverses the lines of staggered labels. 
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Fonts and Typefaces 
Changing font attributes and typefaces is the same in the graph 
window as in any standard Macintosh application. You can change 
attributes for axis labels, axis names, annotations, and user-created 
text by selecting the desired objects and using the Font, Size, Style, 
Alignment, and Rotate commands from the Text menu. To change the 
font or typeface of annotations, select the appropriate fields in the 
legend by clicking on their marks. Do not try to select annotations by 
directly clicking on them. 

The Rotation command allows you to rotate selected text to the left, 
right, or upside down, or return it to a normal orientation. Left 
corresponds to counter-clockwise, right to clockwise. 

When setting alignment, remember that text is aligned to the border of 
the text box, not to any object outside the box. Labels are aligned to 
tick marks if they are perpendicular to the tick marks, or are aligned 
to each other if the labels are parallel to the tick marks (as commonly 
seen on the dependent axis). 

Adding Your Own Text 

To add your own text to a graph, select the text tool , T , from the 
Tools pull-down menu (currently displaying a pointer) in the palette. 
The pointer will turn into a text insertion cursor as it passes over the 
graph. 

Place the cursor where you want to begin, click, and type your text. 
When you want to begin a new line, press the Return key and 
continue typing. If you continue typing when a line gets to the edge 
of the window, your text will not automatically wrap to the next line. 
Wrap the text manually by pressing the Return key. You can end 
typing by clicking anywhere in the graph window, or pressing Enter. 

Mixed Text 
Text attributes and typefaces can be mixed in the same line for labels, 
titles, ~ind user-drawn text. Make the desired formatting changes from 
the Text menu (Font, Style, Size) as you create text, or select existing 
text and make the desired changes. You cannot, however, mix text 
colors in the same text block. 

Changing the Dependent Axis Title 
If you're graphing two or more fields, the dependent axis is normally 
titled "Data." You may want to change this title to something that is 
more appropriate, such as "Dollars in Thousands" or "Frequency in 
MHz." 
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To change the standard title that is used with all graphs (the default 
title), use the Preferences command on the File menu. In the 
Preferences dialog, type the desired title in the "Default Dependent 
Title" field. You can make the title the default for all new documents 
by selecting "All New Files." 

Colors, Shapes, Patterns, and Lines 
MacGraphX gives you many choices for changing colors, shapes, and 
patterns of objects in the graph window. You can even add drop 
shadows to graphs, bars, pies, and user-drawn objects. 

Most of the changes you make to graph objects are made using draw 
tools found in the palette. (For a detailed description of the palette, 
see the chapter, About the Palette.) To use the palette's capabilities, 
select the desired object, make the palette choice specifying the 
attribute to change. Your command choices are: 

Color Specifies the color of a selected attribute 
of a graph object. In addition to the color 
selections given, New allows you to ') 

define new colors, including ramped 
colors for graduated color fills. 

Pattern Specifies the pattern of a selected 
attribute of a graph object. Choose a 
pattern from the pop-down menu. 

Mode Determines the background of patterns, 
either white, black, or clear. 
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Listed below is a table of anributes and commands from the palene, 
and the graph objects they affect: 

This command ... Can change this Of this object 
part ... 

Panern, Mode, and Fill-The fill of a Field element such as a 
Color graph object bar, area, piece of a pie 

or stacked bar, legend, a 
graph frame, a 
user-drawn graphic other 
than text or lines. 

Pattern, Mode, and Line - Line or Field element such as a 
Color boundary line, area, bar, stacked 

bar, or pie wedge, 
legend, a tick, grid lines, 
Hi-Lo lines, a data or 
graph frame, non-text 
user-drawn graphic. 

Pattern, Mode, and Drop-Drop Field element such as an 
Color shadow area, bar, stacked bar, or 

pie wedge, legend, 
graph frame, non-text 
user-drawn graphic. 

Color Text-Text Graph name, field 
names, axis labels, 
annotations, user text. 

Color Mark -Field or Marks on a scaner, line, 
Hi-Lo mark or area chart; Hi-Lo 

marks. 
Pattern and Color Bkgd-Text Graph name, field 

background names, axis labels, 
annotations, user text. 

Note that you use empty (X) pattern to hide the drop shadow. 
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Creating Your Own Colors 
MacGraphX gives you the ability to create any custom colors you like, 
and add them to the list of colors in the palette. To define your own 
color, select New from the Color menu on the palette. In Apple's 
Color Picker dialog, you define a color by setting the Hue, Saturation, 
and Brightness; or the Red, Green, and Blue components of the color 
you want. Change the numbers in the fields corresponding to these 
attributes by highlighting them and typing in new ones, or by clicking 
on the arrows next to them. You can also use the scroll bar to the 
right of the color wheel to set brightness, and click on a color on the 
color wheel to set Hue and Saturation. 

Select new color 

Hue~O 00 
S11turotlon O 00 
Brightness 65535 (;] 

Red 65535 00 
Green 65535 00 

Blue 65535 00 

1.4 

When you have set your color, click OK. In the dialog, give your 
color a name. When you return to the graph window, your new color 
wiil appear on the color menu and you can select it as desired. 
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Ramped Color 
A ,.imped color, or graduated fill, is created in the same manner as a 
solid color, but with one additional step. In the second dialog, select 
the "Ramp" check box. You will return to the color picker dialog to 
specify a second color. The second color is necessary to create the 
effect of one color gradually shading into another. This second color 
can be completely different, or it can be a different shade of the first 
one. (If you're planning to output to a film recorder, you may wish to 
have the second color be a darker or lighter version of the first, for 
best results, due to hardware limitations.) When you have completed 
this second step, you will return to the dialog to name the color. 

=--'----'- -=--= New Color - ~-~ 

Color Nome: li..,ew color I 
_I' I[ OK JI 

!8]R11mp... , 

[ Cancel ] 

Note: that you can use a pattern with a graduated color, and the 
pattern will respect the graduated color. 

Color Position 
With ramped colors you have sever.ii options for specifying the 
direction in which one color will shade into the other for a selected 
object. The Color Position submenu on the Areas menu gives you 
these choices: 

~ Windows 
Round Corners ► 

Shadow Uert ► 
Sh11dow Horiz ► 
3-0 Shadow 
Surround Shadow 
Forward Shadow 

r,roup Sl7e I> 
l.lne \IZl' I> 
Line Ulfwt. .. 
l.uoc, \hilt... 

11~ 
llo,r IJrifl'r ► 

~ 

El 13 ~ 
■•t I 'I I 

Color Reuersol 

~ ~ ffi 
~ Ir.] ~ 

The arrows for each selection on the menu show the direction in 
which the first color you defined shades into the other. 
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You can reverse the order in which your colors blend. If blue shades 
into green, for example, you can change it from green to blue. Select 
the object and choose the Color Reversal command on the Areas 
menu. 

Fast Redraw 
Redrawing a screen with graduated fills takes more time than 
redrawing a screen with only solid colors. If you wish to turn off 
graduated fills in a graph window you are updating frequently, select 
Fast in the palette. MacGraphX will redraw the screen using only the 
first color from graduated fills. 

Creating Your Own Graphics 
You can create your own graphics with the draw tools on the palette. 
These tools give you the ability to create vertical, horizontal, and 
diagonal lines and arrows, rectangles, squares, ovals, and circles. You 
can apply formatting commands from the palette and menus to these 
user-drawn graphics in the normal manner. 

To select a tool and begin drawing, use the Tools menu on the palette 
and choose the desired object. For a list and explanation of palette 
tools, see About tbe Palette. 

To bring up a clear graph window in which to draw, from the Graph 
menu select New Graph; from the New Graph submenu select Blank 
(Draw). 

Line Formatting 
The palette lets you specify line colors, patterns, and modes. The 
Lines menu lets you to change the length and width of lines and ticks, 
adjust tick position on an axis, extend grid lines, axes, and the 
baseline to an enlarged graph frame, and adjust the length of grid 
lines and ticks for a widened data frame or graph frame.Your line 
formatting options are: 

Line Width Lets you select the width of a line in points. 

Tick Length Lets you set the length of tick marks in 
points. 

Length Adjust Adjusts the length of selected ticks and grid 
lines to the width of a perpendicular line 
(normally the data frame or graph frame). 
(See Adjusting Grid Lines and Ticks.) 

Tick Position Lets you to set the position of selected ticks 
(inside, outside or crossing the axis line). 
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For Line Width, Tick Length, and Length Adjust, selecting ''?" on the 
submenu allows you to select a custom size in points, centimeters, or 
inches. 

Displaying Hi-Lo Lines (Error Bars) 
Hi-Lo lines are used to clearly distinguish the high and low data points 
on a chart. They also serve as error bars for scientific graphs. 

A Hi-Lo line is simply a line running parallel to the dependent axis 
with a mark on each end. To display Hi-Low lines, select Full Graph 
from the Objects menu. On the submenu, choose either Hi Mark or Lo 
Mark. Then choose Show from near the top of the same menu. Hi-Lo 
lines will appear for each group of data in your chart. 

To display a Hi-Lo line in the legend box along with field marks, from 
the Graph menu select Options; from the Options submenu select 
Legend. In the Legend Info dialog, select "Show Hi-Lo." 

You can also open the Legend Info dialog by double-clicking on the 
legend frame. 

Customizing Marks and Hi-Lo Lines 
You can change the length of Hi-Lo lines and the size and shape of 
Hi-Lo marks. To change the length of lines, select Legend from the 
Shifts submenu on the Graph menu. In the Legend Info dialog, select 
either "Absolute", "Percentage", or "Std Dev'ns··. This sets the Hi-Lo 
lines above or below the field values by an absolute number, 
percentage, or number of field standard deviations. Enter numeric 
values in the fields corresponding to "Hi Delta" and ··Lo Delta:· To 
achieve a desirable effect, experiment a bit. Generally speaking. limit 
yourself to relatively modest values or Hi-Lo lines will not present an 
accurate view of your data. 
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To change the shape of the marks at each end of Hi-Lo lines, first 
select Hi Delta or Lo Delta from the Full Graph submenu on the 
Objects menu. You can also click on the top or bottom half of the 
Hi-Lo line in your legend if you have it displayed there. Then choose 
Mark Type on the Lines menu. You will see an assortment of mark 
types. They are: 

m .• 

• + m 

► 
Tick lon111t1 ► 

ll'lll_l th ll1ljusf ► 

Tick Posit Ion ► 

Ccirn11lof « Grid 

Cun•<~:; \t1~p~ 
er Mnnuul lh~i:<11< 

► 
► 

o o a Cf" [ul1: Nnw 

x X 0 

• ♦ ♦ Bl 

0 D ♦ 0 

o O • • 

Rounding Corners 
You can round the corners of a bar, stacked bar, table, graph frame, 
legend, placement frame, or user graphic with the Round Corners 
command. This command lets you specify the roundness of the 
corners of a rectangle. Selecting "?" lets you set a custom corner size 
in points, inches, or centimeters. 

Field and Group Formatting 
MacGraphX gives you control over the size of individual fields and 
groups of fields with several commands on the Areas menu. You can 
also change their distance from each other and their order along the 
independent (usually, x) axis. First select a field, then give the desired 
command. 

To select the size of an entire record group as a percentage of the 
width of an interval along the independent axis, use the Group 
command. The standard size is 75% of this interval. Choosing "?" on 
the submenu allows you to set a custom width for the field group in 
points, centimeters, or inches, or as a percent value with settings in a 
Sizes dialog. 

A scale indicates with a black horizontal bar the total width of the 
field group in inches and centimeters relative to the width of the 

Formatting Your Graph 126 

~ 
~ 

' 

FP 
!· 
11 

\ 

w 

~ 
I 

~ ~ 
c:.... I I 
~ ~ 

' ! 

~ 
I ~ 

• 1' ' 

' 

l 



graph. Displayed beneath it is the width of a major interval on the 
independent axis. "Percent" sets the group width as a fraction of the 
major interval width (between major grid lines) of the independent 
axis; "Gap" insets the bar group from the major interval. 

Sizes -

===®Inch 
O Absolute lllilDIIIIIO Cm. 

~-~OPolnts 
® Percent j 74 j 

QG11p jD.167 I 
0Ncg 

OK 

[ C1rncel ] 

Reset 

q i ~ I i 
I, 1, I, 1, I, 1, I, 1, I,,, I, 1, 1,,, I, 1, I 
I I 1 f I I I I 1 p I I I I 1 f I I I 1 
q ~ i ~ ~ ~ 

I 2 • Minor Grid Size a I 00°!. (98 pts)J 

To specify the size of an individual bar or wedge of a pie, use the Bar 
Size or Pie Size command after selecting the desired field. Submenu 
choices are percentages of the group size. Choosing"?" lets you set a 
custom width for the field element in points, centimeters, or inches, or 
as a percent value with settings in the dialog. 

A scale indicates with a black horizontal bar the total width of the 
field element in inches and centimeters relative to the width of the 
graph. Displayed beneath it is the value of the field size divided by 
the number of bars, or the width of a stacked bar, depending on the 
graph. For a bar graph, the "Percent" choice sets the bar width as a 
percentage of the width of the bar group (depending on the number 
of fields); "Gap" sets the individual bar width to be inset from the 
group width. 

To set the radial or horizontal position of an element relative to its 
normal location, use the Offset command. Setting a negative value as 
a percentage moves an element to the left in a line, bar, or stacked 
bar chart. A positive value moves it to the right. In a pie chart, a slice 
of the pie is moved radially away from the chart regardless of whether 
you use negative or positive numbers. The "Percent" choice sets the 
distance as a percentage of the bar or pie's own size or, with a line, as 
a percentage of the major spacing on the independent axis. 

With a line graph you can move a line vertically with the Line Shift 
command on the Lines menu. Setting a negative value moves the line 
down. A positive value moves it up. The "Percent" choice in the 
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Offset dialog sets the position as a percentage of one major inteival of 
the dependent axis. 

You can set the left-to-right order of all the bars in a group with the 
Bar Order command. You can also reorder the fields within a group 
by selecting a field in the legend and dragging it to reposition it 
relative to the other field elements. 

Shadows 
Using drop shadows gives graph objects an illusion of depth. Create a 
drop shadow by selecting the desired object, choosing Drop on the 
palette, and specifying the color, pattern, and mode you desire. Drop 
works with any graph object, except text, lines, and marks. You can 
hide the drop shadow for an object by choosing the empty pattern for 
the drop shadow's pattern; the empty pattern is found at the top row, 
left side, of the Pattern menu on the palette, and is indicated with an 
"X." 

You can make changes to the drop shadow of a selected graph object 
any time by choosing a new color, pattern, or mode from the palette 
or by making several choices from the Areas menu. They are: 

Shadow Vert Lets you specify the vertical displacement of a 
drop shadow. Selecting"?" lets you set the 
vertical displacement in points, centimeters, 
or inches. 

Shadow Horiz Lets you specify the horizontal displacement 
of a drop shadow. Selecting"?" lets you set 
the horizontal displacement in points, 
centimeters, or inches. 

3-D Shadow Changes the shadow of a selected graph or 
user drawn object to a three-dimensional 
shadow. This fills in the area between the 
object and its shadow. 

Surround Shadow Changes the shadow of a selected graph or 
user-drawn object to one that surrounds the 
object evenly on all sides. 

Forward Shadow Shifts an object so its shadow resides on the 
object's original position. 

Delaying Screen Updates 
MacGraphX can make multiple formatting changes concurrently by 
waiting to update the screen until after you specify several changes. 
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This saves you the time of having to wait for one formatting change to 
be completed before making another. To use this feature, hold down 
the Control key (on the left side of the extended keyboard, below the 
Shift key) while making the desired choices on the palette or from 
menus. You can even draw an object. When you release the Control 
key, all the formatting changes will be executed. 

Formatting the Legend 
You may format the legend in a variety of ways with settings in the 
Legend Info dialog. This dialog enables you to put field names into 
rows or columns, set margins, show names for fields that are hidden 
in your graph, and show Hi-Lo lines that appear in your graph. 

To use these formatting options, from the Graph menu select Options; 
from the Options submenu select Legend. In the Legend Info dialog, 
make your choices. For an explanation of choices, see the Legend 
command in the Menu Commands and Dialogs chapter. 

You may also open the Legend Info dialog by double-clicking on the 
legend's border. 

Resetting Attributes 
Any object in the graph window, including user-drawn graphics, can 
be returned to its default values by selecting the object and giving the 
Reset Attributes command from the Objects menu. 

Creating and Using a Template 
If you particularly like the way you have formatted a graph, you can 
save its attributes to apply to any new graph. Do this by selecting 
Template on the Graph menu with the desired graph window open. 
Name the template, which is a record of all the parameters you have 
set for the active graph, and click Add. Your template name now 
appears on the list of graph types on the New Graph submenu. When 
you wish to create a graph that looks the same as this one, just select 
it as you would any of the other types. 

You can add, change, and delete any template by opening the 
Template dialog, making the desired changes, and clicking the button 
to add, delete, or change. 

Saving a PICT File 
You can save any graph you are working on as a PICT file for use in a 
desktop publishing, desktop presentation, or graphics program by 
using the Save PICT command on the File menu. This command 
allows you the graphic image as a PICT file. 
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Chapter 10: The Layout and Letterhead Windows 
Working in the layout and letterhead windows lets you take the 
graphs you have created and formatted and lay them out over one or 
more pages with a recurring background. The layout and letterhead 
windows are opened by double-clicking on their icons in the docking 
window. You can also open them or bring them to the front of other 
windows by selecting them from the Open Window submenu on the 
Windows menu. 

Using the Letterhead Window 
The letterhead window serves to place recurring text or graphics on 
each page in the graph and layout windows. When you open the 
letterhead window, you see a blank window with the palette in the 
upper right comer. You can create text or graphics in the letterhead 
window, positioning it where you would like it to appear on pages in 
the graph and layout windows. 

For example, a footer placed in the letterhead window (displayed with 
Zoom set to Fit to Window), 
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shows in the same location in the graph window, 

and across pages in the layout windO\v. 
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The Palette 
To create text or graphics in the letterhead window, use the palette as 
you would in a graph window. For an introduction to the palette and 
an explanation of how to use it to create text and graphics, see About 
the Palette, and ·'Colors, Shapes, Patterns, and Lines·· and 'Text and 
Numbers" in Formatting Your Graph. 

When you have finished creating or pasting text or graphic objects 
into the letterhead window, position the objects on the letterhead 
page where you would like them to show on pages in the layout or 
gr..1ph windows. You can reduce the window size with the Zoom 
command on the Windows submenu to make it easier to position the 
text or graphics. 
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Using the Layout Window 
The layout window enables you to take multiple graphs and lay them 
out and print them over multiple pages. You can create a layout of up 
to 81 pages (9 by 9). When you open the layout window, you see a 
blank window with the palette in the upper right corner. You can use 
the palette ro create text or graphics, but not to modify any graph 
placed in the layout window. If you have created a background in the 
letterhead window, you will see it in the layout \vindow (unless you 
have elected not to). 

Setting Up the Layout 
To specify the number of pages a layout will consist of. open the 
Window Info dialog by selecting Window from the Options submenu 
on the Graph menu, or by double-clicking anywhere in the layout 
window. In the dialog, specify the number of vertical and horizontal 
pages by selecting a number from the "Pages Across" and "Pages 
Down" pop-up menus. 

How many pages down or across to make a layout"' ill depend on 
how many graphs you want to place in the layout window, and how 
large they are. 

Landscape Orientation 
If a landscape (horizontal) page orientation would help better present 
your graphs, you can select page orientation with the Page Setup 
command on the File menu. The dialog you get will depend on what 
printer you have chosen with the Chooser desk accessory. If you 
choose a horizontal page orientation ajiercreating a letterhead 
background or setting up the layout window, be sure to check where 
text and graphics appear after making the change. 

Placing Graphs in the Layout Window 
When you have the layout size as large as you want, you can begin 
placing your graphs. With the layout window frontmost, select Place 
Graph from the Graph menu, and choose the desired graph by title 
from the submenu. The graph will appear in the upper left corner of 
the first page of the layout. You can click and drag your graph to any 
location in the layout. 

Graphs placed in the layout window will appear as outlines only. This 
makes it faster to update the screen. If you wish graphs to appear in 
full detail, choose the "Show in Layout" check box in the Window 
Info dialog of the grapb window of the placed graph ( not the layout 
window). 
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Remember that even when fully visible your graphs are no longer 
really graphs in the layout window; they are images of graphs. They 
cannot be modified or updated in the layout window. To change the 
appearance of a (placed) graph in the layout window, go back to the 
(placed) graph's own window and modify the graph there. 

Using Options and Commands 
The Window Info dialog provides you with several options for 
working in the layout window. The Window Info dialog is the same 
as the dialog for a normal graph window. From the Graph menu 
select Options; from the Options submenu select Window, or 
double-click anywhere in the layout window, but not on a graph 
object. See the Window command in Menu Commands and Dialogs 
for an explanation of choices. 

When working in the layout windmv, you have full use of the Cut, 
Copy, Paste, and Clear commands. You can also use the Move to 
Front and Send to Back commands on the Objects menu, as well as 
the Align command there. For an explanation of these commands, see 
the Menu Commands and Dialogs and Formalling Your Grapb 
chapters. Most other formatting and .. tructuring commands are 
disabled in the layout window. 

Adding Text and Graphics 
You can add text and graphics in the layout window by pasting it in 
or creating it with the palette. To create text or graphics in the layout 
window, use the palette as you would use it in a graph window. For 
an introduction to the palette and an explanation of how to use it to 
create text and graphics, see the chapter About tbe Pale/le, and 
"Colors, Shapes, Patterns, and Lines .. and .. Text and Numbers·· in the 
chapter Forma11i11g Your Grapb. 

One type of text you may want to add to your layout is page 
numbering. Page numbers must be manually entered and placed. Use 
the the palette's text tool to create text, and the commands on the 
Text menu to format text. 

Printing 
When you have finished laying out your graphs, you can print out all 
or part of the layout. Use the Print command on the File menu \Vith 
the layout window active. The dialog you get will depend on what 
printer you have selected with the Chooser desk accessory. Make your 
choices and print out your document. 
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Chapter 11: Building Formulas 
MacGraphX allows you to define the value of a field as the result of 
calculations determined by a formula. The ability to define formulas 
lets you examine your data under the light of mathematical models, 
and allows you to generate values for fields based upon specific 
relationships. For example, if you know gross revenue and costs and 
want to find profits, you can create a Profits field defined by a 
formula that subtracts the Costs field from the Revenue field. Profits 
will then be calculated for every record in your dataset, and 
recalculated if the data change. 

Parts of a Formula 
Formulas consist of operands, operators, and Ju net ions. Operands 
specify the data used in the formula's computations. They can be 
numbers, the results of a complex calculation, field references, or, in 
some cases, text. 

Operators define the kind of computations to be performed. They 
can define arithmetic, logical, or comparative operations. For an 
explanation of all the operators, see the description of the 
Operators menu in Menu Commands and Dialogs. 

A function is a rule which operates on a set of arguments and 
returns a value. Arguments differ from function to function and can 
be numbers, text, dates, or fields. For example, the function ABS 
takes a numeric value and returns its absolute value. Thus, ABS(-5.6) 
will return 5.6. Not all functions operate on arguments. For example, 
the function RAND is a random number generator and takes no 
arguments. 

For a description of functions and their arguments, see the 
Functions menu in Menu Commands and Dialogs. 

Creating Formulas 
To define a formula for a field, from the Edit menu, choose Data; 
from the Dataset submenu, select Fields. Or you may double-click 
on a field name. First, type the name for the new field in the ''New 
Name" edit item of the Define Field dialog. Tab to the "Formula'' 
field. In the "Formula'' field, enter the operand, operators and 
functions. If the operand is a value, type it in. If it is a field 
reference, type in the field name or select it from the Fields menu. 
Choose desired operators from the Operators menu, or a function 

Building Formulas 134 



J ~ I '/ 
,I __n __ 

:ff~ 
: .. , i I ii' 

. Tu 
·~ ~ 
.~ 

~ 

from the Functions menu, or type them in. A formula calculating 
profits, for example, might look like this: 

Define fields , ~ 

I I ' ( Delete ) I ) Rdd 
@Number □ No Stat 

(Rename) QTeHt D No Graph 
( Cancel ) 

Record# ~ ( Modify ) 
Year Notes 
Region 
Sales 
Reuenue 
Costs 

' r.= 

Formula: O Constant D N/R Is err I Reuenue - Costs I 
This formula tells MacGraphX to subtract the value in the Costs 
field from the value in the Revenue field and return the result in the 
Profit field, for each record. When you have completed a formula, 
click Add if you are adding a field, and click Modify if you are 
redefining an existing one. 

Order oF Evaluation 
When formulas contain more than one operator, MacGraphX 
performs the operations in the following order: 

• I\ 

• - (negation) 

• • or I 

• + or -

. =, <>,<,>,~,:5 

• NOT 

• AND,OR 
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You can change the order of evaluation by using parentheses to 
group operations. The operations in parentheses are performed 
first. For example, 40•(l0-5)/(6+8)/\2 means: 

• Subtract 5 from 10 

• multiply the result by 40 

• add 6 and 8 

• square this number 

• divide the result in step 2 by the result in step 4. 

Using Functions 
With the Define Field dialog open, the Functions menu appears 
active and lists MacGraphX's functions. There are six types of 
functions: 

Constants ► 

Arllh Fens ► 
Trig Fens ► 
Logleol Fens ► 
Dote Fens ► 
Flnonelol Fens ► 

For an explanation of the ·functions on each submenu, see the 
Functions menu in Menu Commands and Dialogs. 

Functions can be entered alone or as part of a formula. To enter a 
function, type in the function name or select it from a submenu on 
the Functions menu. For the arguments, type in values or choose 
field names from the Fields menu. 

About Arguments 
Although some functions take no arguments, most have one or 
more arguments. An argument is a value on which a function 
operates. An argument for a function is the same as an operand for 
an operator. Arguments of a function appear in parentheses and are 
separated by commas. In MacGraphX, an argument can be a 
number, a field reference, or the result of a calculation. 
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For example, the function that takes two numbers and returns the 
remainder of the first divided by the second, MOD, could look like 
this, 

MOD(17,5) = 2, 

or like this, 

MOD(Widgets,Gizmos) = n . 

In the first example, the two argument are numbers; in the second, 
field references . 

Applying Transforms 
Transforms are a type of function which, rather than acting on data 
within each record separately, act on data in all the records 
cumulatively. For example, a transform might generate a running 
total of all values in a given field in several records. Like the 
functions discussed earlier, some transforms take arguments and 
others do not. MacGraphX comes with several transforms, and you 
can build your own. For a list and explanation of MacGraphX's 
transforms, see the Transforms and Curve Fits menu descriptions in 
the Menu Commands and Dialogs chapter. 

Transforms are used the same way operators and functions are. In 
the Define Field dialog, select an existing field or enter the name of 
a new one. Enter the transform in the "Formula'' field with the 
appropriate arguments in parentheses. Click on Add or Modify to 
execute the transform. 

Using Transforms for Curve Fits 
Transforms can be used elsewhere besides the data window. 
MacGraphX uses transforms to create curve fits in scatter charts. 
Curve fits are lines that represent a mathematical model of your 
graph data. They are useful for showing patterns in data. 
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This is a straight line curve fit for a simple scatter chart: 

This curve fit reveals a trend in the data that would not be as easily 
seen by simply connecting the marks. It shows an overall increase in 
the y variable as the x variable increases. 

Creating a Curve Fit 
You can define a curve fit with transforms provided in MacGraph.X 
or your own transforms. With a graph window active, select one or 
more fields from the legend. Use the Curve Fit command from the 
Lines menu; from the Curve Fit submenu, choose Define Curve Fit. 
In the dialog, type a name for the curve fit in the name field. Tab to 
the ''Formula'' field and select the desired transform from the Curve 
Fits menu. 

When you have finished selecting a transform and specifying its 
parameters, click Add. The transform name will appear on the 
Curve Fit submenu, and the curve fit will appear in your scatter 
chart. To use this curve fit again, you need only select the desired 
fields and choose the name from Curve Fit submenu. 

Building Your Own Transforms 
If you wish to build your own transforms for use in generating curve 
fits or for use in the data window, Bravo Technologies will send you 
a special instructional kit. The kit is free and will describe transform 
programming in detail. Write or call us to obtain this kit. 

Building Formulas 138 

I 

fYI 
~ 

~ 
~ 

~ 
~ 

~ 



Chapter 12: Making Graphs with Impact 
In this chapter, you'll learn how to design graphs that clearly 
communicate the implications of your data. 

Regardless of the graph type that you select, a few basic guidelines 
invariably apply. 

Simplicity - ''Less is more,"' to quote any postmodernist. Use 
visual enhancements with discretion. Use only the amount of 
background grid necessary to showcase the data plotted on it. 
Distinguish primary points with bold, large type. Use the draw 
capabilities of MacGraphX to emphasize data values or 
trends. Avoid distracting visual elements. Devote your efforts 
to showcasing your data, and when you've done so, stop. 

Clarity - Make it as easy as possible for a viewer to understand 
your graph. se specific language and clearly legible text in 
your titles, labels and annotations. Avoid symbols or legends 
that aren't instantly understandable. 

When you're presenting more than one graph on a given 
subject, use a template, so all graphs use the same format. 
Graphs displaying related data are easier to understand if they 
use a common format: Variations in data are far more 
obvious if the graphs have similar appearance. 

Validity - Not every set of numbers calls for graphing. Use 
graphs only when the significance of your data indicates 
trends or relationships. Use the right kind of graph to 
highlight the important relationships. 

Using the Right Graph 
Whenever you're ready to create a graph in MacGraphX, you'll have 
seven different graph types to choose from. The type you'll want will 
depend entirely on what kind of data you want to display, and on 
what you want to emphasize - trends, changes, or values, for 
example. In some cases, you might want more than one type of 
graph, since each will showcase different aspects of your data. 
Below, we'll describe each graph type and tell you which is best 
suited for what kinds of data. 
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Scatter 
Scatter graphs are best suited for discerning a pattern in a 
seemingly random group of data. 

Scatter charts are so named because they display data that (until 
you graphed it) wouldn't normally indicate clearly defined patterns. 
The initial pieces of data are essentially "scattered." 

Presented as numbers, these pieces of data wouldn't indicate such 
tidy specifics as trends or averages. But plotted as a scatter graph, 
the data can allow viewers to make deductions based on the cluster 
patterns of the data. You can indicate the trend within the data 
group by using the curve fit capabilities of MacGraphX to showcase 
any mathematical relationships underlying the data. 

You can use a curve fit to create a line showing a trend in your data. 
Widen the curve and give it a translucent pattern so that it appears 
as a tinted swath clearly pointing out the direction in a seemingly 
random set of data points. See the chapter Building Formulas to 
learn about using curve fits. 

Suggestions 
• When graphing several different kinds of data, make marks 

visually distinct by using different shapes, sizes, and colors. If 
you use large marks, make sure they don't overlap. 
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• You can label marks in a scatter chart with annotations if 
there are not too many points. Otherwise, it is best to use a 
legend or key to show what fields are represented. 

Line 
Line graphs are ideal for comparing two continuous (numeric) 
variables, such as sales (on the vertical axis) versus time (on the 
horizontal axis), or tax rate versus revenues. 

In Western cultures, time, or any other continuous variable, 
generally increases from left to right on the number line. Therefore, 
such independent variables are plotted on the horizontal (x) axis. 

Suggestions 
• Don't plot several fields whose values are too close to one 

another. You'll end up with a confusion of lines running 
across your graph. Instead, use several different graphs for 
fields with similar values. 

• If you want to call attention to the result of the plotted data, 
show the far dependent axis (at the right edge of the diagram) 
and have the curve end there. Doing so emphasizes the end 
point rather than the beginning or middle of the data. 

• When you emphasize a field by widening its line (using the 
Line Width command from the Lines menu), make sure the 
line doesn't obscure data values. The line should be thick 
enough to clearly show trends, but thin enough to show 
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specific values. Selective use of color is also effective in 
emphasizing lines. 

• To draw attention away from the graph data points, hide the 
marks. (Select no marks, "N," from the Mark Type submenu of 
the Lines menu.) If the specific data are crucial, enlarge the 
marks to make them more visible, or give them a contrasting 
color. You can annotate the marks as well. 

• To emphasize a future projection, draw in a colored or thick 
line. 

Area 
Area graphs are useful primarily to show accumulated data versus a 
continuous variable. For example, you can plot revenues for three 
product lines by year. The top line of the area graph will give total 
revenues for all three products. 

A line graph emphasizes trends; an area graph emphasizes totals. 

Because area graph automatically totals the data, it can be difficult 
to ascertain the contribution of any one field, assuming two or more 
fields are being graphed. For precise comparisons of field data, try 
line, scatter, or bar graphs. 
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Suggestions 
• If you're working with an area graph, use sharp contrasts to 

clearly distinguish the areas: dissimilar patterns and 
contrasting colors work well. 

• When you're presenting simple data (with just a few data 
points) area graphs can look impressive. Don't use area 
graphs for more complex data with many data points; the 
results will be distractingly jagged. 

Bar 
Bar graphs are useful for comparing field values and de­
emphasizing trends. In contrast to line or scatter graphs, in bar 
graphs the independent field is often discrete (not continuous). 

Horizontal bars are useful for comparing discrete field values (such 
as sales by product line) because they don't imply a quantity 
relationship as vertical bars do by their left-to-right ordering. 
Horizontal bars can be arranged in a number of ways: 
alphabetically, in ascending or descending order by size, in random 
sequence, and so forth. This format lets you put field labels inside 
the bars where they can be read from left to right. 
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Suggestions 
• Avoid creating a bar chart with many field values. The 

resulting graph will be too cluttered. When you're working with 
many values, you might be better off using a line chart, or 
paring down the data so that they can be rendered with fewer 
bars. 

• Given its natural simplicity, the bar chart lends itself to 
experimentation and embellishment. You can use different 
grid lines, tick widths, bar patterns and colors, and 
backgrounds, as you see fit. 

• Label vertical bars with text running left to right, rather than 
rotating field labels (or other annotations) vertically along 
the bar. You could center a label above or alongside the bar. 

• If you want to emphasize the disparity in length between bars, 
consider overlapping the bars (use the Bar Offset command 
from the Areas menu). This can produce a dramatic effect. 

Stacked Bar 
Stacked bars show comparisons of summed (cumulative) amounts. 

Bars in a stacked bar chart are subdivided into components 
representing separate field values. 

Stacked bars are useful when showing the relative proportion of the 
parts to each other is more important than showing the relative 
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proportion of the parts to the whole. If showing parts in relation to 
the whole is your aim, use a pie chart. Because a rectangular bar 
makes judging area easier than a round pie, comparing values to 
each other is easier in bars than comparing slices of a pie. 

Suggestions 

Pie 

• When you're using stacked bars, place the dominant 
element at the bottom of the bars to act as a visual base 
against which the other segments can be measured. 

• Use contrasting colors or patterns to distinguish the 
different fields in a bar. 

Pie charts show the proportion of parts to the whole. 

In a pie chart, a circle is broken into segments, called slices or 
wedges, proportional to the sizes of the elements plotted. The pie is 
best suited for showing the proportion of the parts to the whole, not 
of the parts to each other. 
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Pie charts lend themselves well to the dramatic presentation of data, 
particularly when color and other embellishments are added. 
Although the pie is better suited to showing the proportions of the 
whole, comparisons among data from several records are also 
possible. 

Suggestions 
• Generally speaking, you'll want to limit the number of 

divisions in a pie to six; too many slices make the pie difficult 
to read. 

• To emphasize a given field of a pie chart, separate the slice 
from the body of the circle (using the Pie Offset command 
from the Areas menu), and give it a contrasting color or 
pattern. 

Table 
Tables let you organize data without plotting actual graphs. 

YEAR 
90 91 92 93 

REVENUE 2000 2500 3100 3600 

COSTS 1300 1575 1905 2180 

PROFITS 700 925 1195 1420 

A table is a systematic presentation of data, whether text, numbers, 
or symbols. 
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In MacGraphX, a table in a special type of chart in which the data 
values are always hidden, and annotations only are used. 
Annotations are placed within boxes defined by the minor grid 
lines. To position text within the table, select the fields and use the 
Annotation Place command from the Text menu; to color the text 
or background, select the fields and use the color options from the 
palette. 

Because it's just as important to read across a table as it is up and 
down its columns, try to keep columns of information close 
together, so that the eye can move from side to side as easily as top 
to bottom. In a table with lengthy headings that require wide 
column spacing, use grid lines to create "tracks" between field 
values. Generous horizontal spacing between lines of type also 
makes sideways motion of the eye easier. 

Suggestions 
• Numeric data in tables is usually right-aligned. 

• Keep column headings brief to make it easier to keep the data 
columns close together. Use abbreviations, condensed type, 
or rotated text as necessary. 

• To give a table a strong rectangular shape, set a bold rule 
across the top and bottom edges, using the baseline and axes 
of the graph. You can also show the table inside a frame, or 
put a fill behind it. 

Other Guidelines 
This section of the chapter will give you guidelines pertaining to 
graphs in general. 
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Grid Lines 
Grid lines make interpreting field values easier and keep the eye 
moving across the graph. Too many grid lines can make the graph 
difficult to read, however. If you don't use grid lines with discretion, 
your graphs could look like this: 
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One can also possible to use too few grid lines, which makes your 
values ambiguous. Line charts are especially reliant on grid lines to 
mark their values. This line chart is hard to read: 

The right grid structures the data clearly. 

I I I I 
V 

/I 
/ I 

I ~v 
I / I 
V 

/ 
----~ 

i..---

Making Graphs with Impact 148 

~ l-- ~,, • 

1· ' , i 
' • ·! 
~._,,__. "-..c 
I . . ~ 

I ,? . 
I~~ 
1!.-,...a! ___ 

', f . l 
- - :·j 

I(~ 



Fills and Colors 
When you're using fills and colors to distinguish different data 
elements such as bars, slices of pies, or areas in an area chart, 
remember this cardinal rule: contrast is essential. This area chart 
does from too little contrast: 

This graph. designed with more contrast, is far easier to read: 

When you're shading different bars. don't limit yourself to only 
diagonals. The result might be more Pop Art than one might wish: 
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Use a bold color or pattern to make one field value stand out over 
others in a graph - highlight whichever field is the most important. 

- -- -,... 

- -,... 

--
Scale 
Scale is the distance between measures (major grids or ticks) along 
an axis. Scale is set in the A.xis Info dialog box, which is accessed by 

double-clicking on an axis line, tick, grid or label. or by choosing 
A.xis Info from the Options submenu from the Graph menu. 

The scale that you set for the vertical and horizontal axes influences 
what the vie\ver concludes from your data. On the horizontal axis. if 
the distance between measures is long. the rise or fall of a line 

appears gradual. If measures are close tog ther. up or down 
movement appears more precipitous. On the vcnical axis. the 
opposite is true: a wider interval between grid lines \Yill make a rise 
or fall look dramatic, a shorter interval will make it look 

incremental. 

You can manipulate the scale to clarify or distort your data. 
(Needless to say, we heartily and fully endorse the former, and 
strongly discourage the latter - though we present all the tools 
necessary to do either.) For example, you could enlarge a graph's 
scale to emphasize a change that is numerically small, but that 

represents a large relati\ e increase or decrease. 

Consider the following: unemployment doubling from 2.5 to 5 
percent in one year is a small numerical difference - a change of 

only 2.5 percent - but it represents twice as many people out of 
work. To emphasize this large relative change, use a large distance 
between measures along the vertical (y) axis, and a short distance 
between measures along the horizontal (x) axis, so that a line drawn 
from 2.5 to 5 rises dramatically. If you use a small vertical scale to 

represent this change, the graph will be technically accurate, but 

won't make its point as clearly. 
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The following two graphs show the same data, but, due to different 
scales along the dependent axis, give very different impressions. 

10 

a 

6 

4 

2 

0 

10 

9 

a 

By changing the baseline from O to 8, the scale for the y axis 
becomes dramatically larger; what appears to be a gradual fall and 
rise in the first graph becomes a steep drop and fast rise in the 
second 

Changes in scale should only be used to clarify data. Most often, the 
automatic scale set by MacGraphX is preferred. 

Text 
Keep labels clearly legible. 
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There is no ideal solution to the problem of labeling the vertical 
axis of a graph or a vertical bar. Avoid running a title up the side of 
the axis or bar, since it will be hard to read. Flush left or flush right 
works, unaesthetic as it may be. You might consider an annotation 
centered above the bar or axis. 

The horizontal axis or bar is easy to label: Use a single horizontal 
line of type, or put the label, whether field name or quantity, within 
the bar itself. 

Small ThinAS I 

Tiny ThinAs I 

fv\edium Thinqs I 

Biq Thinqs I 

GorAontuon ThinAs I 

Call-outs are appropriate for many graphs. Call-outs are labels 
appearing outside a field value, and often connected to the field 
value by a thin line. Use type of a readable point size. You can use 
MacGraphX's annotation command to create call-outs, or simply 
enter call-outs as text. 

Big Things 

Tiny Things Gorgoluon Things 

Nedium Things 

Small Things 

Low~ncy 

Be consistent in labeling parts of a graph. If you place the field 
names or amounts within some of the bars in a bar graph, put them 
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in all of them. If one bar is too small to contain the information, 

choose another way that will work for all the bars. 

One Rule: Keep It Simple 
MacGraphX provides you with many sophisticated tools to enhance 

your chart. Use them sparingly. 

Further reading: 
Holmes, Nigel, Designer's Guide to Creating Charts & Diagrams, 

New York: Watson-Guptill Publications, 1984. 

Tufte, Edward R., 1be Visual Display of Quantitative Information, 

Cheshire, CT: Graphics Press, 1987. 

White,Jan V., Using Charts and Graphs, New York: R.R. Bowker 

Company, 1984. 
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Chapter 13: Menu Commands and Dialogs 

File 

This chapter lists and explains all the commands and dialogs accessed 
from MacGraphX's menus. Menus are listed as the appear in 
left-to-right order. 

New - Starts a new empty MacGraphX file. If a document is already 
open, New is disabled. 

Open - Opens an existing MacGraphX file. The Open command is 
active when you have a blank document open or no 
document open at all. 

Close - Closes the document you are currently working on, and asks 
you to save the document, if necessary. 

Save - Saves to disk any changes you have made to a file since 
creating or last saving it. You should save regularly and 
frequently in order to avoid losing work in the event of a 
power outage or system crash. 

Save As - Saves another copy of your file with a new name or in a 
different folder. 

Save Stationery - Saves the current document as a stationery file -
a set of file parameters without data or graphs. All fields, field 
settings, formulas, custom numeric formats, curve fits, and 
graph templates are preserved. A stationery file opens as an 
untitled document. 

Revert To Saved- Undoes all the work you have done since you 
last saved a file to disk. 

Page Setup - Sets the printer parameters for your document. The 
choices you have in Page Setup depend on the printer driver 
you have selected from the Chooser desk accessory. 

Print - Prints the contents of the active window. 

Save PICT - Saves a graph as a PICT graphics file for use in other 
applications. Most Macintosh graphics applications can open a 
PICT file. 
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Import Data - Brings data created in another application into 
MacGraphX. You do not need a MacGraphX document open 
to import data. If necessary, a document will be created when 
you give the Import command. Data may be entered in 
addition to data already existing in a dataset, either as new 
fields or as new records. 

MacGraphX can read data files created on many programs 
such as MacCalc, Excel, or your favorite database or 
accounting program. Choose the data file format from the 
Import Data sub-menu. Only files with formats identical to the 
format you select will appear in the file list. Select All if you 
wish to import any file type. 

After selecting a file, you can make choices in the Load dialog 
about the file you are importing. 

Load Data H22Macuser Growth 6/90.C0BH2 

II OK ll 
@ Row Is Record 
O Column Is Record 

[ Cancel ] 

181 Field Name In I st Record 181 Use 

O Records to Skip E:==:J 
O Records to Lood ~ 

181 Add New Fields 181 Use Formulas 

O Add New Records 

New Field Notes 

Your dialog choices are: 

"Full Data" Default setting that loads all of the data 
from the file to be imported. 

continued next page ... 
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"Range" Specifies a range of data to import if not 
importing all of it, using standard 
spreadsheet range reference nomenclature. 
Enter the address of the beginning and 
ending cells, separated by a colon. 

Entering Al:GlO, for example, would 
import all data from the first column (A) to 
the seventh (G), from the first row (1) to 
the tenth (10). 

® Range I RI :GID 
I 

"Row is Record" Default setting that specifies that a 
horizontal row is one record. 

"Column is Record" Specifies that a vertical column is one 
record (common in financial data). 

"Field Name in 1st Specifies that the names of each field make 
Record" up the first record, and valid data starts in 

the second record. 

"Use" Retains the field names contained in the 
imported file when "Field Name in 1st 
Record" is also selected. If "Field Name" is 
not selected, enters "Field#l" automatically 
as the new field name for the first field, 
"Field#2" for the second field name, and so 
forth. 

"Records to Skip" Specifies the number of records to skip 
from the first data record (ignoring record 
with field names). 

"Records to Load" Specifies the number of records to load. 

"Add New Fields" Specifies adding imported data as new 
fields in an existing dataset after the current 
fields. 

"Add New Records" Specifies adding imported data as new 
records after existing records. 

"Use Formulas" Retains any formulas in the imported text 
orWKS file. 
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Export Data - Allows you to save your data in formats readable by 
other applications. You can make the following choices in the 
dialog: 

"Text" Exports a tab-delimited text file. 

"WKS" Exports a file in WKS format. 

"SYLK" Exports a file in SYLK format. 

''Selected Records Only'' Exports only selected records in a 
file. Select records in the data 
window prior to giving the Export 
command. 

"Include Field Names" Exports existing field names along 
with data. 

"Include Equations" Exports all field formulas into a WKS 
or text file. 

Communicate -Allows you to open or send a MacGraphX file, 
template, or PICT image over a network using Microsoft Mail. 
You must have Microsoft Mail software installed on your 
system and the other systems using the network. 

Your MSMail Open options are: 

MGX File Opens a MacGraphX file that has been sent to 
you over the network. (Same as Open 
command.) 

MGX Stationery Opens a MacGraphX template that has been 
sent to you over the network. A template 
contains all the settings but none of the data in 
a MacGraphX document. 

MGX Import Imports data that has been sent to you over the 
network. (Same as Import Data.) 
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Your MSMail Send options are: 

MacGraphX File Sends a MacGraphX file to someone on the 
network with Microsoft Mail. (Same as Save As 
command.) 

PICT File Sends a PICT image of the active graph, 
letterhead, or layout window to someone on 
the network with Microsoft Mail. (Same as Save 
PICT command.) 

Data Export Exports data only to someone on the network 
with Microsoft Mail. (Same as Export Data 
command.) 

Preferences - Allows you to set preferences for the current file or 
all new files. Your options are: 

"This File" Default setting that applies preferences to 
the current file only. 

"All New Files" Optional setting that applies preferences to 
all new files including the current one. 

"Field" Displays an alert box warning you that the 
delete or modify operation you are 
performing on a field cannot be undone. 

"Template" Displays an alert box warning you that the 
delete or modify operation you are 
performing on a template cannot be 
undone. 

"Color" Displays an alert box warning you that 
creating, deleting, or modifying a color 
cannot be undone. 

"Curve Fit" Displays an alert box warning you that the 
operation you are performing on a curve fit 
cannot be undone, deleted, or modified. 

"Delete Graph/Layer" Displays an alert box warning you that 
deleting a graph or graph layer cannot be 
undone. 

"Num Format" Displays an alert box warning you that 
deleting a numeric format cannot be 
undone. 

continued next page ... 
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"Suppress Error Prevents error messages from appearing on 
Messages" screen, hut beeps instead. 

"Min Tick Spacing" Sets minimum tick spacing in points for 

"Log" axis labels for regular and log axes. 

"Default Dependent Specifies a name for the dependent axis 
Line" title. The default is "Data". 

Quit - Closes the file and application. A dialog box asks you 
whether you want to save your changes. 

The Undo, Cut, Copy, Paste, and Clear commands work for both data 
and graph windows. The other commands in the Edit menu 
only work on the data window. 

Undo - Undoes the last editing or formatting command given from a 
menu in the data window or from the Palette or menu in a 
graph window. 

Cut- Deletes the selected object and copies it to the Clipboard. 
When cutting records, MacGraphX collapses the dataset and 
renumbers the remaining records accordingly. If the objects to 
be cut are elements of a chart, such as a piece of a pie chart, 
those elements are hidden but not removed. To make the 
object reappear, select the cleared object and choose the 
Show command under the Objects menu. 

In the graph window, this hides selected objects on a graph, 
and deletes selected user-drawn graphics. To make a graph 
object reappear, select the cut object and choose the Show 
command under the Objects menu. 

Copy - Copies the selection to the Clipboard. 

Paste - Pastes a graph object, cell or range of ceUs, or record or 
range of records into a graph or data window. When pasting 
records into a dataset, records will be added to the end of the 
dataset. Cut or copied cells replace an analogous range of 
cells with respect to an entry cell, or, if no entry cell is 
selected, are added in new records at the end of the dataset. 
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Clear - In the data window, this turns cells with numeric values to 
zero, and cells with an alphabetic text type blank. Clear a 
record or range of records by selecting the desired record 
numbers and giving the Clear command. Clear a single cell or 
range of cells by highlighting them and giving the Clear 
command. 

In the graph window, this hides selected objects on a graph, 
and deletes selected user-drawn graphics. To make a graph 
object reappear, select the cleared object and choose the 
Show command under the Objects menu. 

Duplicate - Duplicates records or enters blank records at the end of 
a dataset. When duplicating selected record· you can specify 
how many times you want them duplicated. You can also 
change the value of one cell by a percentage, an absolute 
value, or according to a formula. Also pastes a record or 
records in from the Clipboard. 

When you use the Duplicate command, a Duplicate dialog 
appears with the following choices: 

"Duplicate from Duplicates selected records once. 
Selected Records" 

"Duplicate One Record Duplicates the first record the specified 
N Times" number of times. 

"Insert Empty Record N Inserts a specified number of blank 
Times" records. 

"Fill Field" Specifies a field that will change in each 
duplicated record. You can change the 
field by a percentage, an absolute value, 
or according to a formula. This feature 
can be used with "Duplicate from 
Selected Records," ''Duplicate One 
Record N Times," and "Insert Empty 
Record N times." First check the"Fill 
Field" option, then select the field name 
from the Fields menu, or type the name 
of the field. 

If you selected "Fill Field," MacGraphX shows another dialog 
box. This lets you indicate how to change the field. 
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Insert - Adds one blank record for each selected record, at the end 
of the dataset. 

Delete - Deletes selected records. Delete does not change the 
Clipboard, so you cannot paste records or cells back into the 
dataset. You must use Undo immediately after using Delete to 
return deleted records or cells to the dataset. 

Fill Recs - Causes a field in many records to change. You can 
specify that the change be by a percentage, absolute value, or 
according to a formula. The dialog is the same as the "Fill 
Field" dialog of the Duplicate command. The difference 
between these two commands is the Fill Recs command 
changes fields in existing records. The "Fill Field" dialog 
contains: 

"Fill Field" Specifies the field that will be filled with data. 

"Constant Lets you specify a constant value for all 
Number or duplicated records. 
String" 

"Grow" Allows you to change the field value by a fixed 
percentage or number. Set the starting value of 
the series in the ''Start from" box and the 
increment in the "Step by" box (this value can be 
positive or negative). You must also specify 
whether you want to step ''by Percent" or '·by 
Amount." 

"Formula" Allows you to define an equation. You will find 
field names, constants, operators, and functions 
on separate menus. See the Building Fonnulas 
chapter earlier in this manual for more 
information on how to create a formula. 

Summarize - Determines the total, average, and maximum values, 
or standard deviation for all fields in selected records. Select a 
set of records, and give a command from the Summarize 
submenu. The result is entered as one new record at the end 
of the dataset. The new record will have a "T", ·'V", "M", or 
"I" next to the record number to indicate whether this result 
is a total, average, maximum value, or a standard deviation. 
Add-in statistics from the MG.XSTisf folder (such as 
geometric mean or sum of the squares) appear at the end of 
the submenu. 
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Data - Submenu with the following commands: 

• Fields 

• Sort 

• Search 

• Move to Top 

Fields - Allows you to name or rename fields, define formulas, and 
set text types in the Define Fields dialog. 

Define Fields I; 

I Delete ) 
11 Rdd ll @Number □ No St11t 

( Ren11me) QTeHt 0 No Gr11ph 
( C11ncel ) 

~ I Modify ) 
Notes 

= 

Formul11: D Const11nt D N/R Is err 

The Define Fields dialog choices are: 

"New Name" Name for new fields added to the dataset. 
Also permits you to change the name of 
an existing field. 

"Number" Defines a field as one that holds 
quantitative information (including dates) 
only. Alphabetic data may not be 
entered. Only number fields may be used 
in formulas and transforms. 

"Text" Defines a field as one that holds 
alphabetic information, and treats any 
numbers as alphabetic rather than 
numeric data. Data in a text field may not 
be used in formulas and transforms. 

continued next page ... 
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"No Stat" Disallows use of a selected number field 
for statistical purposes. Field cannot be 
totaled, averaged, etc. 

"No Graph" Disallows use of a selected field for 
graphing purposes. 

"Constant" Temporarily suppresses the recalculation 
of a formula for a selected number field. 

"NIA is err" Returns "N/ A ERR" as the value of a 
calculated field when the value of an 
input is not available (N/ A). If not 
selected, will process any null value as 
zero and place a number in the output 
field. 

"Delete" Deletes an existing field entirely after you 
select it in the scroll box. 

"Rename" Changes the name of a selected field to 
what you type in the "New Name" field. 

"Modify" Executes any new settings you have 
made in the Fields dialog. 

"Formula" See the Building Formulas chapter for 
information on how to create a formula. 

"Notes" A box in which to type in notes about a 
field. 

Sort - Allows you to sort a dataset by up to three fields in the Define 
Sort dialog. 

Define sort == -

I 
D Dest 

1----------1. D Dest 
□ Dest 

II DK )I 
[ Cnntel ) 

In the Define Sort dialog, specify the data fields to sort by, 
and their order, by entering their names in the sort fields. You 
may type in the names or select them from the Fields menu. 
Specify a descending sort by selecting the "Desc" check box 
for any field. 
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Search - Allows you to search records in a dataset by specified 
criteria. Found records are highlighted in the Recs# column. 
In the Define Search dialog, specify the field to search by 
typing the field name into the first field or by selecting it from 
the Fields menu. Enter the value or text string to search for 
(the "key value") in the second field. (The Define Search 
dialog will automatically display the name of the field 
containing the entry cell and the entry cell's contents.) Click 
on the appropriate radio buttons to define the search. Found 
records will appear with their record numbers highlighted. 
You have these choices: 

u=n Default that searches for the specified 
value or text (equals the key value). 

Searches for values 

"<" less than 
u~n less than or equal to 

">" greater than 

"~" greater than or equal to 

the key value. 

"Prefix" Searches for the specified text at the 
beginning of a text string. 

"Embedded" Searches for the specified text anywhere 
in a text string. 

"Not" Finds records with values or text that do 
not match the specified search criteria. 

Move to Top - Moves selected records to the top of the dataset. 

Recalc - Gives you several options for recalculating the formulas 
and transforms in a dataset. Your choices are: 

Manual Recalc Prevents the automatic 
recalculation of formulas and 
transforms in a dataset. 

Recalc Now Recalculates formulas in a dataset 
when Manual Recalc is set. 

Field No Recalc Prevents the recalculation of 
formulas for selected fields. 
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Graph 

Fields defined by formulas are recalculated in "natural order," 
based upon the inherent dependencies; as necessary, fields 
that are inputs to formulas are calculated before the 
dependent formulas are calculated. All fields defined by 
transforms are calculated afteiwards, in field order. 

The graph menu is enabled when a graph, letterhead, layout, or 
clipboard window is open on th~ screen. 

New Graph - Generates a chart or graph from data you have 
selected in a data w·indow. You can choose from several 
types of charts or a blank chart. The submenu choices are: 

Scatter Chart with data represented as single points 
called marks. Each dependent field is 
represented by a different mark. 

Line Similar to a scatter chart except that the data 
marks in a field are connected by lines. 

Area Similar to a line chart except that the areas 
between the lines are filled in. 

Bar Chart with data represented as rectangles called 
bars. Each dependent field is represented by a 
different vertical or horizontal bars, grouped by 
record. Use Transpose for horizontal. 

Stacked Bar Similar to Bar chart except that bars within one 
record are stacked. 

Pie Chart with data represented as pieces of a circle 
called wedges or slices. Creates a pie for each 
record selected. There are no measurements 
along the dependent axis with pie charts. 

Table An organized arrangement of data (field 
values), represented as text. 

Blank [Drawl Gives you a blank graph window; used 
MacGraphX's draw capabilities. 
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Scatter 

Line 

Area 

Bar 

The following graphs will give you an idea of what each 
graph type looks like. 

continued next page .. . 
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Stacked Bar 

Pie 

Table YEAR 
90 91 92 93 

REVENUE 2000 2500 3100 3600 

COSTS 1300 1575 1905 2180 

PROFITS 700 925 1195 1420 

Options - Lets you specify the structure and formatting for 
windows, graphs, axes, legends, and fields. The submenu 
items are: 

• Window 

• Graph 

• Independent Axis 

• Dependent Axis 

• Legend 

• Fields 
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Window allows you to change the active graph window or 
layout or letterhead window in several ways with the Window 
Info dialog. 

TIiie: I 
OK u 

D Use full Rren Poges Across [I) 
ll 

[ Concel ) D Hide Scroll Bnrs Poges Down [I) 
D No Letterhe11d 
D Show In L11yout D Lock 

Your options are: 

"Title'' Allows you to name a window. 

"Use Full Area'" Enlarges the placement frame to 
surround the page or pages of the whole 
layout. Applies only to the graph 
window. 

"Hide Scroll Bars" Hides scroll bars and extends the 
window. 

"No Letterhead" Prevents the contents of the letterhead 
window from appearing in the graph or 
layout window. 

"Lock" Prevents changes from being made to a 
window. Applies only to a graph 
window. 

"Pages Across" Specifies the number of horizontal pages 
for a layout in the graph and layout 
windows. 

"Pages Down" Specifies the number of vertical pages for 
a layout in the graph and layout 
windows. 

"Show in Layout" Shows the contents of the graph window 
in detail rather than in outline form in the 
layout window. Must be specified in the 
graph window. 
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Graph allows you to change the active graph in many ways 
with the Graph Info dialog. 

6raph Info 

6raph Type ._I _e_ar __ __, 

D Numbers as Labels D N/A's -> 0 
D staggered (Zones) D Negs -> o [ Cancel I 
D Running Totals D Separate negs 
D Percentages D Change ~so_rt-=---. 

Sort Type I No Change I 

Your options are: 

"Graph Type" Changes the graph type to any of the 
other options listed in the New Graph 
command. 

"Sort Type" Allows you to select from "Natural," 
"Record#," "Sort List," and "Sort Order." 
Click in "Change Sort" check box first. 
"List Order" presents data as currently 
sorted in the dataset. "Natural" sorts the 
field for the independent axis in 
ascending alphabetic or numeric order. 
"Rec #" sorts by ascending record 
number. "List Sort" uses the order of the 
last direct sort chosen. 

"Numbers as Labels" Guarantees even spacing between field 
values regardless of their numeric value. 
This setting is a default for bar and 
stacked bar charts. Deselecting this 
option with numeric axis values may 
cause data (bars) to be spaced unevenly. 

"Staggered (Zones)" Moves the first major interval of the 
independent axis away from the 
dependent axis, creating a margin within 
the data frame. Doing this keeps bars and 
pies from overlapping the dependent 
axis. Bar and pie charts default to this 
setting. 

continued next page ... 
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"Running Total" Shows all objects in a field of your data 
as the accumulated total for each record. 
This feature is the default with a stacked 
bar graph and pie chart. 

"Percentages" Shows each value as a percentage of the 
total. Using percentages with Running 
Totals will show you the accumulated 
totals of those percentages. 

"Negs-> O" Treats any negative value to O on the 
graph. 

"Separate Negs" Default setting for bar, stacked bar, and 
area graphs, accumulating negative and 
positive values separately. Deselecting 
''Separate Negs" causes negative values to 
be added in with positive numbers on 
the graph, lessening the totals. 

"N/A's -> O" Treats any null value in the dataset as 0 
for graphing. 

Independent Axis and Dependent Axis let you change their 
respective axes with a dialog when numerical data is 
displayed. 

Dependent RHIS 

Limits □ Log 
® Rutomotlc lnleruols I( OK JI O Unrounded ® Rulomotlc 
QMO[IUOI QMonu111 

Min I !soo I ( C11ncel l 
MIIH 2500 Minors I None I 

Bose 0 Lobels ~ 

O Include Bose O Align M11Jors To Bose 
O Ettocl Frome Size O Minors DK on End 
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Your options are: 

Limits: "Automatic" Default setting that sets the limits of the 
axis from the lowest value to the highest 
value of the data intelligently rounded 
down and up, respectively. 

Limits: "Unrounded" Sets the limits of the axis at the highest 
and lowest values of the data plotted on 
the axis. Deselect "Include Base" to start 
the axis with the lowest plotted value if 
the lowest value is positive. 

Limits:"Manual" Sets the limits of the axis to any desired 
values. Type the desired beginning and 
ending numbers in the "Min" and "Max" 
fields. 

"Include Base" Default setting that includes a baseline in 
the graph even if it falls outside the range 
of values. If you would like a value other 
than O for the baseline, type the number 
in the "Base" field. 

"Exact Frame Size" Forces the axis size to equal the data 
frame size when grown by the user 
instead of rounding so that intervals are 
of equal size. 

"Log" Sets a logarithmic scale for the axis. 

Intervals: "Automatic" Default setting that automatically 
determines the intervals along an axis. 

Intervals: "Manual" Changes the major interval between 
numbers. Type the desired interval value 
in th~ spacing field. 

"Minors" Pop-up menu that lets you change the 
number of subdivisions bet\veen each 
interval (this can be ''None"). 

"Labels" Pop-up menu that lets you specify which 
major ticks along the axis are labeled. 
Selecting 1 labels every major tick; 
selecting 2, every second tick, and so on. 

·1 

continued next page ... 
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"Align Majors To Base" Default setting that starts the spacing of 
major grid with the baseline; otherwise, 
adjusts major grid to align with minimum 
value. 

"Minors OK on End" Allows minor ticks to occur at the end of 
the axis. 

Note: When alphabetic information is displayed along an axis, 

or "Nums as Labels" is set in the Graph Info dialog, the Graph 

Info dialog appears rather than the respective axis dialog 

when you double-click on the axis or axis labels. 

Legend controls parameters for the legend with settings in the 

Legend Info dialog. 

----- -- Legend Info 

Layout 
O Row Major @ Column Major 

# Majors [II 
18] Show Hidden Fields 

M11rglns 
Lefl ~Qlnch ocm 
Top/Bot 4 @ Points 

[ C11ncel 

HI-Lo----------------~ I 
0 Show HI-Lo 

. 0 Absolute 
HI ..... , c-o-st-s------,,. B® Percentage 

Lo Reuenue - 0 O Sid Oeu·ns 

Your options~ are: 

"Row Major/ Determines whether the legend objects are 

Column Major" displayed in rows or columns. 

"# Majors" Specifies a fixed number of columns or rows 
in which to display legend information. For 
example, if you choose "Column Major" and 
2 for"# Majors," the legend objects will be 
displayed in two columns of as many rows as 
needed. 

"Show Hi-Lo" Displays a hi-lo line in the legend. 

continued next page ... 
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"Show Hidden Shows legend information for fields that are 
Fields" hidden on the graph. 

"Left Margin" Specifies the left margin in the legend box in 
inches, centimeters, or points. Even at a 
setting of 0, however, legend objects do not 
touch the side of the box. 

"Top/Bot Margin" Specifies the top margin in the legend box in 
inches, centimeters, or points. Even at a 
setting of 0, however, the first object does not 
touch the top of the box. 

"Hi" Specifies the field of the graph that will be 
used as the basis for the upper part of a Hi-lo 
Line/Error Bar. Hi value is calculated as a 
percentage, addition, or field standard 
deviation multiple of a constant with the 
specified field. 

"Lo'1 Specifies the field of the graph that wiU be 
used as the basis for the lower part of a Hi-lo 
Line/Error Bar. Lo value is calculated as a 
percentage, addition, or field standard 
deviation multiple of a constant with the 
specified field. 

Field Names - Field names listed at the end of the Options 
submenu open a Field Info dialog for the chosen field. 

Field Info 

Field: Costs 
3 D11111 Points 
Meon: 131 B.33 
Std Deu'n: 68.5971 

Note/Msg: O Curue Flt 
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The Field Info dialog provides the following information: 

"field:., Indicates the field name. 

"Data Points 
.. 

Indicates the number of values 
that define the field. 

"Mean:'' Indicates the mean value 
(average) of the field's data 
points. 

"Std Dev n:·· Indicates the standard deviation 
of the field's data points. 

"Note/fvlsg:'' Contain • user notes about the 
fi ··lei. Type in any notes or 
comments. 

"Curve Fit'' Indicates that a curve fir has 
been applied to the field (scatter 
chart only). Curve fit data will be 
displayed in the .. ote/Msg:'' 
dialog. 

Delete Graph - Deletes the active graph windmv but not an active 
byout or letterhead window. 

Transpose - Exchanges the x (horizontal) for they (vertical) axis. 

Place Graph - Places a graph in the top left corner of the first page 
of the layout window. Graphs are listed on the Place Graph 
suhmenu. • 

Template - Saves the graph in the active window as a template for 
later use. 

~seq Templntes ~ 

New Nnme 

I I 

[J 
From Groph ti I 

II Rdd li 
[ Cancel 

[ Delete 

[Rename) 

[ P.e~et ) 
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The Templates dialog choices are the following: 

"Delete" Deletes an existing template selected in the 
scroll window. 

"Rename·· Renames an existing template selected in the 
scroll window. First select the template to 
rename and type in its new name in the 
New Name field. 

"Reset" Uses information in the active graph to 
replace information the selected template. 

Layers 
Commands from this part menu affect the layers of a graph. 

Swap Graph Layers - Exchanges two graphs by moving the graph 
that is in front to the back. 

Remove Layer - Removes the front-most graph layer. 

Graphs in Front - Moves user-drawn graphic objects such as lines, 
boxes, and text behind the graph. 

Graphs to Back- Moves user-drawn graphic objects such as lines, 
boxes, and text on top of the graph 

Data Front - A default setting that puts field elements such as 
marks, lines, and bars in front of all grid lines. Deselecting it 
puts grid lines of forward graph in front of field elements of 
back graph.' 

Align Horiz - A default setting that ensures that overlaid graphs 
have the same width and horizontal position. Deselecting it 
allows you to move overlaid graphs separately from side to 
side. 

Align Vert- A default setting that ensures that overlaid graphs have 
the same length and vertical position. Deselecting it allows 
you to move overlaid graphs separately up and down. 

Note that deselecting Align Horiz and Align Vert 
simultaneously will allow you complete freedom in moving 
overlaid graphs separ.itdy. 
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Objects 
Show - Makes a selected hidden graph object visible. 

Hide - Hides a selected graph object. 

Reset Attributes - Returns the attributes of a selected graph object 
to their default settings. Will work with a user-drawn object. 

Reset Location - Returns a selected label or title to its default 
location. Will not work with a user-drawn object or the 
legend. 

Reset Graph Order - Returns overlaid graphs to their original 
front-to-back order. 

Anchor to Frame - Freezes a selected object in its current position 
relative to the graph frame. The graph cannot be moved or 
resized without moving the anchored object, but the anchored 
object can still be moved independently of the graph frame. 

Grow to Frame - Enlarges a selected grid line, baseline, axis or field 
item (including drop shadows for bars) to extend past the 
data frame, to the graph frame; useful only if margin separates 
the data and graph frames. To allow all fields to grow to 
frame both horizontally and vertically, select the legend and 
issue this command. 

Align- Gives you several choices for aligning two or more selected 
objects. They are: • 

To Grid Aligns selected objects to invisible grid defined in 
the palette. You must have Grid selected. (See the 
chapter, About the Palette.) 

Top Aligns selected objects to the top of the top-most 
object. If a frame (data frame, graph frame, or 
placement frame) is one of the objects, aligns 
objects to the top of the frame. 

Middle Aligns the middle of each selected object to a point 
halfway bet\veen the top point of the top-most 
object and the bottom point of the bottom-most 
object. 

continued next page ... 
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Bottom Aligns selected objects to the bottom of the 
bottom-most object. If a frame (data frame, graph 
frame, or placement frame) is one of the objects, 
aligns objects to the bottom of the frame. 

Left Aligns selected objects to the left of the left-most 
object. If a frame (data frame, graph frame, or 
placement frame) is one of the objects, aligns 
objects to the left side of the frame. 

Center Aligns the center of each selected object to a point 
halfway between the right point of the right-most 
object and the left point of the left-most object. 

Right Aligns selected objects to the right of the right-most 
object. If a frame (data frame, graph frame, or 
placement frame) is one of the objects, aligns 
objects to the right side of the frame. 

Bring to Front - Brings selected objects to the front of the window. 

Send to Back - Sends selected objects to the back of the window. 

Select All- Selects all graph objects or all graph objects of a chosen 
type. Your choices are: 

All Selects all graph objects. 

Text Selects all text. 

Lines Selects all lines. 

Rects Selects all rectangles. 

Grids Selects all grid lines. 

Ticks Selects all ticks. 

Titles Selects all titles. 

Labels Selects all labels. 

Full Graph - Selects one of the following graph objects: 

• Placement Frame • Graph Frame • Legend 

• Title • Data Frame • Hi Mark/Lo Mark 
Note that showing the high mark or low mark will display the 
entire Hi-Lo line. 
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Text 

Fields - Selects one of the field elements in a graph. 

Independent Axis/Dependent Axis - Selects one of the following 
axis objects: 

• Title • Near Axis • Far Axis 

• Major Grid • Near Labels • Far Labels 

• Minor Grid • Near Major Ticks • Far Major Ticks 

• Baseline • Near Minor Ticks • Far Minor ticks 

The near axis is the axis corresponding to the "near" side of 
the graph, that is, the bottom or left side. The far axis is on 
the "far" side of the graph, that is, the top or right side. 

The Font, Size, Style, Alignment, and Rotation commands let you 
change the way that text appears in the data window and in your 
chart. Selecting any of the choices in these commands changes the 
setting for all new text you type. You can also specify the format of 
numbers. In the data window, these choices affect the columns you 
have specified as the dependent columns (the columns with their 
names highlighted). 

Font - Specifies the font for the selected text. 

Size - Specifies the size for the selected text. The sizes that appear as 
outlines are font sizes resident in your system. Other font 
sizes may be selected with the Other command on the 
submenu. You may define custom sizes in points, centimeters, 
and inches by typing them in the blackened field. 

Style - Specifies the font style for the selected text. The styles 
available are plain, bold, underline, italic, outline, and 
shadow. You can have more than one style on your text, such 
as bold italic. 

Alignment - Specifies the alignment for the selected text: left, 
centered, or right. The text is aligned to the edge of the cell 
(if you are in the data window), or the border of the text box 
in a graph. 
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Rotation - Allows you to rotate text to the left or right, flip it upside 
clown, or return it to a normal orientation. Left corresponds to 
counter-clockwise, right to clockwise. You cannot rotate text 
in the data window. 

Num Format - Specifies, changes, and creates numeric formats for 
fields in the data or graph window. Select preset formats from 
the submenu or change and create formats in the Define 
Number Format dialog. 

Define Number Format 
Format Name Olnegl 0% ON/R"s it Add ll I Dint □ M·s OD00's 

Dees U] Lead DJ 
FiHed0 Q ( Cancel ) 
FIHedl ® FIHed D Space 
FIHed2 Q Currency [DO After ( Delete ) 
FIHed5 0 General 
FIHed4 O Scientific 0 E•00D (Rename) 
Scl2 
Scl4 

QDate ( Modify ) 
Curo 0mm dd yy Ommyy 

Cur2 
® dd mm yy Qddmm 

PerCento 

l

oo, 1 
D Year. 19yy 

PerCent2 lri 
®' 0 Day: 01 

51415.95 
QJan 18] SeparntorLJ 

You have these choices in the Define Number Format dialog: 

"Format Name" Specifies the name for a new or renamed 
numeric format. 

"(neg)" Places a negative value in parentheses. 

"Int" Rounds all values to no decimal places. 
overriding the "Decimals" sening. 

uo/o" Multiplies value by 100 and appends"%"' sign. 

"M's" Specifies each thousand multiple with "M" 
rather than a group of three zeroes. 

"N/A's" Shows blank cells as ''N/ A.·· 

"000's'· Separates groups of three zeros by thousands 
separator (commas). 

"Dees·• Specifies the number of decimal places for 
display. 

co11tin11ed 11ext page ... 
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''Lead'' Specifies the number of digits that must appear I • : ~l 
,...___, I 

before a decimal point. When used with 
Currency format, places a minimum number of 
spaces berween the decimal point and the 
dollar sign. 

·'Fixed" Rounds off a number to the number of 
decimals specified by the"# Decimals" pop-up 
menu. 

"Currency·· Specifies a format that places a currency symbol 
before or after a number. 

"Space" Puts one space berween the currency symbol 
and the number (before or after). 

"After" Specifies placing the currency sign after the 
value. Must be used with "Currency". 

"General" Minimizes the space a number takes up by 
stripping away trailing zeroes after the decimal 
point. Puts a number in scientific format if it 
takes up too much space. 

"Scientific" Specifies a scientific format. 

"E+000" Specifies the representation of the exponent 
value with a letter and three digits rather than 
the usual two digits. Used with "Scientific.·· 

"Date" Specifies a elate field. Use with the date settings 
'·mm dd yy•·, "dd mm yy", ··mm yy", or '·cld 
mm". 

"mm c.ld yy" Options to specify the order of the day, month, 
"dd mm yy" and year in a date field. 
"mmyy·· 
·'ddmm" L. 

"Month: 01" Options to specify the formatting for a date 
"Month 1" field. Choose whether the month will appear as 
"Month: Jan" a word, or a number (with lead zero); whether 
"Year: 19yy" year will use century prefix; and whether day 
"Day: 01" number will have lead zero. 

"Separator" Specify the mark by which to separate the 
month, day and year. If not selected, date items 
will be separated by space (between first two 

~ 
~ l7 __ 

I ~ 

items) and comma (berween second and third): 
"1-Jan-90" vs. "1 Jan, 90." I ~ 

' continued next page ... 
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"Delete" Deletes a selected numeric format. 

"Rename'' Renames a selected numeric format. 

"Modify'' Applies changes made to the currently selected 
numeric format. 

In addition to creating your own formats, you have these 
preset choices in the submenu under Num Format: 

Same as Field For use in the graph window only: specifies the 
format that is already is set in the Data window 
for the field. 

General Minimizes the space a number takes up by 
stripping away trailing zeroes. Puts a number in 
scientific format if it takes up too much space. 

Fixed 0 Rounds off a value to the closest whole number. 

Fixed 1, Fixed2, Rounds off the value to the specified number of 
and so on decimal places. 

Sci2, Sci4 A scientific format with the value rounded to two 
or four decimal places. For instance, 1734 in Sci2 
is represented as "1.73 E+03." 

Currency 0, Shows dollar values rounded off to the nearest 
Currency 2 dollar or penny. 

Percent 0, Shows percentages rounded off to the nearest 
Percent 2 zero or two decimal places. 

The annotation commands are used only in the graph window. They 
allow you to add annotation text (such as field labels) to your field 
data and to specify the kind of annotation and its location. The 
annotation commands are also used to specify the position and value 
of text elements in tables. 

Annotate Type - Lets you add field annotation or select among 
different annotations for selected fields in your graph. To add 
annotation, select the field in the legend and the annotation 
type. The types are: 

None Removes any existing annotation. 

Value Shows the value. 

Percent of Tot Shows the percent of total. 

continued next page ... 
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Lines 

Running Tot Shows a running total. 

Running% Shows a running total of percentages. 

Field Name Shows the field name. 

Record# Shows the record number. 

Other Shows the value of any other field in 
the dataset. Select one. 

Annotate Place - Indicates placement for annotations relative to a 
selected category. The top row of icons apply to a pie chart. 
The rest apply to any other type of graph. The choices are: 

Ill Ll .&I ~ L) ' ... 
Rnnotnllon Gop .. :"t 

tJ Ll II cl c::f 
Num Formlll ► 

'[J I'.] C'.l □ a S1d()/Jet" ► 

Cl El [!l [3 D 
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J:] CJ 0 [J q, 

For example, the first choice in the third row puts the 
annotation text to the left near the top of the object. The 
center choice from the second row (highlighted in the 
diagram) is the default for all non-pie graphs, and centers the 
annotation above the data value. 

Annotation Gap - Allows you to select the gap between the 
annotation and the data point. 

Stagger - Staggers labels along the selected axis. You can specify: 

Auto Lets MacGraph.X stagger axis labels as necessary. 

None Puts staggered labels into a single row. 

2 Lines, 3 Lines Staggers labels into two or more lines. 
and so on 

Flipped Reverses the lines of staggered labels. 

Line commands are used to change the appearance of lines (such as 
grid lines, ticks, axes) and the borders of regions. When changing the 
line attribute for a one field in a bar, stacked bar, pie, or area graph, 
lines for all fields will be changed. 
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Line Width - Lets you select the width of a selected line in points. 
Selecting "?" allows you to select a custom width in points, 
centimeters, or inches. 

Tick Length - Allows you to set the length of the selected rick 
marks in points. Selecting "?" allows you to set a custom 
length in points, centimeters, or inches. 

Length Adjust - Adjusts the length of selected ticks and grid lines to 
the width of a perpendicular line (normally the data frame or 
graph frame). Selecting "?" allows you to set a custom length 
in points, centimeters, or inches. 

Tick Position - Allows you to set the position of selected tick 
marks, to be inside, outside, or across the perpendicular axis 
line. 

Complete Grid - Selects the top dependent or right-most 
independent grid line (and bottom dependent or left-most 
independent grid line if your graph contains negative values) 
even though they may overlap the data frame. First select the 
dependent or independent major grid to enable this 
command. 

Mark Type - Allows you to choose the mark type for the point on a 
scatter chart, line chart, or area chart, or the end points of a 
hi-lo line. The choices are: 

m • ■ 
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Curve Fit - Specifies the definition of the curve for selected fields in 
a scatter chart with the Define Curve fit dialog. 

-§l Define Curue Flt 

New Curue Flt 
I( Add ll 

[ C1rncel ] 

[ Delete 

Formula 

The Define Curve Fit dialog has these capabilities: 

"New Curve Fit" Names a new curve fit. 

"Formula" A field in which to define a formula for the 
curve fit. Use the Curve Fits menu to help. 

"Delete" Deletes a selected curve fit. 

"Add" Adds a new curve fit. 

Curve # Steps - Allows you to select the number of line segments a 
curve will consist of. Your choices are: 

Same Points As Graph Same number of points in the 
curve as data points on the 
graph. 

Use Major Count Same number of points in the 
curve as major ticks. 

Use Minor Count Same number of points in the 
curve as minor ticks. 

Use Size Same number of points in the 
curve as graph width (in pixels). 

10, 20, 25, 50 ... Specifies a number of points. 

CF Manual Recalc - Prevents the automatic recalculation of a curve 
fit based on new data. 

CF Recalc Now - Immediately recalculates a curve fit based on new 
data. This command is useful with CF Manual Recalc. 
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Areas 
Area commands are used to change the appearance of areas such as 
bars, wedges of a pie graph, or user-draw rectangles. The commands 
are: 

Round Corners - Lets you specify the roundness of the comers of a 
rectangle. Selecting"?" lets you set a custom comer size in 
points, inches, or centimeters. 

Shadow Vert - Lets you specify the vertical displacement of a drop 
shadow. Selecting"?" lets you set the vertical displacement in 
points, centimeters, or inches. 

Shadow Horiz - Lets you specify the horizontal displacement of a 
drop shadow. Selecting "?" lets you set the horizontal 
displacement in points, centimeters, or inches. 

3-D Shadow - Changes the shadow of a selected graph or 
user-drawn object to a three dimensional shadow. This fills in 
the area between the object and its shadow. 

Surround Shadow - Changes the shadow of a selected graph or 
user-drawn object to one that surrounds the object on all 
sides. 

Forward Shadow - Shifts an object so its shadow resides on the 
object's original position. 

Group Size and Pie Size - Selects the size of the entire field group 
as a percentage of the width of an interval along the 
independent axis. The standard size is 75% of this interval. 
Group/Pie Size applies to pie and bar graphs. Choosing "?" on 
the submenu allows you to set a custom width for the field 
group in points, centimeters, or inches, or as a percent value. 

In the dialog, a scale indicates with a black horizontal bar the 
total width of the field group in inches and centimeters 
relative to the width of the graph. Displayed beneath it is the 
width of a single major interval on the axis. 

The "Percent" option sets the group width as a percentage of 
the width of the independent major interval.. The "Gap" 
option sets the group width as equal to the independent 
major interval, inset by the given amount. 
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Field Size, Wedge Size, line Size - Sets the size of a bar's width or 
pie's wedge. Submenu choices are percentages of the group 
size. 

Choosing '"?" lets you set a custom width for the field element 
in points, centimeters, or inches, or as a percent value. A 
scale indicates with a black horizontal bar the total width of 
the field element in inches and centimeters relative to the 
width of the graph. Displayed beneath it is the value of the 
group size divided by the number of bars, or the width of a 
stacked bar, depending on the graph. 

The '·Percent" option sets the bar width as a percentage of the 
group width divided by the number of dependent fields being 
graphed. The "Gap'' option set the bar width to be equal to 
the group width divided by the number of dependent fields 
being graphed, inset by the given amount. 

Bar Offset, Wedge Offset, line Offset - Sets the independent 
position of a field element (bar, pie wedge, line) relative to its 
normal location. Setting a negative value as a percentage 
moves an element to the left in a line, bar, or stacked bar 
chart. A positive value moves it to the right or up in the 
direction of increasing values. In a pie chart, a wedge of the 
pie is moved radially away from the cha11 regardless of 
whether you use negative or positive numbers. The "Percent" 
choice in the Offset dialog sets the distance as a percentage of 
the field element's own size or, in the case of Line Offset, as a 
percentage of the major spacing on the independent axis. 

line Shift - Sets the dependent position of a line relative to its 
normal position. Setting a negative value moves the line 
down. A positive value moves it up. The "Percent'' choice in 
the Offset dialog sets the position as a percentage of the axis. 

Field Order - Sets the left-to-right order for elements within a 
group. 
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Color Position - Lets you set the direction of graduated color in a 
selected object. The arrow in each setting indicates the 
direction the first color shades into the second color for the 
gradient. Your choices are: 

► 

Shadow Uert ► 

Shadow Horlz ► 

3-D Shadow 
Surround Sh11dow 
Forw11rd Sh11dow 
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Graduated (ramped) colors are created with the "New ... " 
command from the Color menu in the palette. 

Color Reversal - Reverses the order of graduated color in an object. 

Open Window - Lets you open a window or activate it (bring it to 
the front). You can select the Clipboard window, the data 
window, the letterhead window, the Help window, the layout 
window, or any of your graph windows. You may have up to 
16 graph windows open at once. 

Close Window - Closes any active window. 

Zoom - Selects the size of the graph relative to the normal window 
size. Normal Size is 100 percent and Fit to Window shrinks 
the displayed information so the graph fits in the current-sized 
window. All other sizes are measured in percent. 

Clean Up Icons - Regroups window icons in the docking window 
by aligning them to an invisible grid. This is useful when 
resizing the docking window. 
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Special Menus 
When using the Define Field, New Format, Duplicate, Fill Field, and 
Define Curve Fit dialogs, the standard MacGraphX menu bar changes 
to one featuring the following menus: 

• Edit 

• Fields 

• Transforms 

• Curve Fits 

• Functions 

• Operators 

If you select a menu object from the Fields, Transforms, Curve Fits, 
Functions, or Operators menu while in one of these dialogs, that 
object will be entered in the field in which you are currently editing. 
These menus make for faster and easier formula building by 
conveniently providing you with the elements you need to create 
formulas. 

The Edit menu contains commands found on the regular edit menu, 
therefore it will not be described in detail here. The cut, copy, and 
paste functions are meant to make it faster and easier to edit text 
strings in dialogs. The other menus are as follows: 

Transforms 
These transforms are for use in the Define Fields dialog only: 

LinearFit - Takes two fields for arguments; new field values are the 
best straight-line fit approximation of the second input field to 
the first input field. 

NthDiff - Takes one integer, 11, and one field for arguments; new 
field values are the nth level difference of the input field. If n 
is one, each new value is difference between current input 
field value and prior one. 

RAvg -Takes one integer, n, and one field for arguments; each new 
field value for current record is the moving avernge for the 
input field, calculated by summing the n previous field values 
(including the current) and dividing by n. 
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RLag - Takes one integer, n, and one field for arguments; each new 
field value for current record is the difference between the 
current value of the input field, and the nth previous value. 
This is the growth of the input, adjusted for periodicity (such 
as seasonal or quarterly fluctuations). 

RLag% - Takes one integer, 17, and one field for arguments; each 
new field value for current record is the difference between 
the current value of the input field, and the 17th previous 
value, divided by the 17th previous value. This is the 
percentage growth of the input, adjusted for periodicity (such 
as seasonal or quarterly fluctuations). 

ZDiff - Takes one field for argument; first computes the mean and 
standard deviation for input field across all records, and 
calculates each new field value as current value of the input 
field minus the mean of the input field, divided by the 
standard deviation of the input field. This normalizes the 
input field. 

RunTotal - Takes one field for argument; each new field value is 
the sum of all previous values of the input field, including 
current value. 

RunAverage - Takes one field for argument; each new field value is 
the average of all previous values of the input field, including 
current value. 

Curve Fits 
These transforms are for use in the Curve Fits dialog only. Transforms 
used in curve fits always use exactly two fields as inputs, in addition 
to any other arguments. These input fields are never explicitly given 
in the formula for the curve fit, but are always assumed to be the the 
independent field as the first input field, and the selected dependent 
field value as the second input field. 

CubicSpline - Takes no arguments; creates data for a smooth curve 
connecting all the data points in a scatter graph. 

LlnearFit - Takes no arguments; creates data for the best straight­
line approximation of the dependent field versus the 
independent field. 
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LNFit881 - Takes no arguments; creates data for the best logarithmic 
approximation of the dependent field versus the independent 
field; requires mathematical coprocessor (68881 or 68882). 

PolyFit - Takes one integer, n, as argument; creates data for best-fit 
nth degree polynomial approximation of the dependent field 
versus the independent field. 

Functions 
In the following examples, an "x," "y" or "xj" indicates a numeric 
value (a field, number, or part of a formula that evaluates to a 
number), and "Record#" is the record number of the current record 
being calculated. For example, in MOD(x

1 
,x

2
) , MOD is the function 

name (Modulo) and x
1 

and x
2 

are the arguments. This particular 

function takes exactly two numeric arguments. 
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Constants - Values that remain constant in a formula. MacGraphX 
has the following constants: 

0, 1, 2,3,4, 5, 10 Numeric constants. 

FALSE Logical FALSE defined as a constant 
equal to zero. 

PI Mathematical constant 7t 

(=3.141592653 ... ) 

RAND Takes no arguments and returns a 
random number between O and 1. Each 
time a dataset is recalculated a new 
random number will be generated. For 
example, RAND may return 0.6645 .... 
RANO°10 will return a random number 
between O and 10. 

TRUE Logical constant defined to equal one. 

Arith Fens - MacGraphX provides you with many arithmetic 
functions: 

ABS Takes a numeric value and returns its 
absolute value, i.e., the number's distance 
from zero on the number line. For 
example, 

ABS(5.6) = 5.6, 

ABS(-5.6) = 5.6. 

EXP Takes any number and returns ex, where 
e is the constant 2.71828 ... (the base for 
the natural logarithm). For example, 

E)(P(1) = 2.71828 ... , 

EXP(2) = 6.38906 ... 

GROW# Takes two numbers and adds the first to 
a multiple of the second. GROW;;:(x,y) is 
defined to be 

(x + (Record;;:• y)). 

co11linued next page ... 
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GROW% Takes two numbers and multiplies the 
first by an exponential growth of the 
second, taken as a percentage. 
GROWo/o(x,y) is defined to be 

(x • ((1 + y/100) " Record#)). 

INT Takes any number and returns only the 
integer part of that number. 

LN Takes any number greater than zero and 
returns its natural logarithm. For 
example, 

LN(2) = 0.69314 ... , 

LN(EXP(2)) = 2. 

LOG Takes any number greater than zero and 
returns its common (base 10) logarithm. 
For example, 

LOG(l00) = 2, 

La°G(2) = 0.30102 ... 

MOD Takes two numbers, (x
2 
* 0) and returns 

the remainder of x1/x
2

. For example, 

MODC17,5) = 2, 

MOD(-23,4) = -3. 

ROUND Takes any number x and returns its value 
rounded to n number of decimal places. 
If n is a negative number, then x is 
rounded to the multiple of 10 specified 
by n. For example, 

ROUND(3.1456,2) = 3.15, 

ROUND(3.1456,0) = 3, 

ROUNDC123.456,-2) = 100. 

SQRT Takes a positive number and returns its 
square root. For example, 

SQRT(16) = 4, 

SQRT(8) = 2.828 .... 

' . I , 
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Trig Fens - Trigonometric functions relate corresponding parts of a 
right triangle. MacGraphX's Trigonometric functions are: 

ACOS Takes any number x and returns the 
inverse value of its cosine in radians. For 
example, 

ACOS(-1) = 3.14 ... (1t] 

ASIN Takes a number x, the size of an angle in 
radians, and returns its inverse sine in 
radians. For example, 

ASIN(l) = 1.57 ... [1t/2) 

ATAN Takes a number x and returns the inverse 
value of its tangent. in radians For 
example, 

ATAN(l) = 0.785 ... [1t/4] 

ATAN2 Same as above but takes two inputs, and 
respects the sign of each. For example, 

ATAN2(-1,-1) = 3.92 ... [51t/4] 

cos Takes any number x, the size of an angle 
in radians, and returns the value of its 
cosine. The cosine is always a value 
between -1 and 1. For example, 

COS(PI/3) = 0.5. 

SIN Takes a number x, the size of an angle in 
radians, and returns its sine. The value 
returned is between 1 and -1. For 
example, 

SIN(PI/2) = 1. 

TAN Takes a number x, the size of an angle in 
radians, and returns the value of its 
tangent. For example, 

TAN(PI) = 0. 
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Logical Fens - Produce a logical value. Logical values are TRUE and 
FALSE. In calculations. MacGraphX uses the corresponding 
numbers 1 and 0. 

IF Takes x as the condition to be tested and 
returns x

1 
if the condition is true (i.e., 

evaluates to a non-zero number) and 
returns x

2 
if the condition is false. For 

example, 

IF(x>21. x
1

,x
2

) will return the value x
1 

if x is greater than 24, otherwise it will 
return the value x

2
. 

ISERR Takes a field as an argument and returns 
1 if the field value for the current record 
contains error value, otherwise 0. Cells 
that contain infinite values (e.g., 1/0) are 
not counted as containing errors. 

ISNULL Takes a field as an argument and returns 
1 if the field value for the current record 
contains no value, otherwise 0. 

Date Fens - Return a number for the specified date. 

TODAY Returns the number (days since 
December 31, 1903) of today's elate. 
Takes no arguments. 

continued next page ... 
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DATE Returns the number (days since 
December 31, 1903) of the date specified 
by the arguments. Year must indicate a 
year between 1904 and 2079, and so 
must have a value between 4 and 179. 
Month may be between 1 and 12. If the 
month is greater than 12, it rolls over. For 
example, a value of 13 for month 
indicates January of the following year. 
Enter the day appropriate for the given 
month, though days also roll over into 
the next month. For example, 

DATE(84,l,1) = 29221, 
DATE(81,2,31) = DATE(81,3,3) = 28187. 

DAY Takes the date number as an argument 
and returns the day of the month in the 
date. For example, 

DA Y(29221) = 1. 

MONTH Takes the date number (the number of 
days since December 31, 1939) as an 
argument and returns the number of the 
month. For example, 

MONTH(29221) = 1 (January). 

YEAR Takes the date number (the number of 
days since December 31, 1939) as its 

, i argument and returns the year of the 

~ date. For example, 
YEAR(29221) = 84. 

WEEKDAY Takes the date number (the number of 
days since December 31, 1939) as its 
argument and returns the number of the 
day of the week of the date. For 
example, 

WEEKDA Y(29221) = 1 (Sunday). 
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Financial Fens - Perform financial calculations. 

PMT Calculates the payment per period for 
principal x at interest rate i for n periods. 
PMT = x•(i/(1-(1 +i)n)). For example, 

PMT(l0,0.1,2) = 5.76. 

PV Calculates the present value of an 
ordinary annuity with payments of x at 
interest rate i after n periods. PV(x,i,n) = 
x•(l-( +i)-n/i. For example, 

PV(l0,0.1,2) = 17.35. 

FV Calculates the future value of an annuity 
with income payments of x at a periodic 
interest rate i after n periods. FV = 
x•((l +i)n-1)/i. For example, 

FV(l0,0.1,2) = 21. 

Arithmetic Oprs - MacGraphX has five arithmetic operators. They 
perform the following operations: 

+ Addition 

- Subtraction . Multiplication 

I Division 

I\ Exponentiation 

Comparison Oprs - Compare two operands. The result of 
comparison operations is always either TRUE (1) or FALSE (0). In 
calculations, MacGraphX uses a true result as 1 and a false result as 0. 
The comparison operators are: 

= Equal 

-:/:- Not equal 

> Greater than 

:::; Less than or equal to 

~ Greater than or equal 
to 
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Note: Text must be enclosed in quotation marks when used as an 

operand. for comparison operators. 

Logical Oprs - Produce a result that is always TRUE or False. In 

numeric calculations, MacGraphX equates TRUE to 1 and 

FALSE to 0. Logical operators arc: 

AND Combines two logical expressions. The 

result is true if and only if both of the 
formulas are true: 

2>1 AND 2<4 is true (1), 

2>1 AND 2>2 is false CO). 

OR Combines two logical expressions. The 
result is true if either or both of them is 
true: 

2>1 OR 2>2 is true (1), 

2<0 OR 2>2 is false (0). 

NOT egates the expression that follows it. 

For example: 
If x > 10 is true (1), 

NOT(x>10) is false (0). 
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Chapter 14: About the Palette 
The palette gives you tools to modify objects in a graph, letterhead, 
and layout window, and create your own graphics. The palette 
automatically appears when you open one of these windows, and 
"floats" above the graphic windows. You can roll up the palette to by 
clicking in the zoom box in the title bar of the palette.on the right 
side. You can expand the palette to full view by again clicking in its 
zoom box. You can also move the palette around on the screen by 
clicking and dragging the title bar of the palette. The palette looks like 
this: 

Using the Palette 

□Fast 
Color 

IDIIIIIII ► 
Pitt rn Modt' 
--►~ ► 

4 Ob ·•cts: 

Ltft :395 Top ;SB 
...,.ldth :85 Hti t :68 

□Grid ~► 
o:::=J ► ~ 

Using the palette is similar to using standard menus. First, select an 
object in the active window. Then choose the part of the object to 
modify (Fill, Line, Drop, etc.) by clicking on it in the palette. Finally, 
give a command by clicking on the arrow next to a menu's status field 
and dragging the cursor to the desired setting on the pop-down menu. 
When you release the mouse, the selected object in the window 
changes its appearance. 

Palette Features 
The palette has four kinds of features: selectors, commands, measures, 
and tools. 
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Selectors 
Selectors specify the attribute of an object that a command will act on. 
When you select an object, some of the selectors become active. If a 
selector is gray, it is inactive and cannot be used with the chosen 
object. For instance, the Mark selector will not be active when you 
select a field element in a bar graph or pie chart since it allows you to 
change only the attributes of a mark. 

In addition, selectors work only with certain commands. The selectors 
and their respective commands are: 

Fill-Allows you to change the fill attributes of an object. Use with 
"Pattern," ··color," and ''Mode" commands. 

Line-Allows you to change the outline of an object. Use with 
'·Panern," "Color,"' and "Mode" commands. 

Drop--Allm,vs you to create a drop shadow for an object. Use with 
"Pattern," ··Color," and '·Mode" commands. 

Text-Allows you to change the color of text. Nore that font. size. 
style and rotation are changed via the Text menu on the 
menu bar. 

Mark-Allows you to change the color of a mark (such as in a scatter 
chart). The actual mark shape is selected with the Mark Type 
command of the Lines menu. 

Bkgd-Allows you to change the background surrounding text. Use 
with"Pattern," "Color,•· and ··Mode" commands. 
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Commands 
Commands change the appearance of an object for the attribute you 
have chosen with a selector. The commands are: 

Color-Specifies the color of an object. In addition to the color 
selections given, "New'' allows you to define new colors with 
Apple's Color Picker dialog: 

1.4 
Select new color 

Hue ~o 00 
S11turollon O 00 
Brightness 65535 00 

Red 65535 00 
Green 65535 00 

Blue 65535 00 

Your choices in the dialog are: 

"Hue" Sets the hue of your color. Click on the 
upper arrow to increase, the lower one to 
decrease. Hue is the position on the color 
wheel (from red to purple). 

"Saturation" Sets the intensity of the selected color. 

"Brightness" Sets the darkness of your color. 

"Red" Sets the amount of red in your color. Click 
on the upper arrow to increase, the lower 
one to decrease. 

"Green" Sets the amount of green in your color. 

"Blue" Sets the amount of blue in your color. 

Color Wheel Allows you to change hue and saturation 
by clicking anywhere in it. 

Scroll Bar Specifies brightness. 
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Pattern-Specifies the pattern of a selected attribute of an object. 
Choose a pattern from the pop-down menu. Patterns can be 
altered for the fill or outline of any graph object or 
user-drawn graphic. 

Mode-Specifies the background of patterns, either white, black, or 
clear. The modes are: 

Default setting that sets the background white. 

Sets the background black. 

Sets the background clear. 

Measures 
Measures give you information and options having to do with the size, 
location, and status of graph objects. 

Coordinates Window-Indicates what object you have currently 
selected, its dimensions, and where it is located relative to the 
left and top boundaries of the graph window. It also tells you 
where the object is relative to its initial location as you move 
it along invisible horizontal and vertical axes. All distances are 
measured in pixels. Negative numbers indicate movement to 
the left or up, positive numbers, to the right or down. 

Grid-Creates an invisible grid to help align graph objects. Using the 
pop-down menu you select the size of the grid in pixels. An 
object can then be moved in any direction by the increment 
selected. 

Fast-Replaces graduated fills with the first color of the fill so that 
updates to the.~raph window can be made faster. 
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Tools 
Use the Tools menu as you would any menu on the palette. When 

you release the mouse after using a tool, the pointer tool, ~ , is 
automatically reselected. If you wish the tool you chose to remain 
selected indefinitely, hold down the Option key while selecting the 
tool. 

The default tool for the palette. Allows you to select any 
graph object by clicking on it. You may also move and resize 
graph objects. To move an object, select it and drag by a 
boundary. 

Resizing is done by selecting the object and clicking and 
dragging on a resizing handle at a corner or side of the 
object. A user-drawn line has a handle at each end. 

If you wish to turn a rectangular or oval object into a square 
or circle, respectively, hold down the Shift key while dragging 
a handle. (MacGraphX may not always draw the data frame or 
graph frame as a perfect square, however, depending upon 
the "Exact Frame Size" option for each dimension, but will 
come as close as possible.) While resizing a line, the Shift key 
constrains it to be horizontal, vertical, or a 45° diagonal. 

Resize an object in one direction only by clicking and 
dragging any handle. To resize it symmetrically, that is, 
equally in two directions, hold down the Option key while 
clicking and dragging any handle. If you want the object to 
resize symmetrically in all four directions, hold down the 
Option and Shift keys while clicking and dragging a handle. 

Moving or Resizing Frames Separately 
As explained in Formatting Your Graph, frames are normally 
linked, i.e., moving and resizing one affects the others. You 
can disable the linkage between frames by pressing the 
Command key while moving or resizing a frame. With the 
Command key pressed, any moving or resizing affects only 
the selected frame. You still cannot enlarge the data frame 
past the graph frame, nor shrink the graph frame within the 
data frame, however. Nor can you enlarge these frames past 
the placement frame. 
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Allows you to enter or change text. The cursor becomes: r. 
MacGraphX does not automatically wrap text, but will wrap 
to the next line when you press Return. You may mix font 
attributes and typefaces in the same text block, but you may 
not have different colored text in the same block. 

Draws rectangles and squares. Your cursor becomes: +. The 
Shift key acts as a constraining tool allowing you to a square. 

Draws ovals and circles. Your cursor becomes: +. The Shift 
key acts as a constraining tool allowing you to draw a circle. 

Draws rounded rectangles and squares. Your cursor becomes: 

+. The Shift key acts as a constraining tool allowing you to 
draw a square with rounded comers. 

Draws horizontal, vertical, and diagonal lines. Your cursor 

becomes: +. The Shift key acts as a constraining tool 
allowing you to draw a perfectly horizontal, vertical, or 45° 
line. 

Draws horizontal, vertical, and diagonal arrows. Your cursor 

becomes: +. The Shift key acts as a constraining tool 
allowing you to draw a perfectly horizontal, vertical, or 45° 
arrow. 
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Appendix 
This Appendix contains illustrations of the parts of a graph, 
repeated from previous sections of the manual. This Appendix also 
provides you with a list of "power selection keys" to select graph 
objects from the keyboard, and a list of possible errors. 

Basic Parts 

Frames and Grids 

t 
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Near and Far Parts 

Power Selection Keys 
The following keys select graph objects in the active graph window. 
Use them to select objects without taking your hands off the 
keyboard. Press a key to specify an object, object class, or class 
modifier to be selected. Keys may be typed in any order. Press the 
return key to perform the selection. 

Object classes 
The following commands select objects that occur at least twice in a 
graph, e.g., axes, ticks, etc. You may use modifier keys to further 
specify which object to select; otherwise, all objects of that class will 
be selected .. 

g Selects a grid. Use the appropriate modifier key to 
specify independent or dependent, minor or 
major. 

b Selects a baseline. Use the appropriate modifier 
key to specify independent or dependent. 

1 Selects a label. Use the appropriate modifier key 
to specify independent or dependent, near or far. 

a Selects an axis. Use the appropriate modifier key 
to specify independent or dependent, near or far. 

t Selects ticks. Use the appropriate modifier key to 
specify independent or dependent, minor or 
major, near or far. 

e Selects an axis title. Use the appropriate modifier 
key to specify independent or dependent; without 
a modifier, selects the graph title. 
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Modifier Keys 
The following keys specify independent or dependent, major or 
minor, near or far for the object classes listed above. If used without 
an object class, will select all objects of that type. 

d Dependent. 

i Independent. 

' 
Minor .(Note that "," is under"<'' on the 
keyboard.) 

Major. (Note that ".·· is under ">" on the 
keyboard.) 

n Near .. 

f Far. 

X x axis (horizontal axis). 

y y axis (vertical axis). 

Singular Objects 
The following commands do not require the use of modifier keys 
because the objects they select occur only once in the graph 
window. 

p Selects the placement frame. 

[ Selects the graph frame. 

] Selects the data frame. 

k Selects the key (legend). 

e Selects the graph title (unless used with a modifier 
key). 

Fields 
The following commands select fields (bars, lines, areas, pieces of a 
pie) and marks in a graph window. 

1 Selects field 1, field, 2, field 3, and so forth. 

2 

... 9 

h Selects the high mark in a Hi-Lo line/Error bar. 

v.r Selects the low mark in a Hi-Lo line/Error bar. 
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Errors 
In your work with MacGraphX, you may run across some error 
messages. This section lists those errors, and suggests some 
solutions to common problems. 

MacGraphX Errors 
This section lists the error messages you may see in working with 
MacGraphX. 

Memory Error 
The most common error you may see is due to running out of 
memory: 

• An error occurred: there is not enough memory to complete 
the operation. Free mem: 5%. 

The dialog box in which this message appears gives you the chance 
to "Clear Boards," which clears out the clipboard and the internal 
undo buffer, and temporarily gives some more space to 
MacGraphX. If you see this error, you're running dangerously low on 
memory. We strongly suggest that you save your work and quit the 
program. 

If you are running under Multifinder, you can allot more memory to 
MacGraphX. In the Finder, select MacGraphX by clicking once on 
its icon. (Don't double-click, or you will inadvertently open the 
program.) Use the "Get Info" command from the File menu of the 
Finder. In the dialog box which appears, increase the Application 
Memory Size for MacGraphX, at the lower right. 

Dialog Entry Errors 
In using dialog boxes, you must often enter a number or the name 
of a field in an edit box. If you've mistyped in an edit box that 
requires some piece of information, you'll see one of these errors: 

• An incorrect integer value was entered. 

• A correct number must be entered. 

• A positive number must be entered. 

• A larger number must be entered. 

• A correct text string must be entered. 
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• A correct field name must be entered. 

• A correct field constant must be entered. 

• A correct record number must be entered. 

• A correct cell specification must be entered. 

• A correct range specification must be entered. 

• A correct numeric field must be entered. 

If you see one of these errors, the offending edit box will be 
highlighted. Check your typing. In a dialog box, you can use the 
Fields menu to correctly choose a field name to be entered into the 
current edit box. 

Formula Errors 
In using equations for defining field values or for curve fits, you 
might run into syntax errors when entering formulas. The errors are: 

• There was an unrecognized term in the equation. 

• The equation did not end properly. 

• There were too many or too few arguments to the function. 

• A part of the equation cannot be recognized. 

• Miscellaneous parse error. 

If you see one of these errors, check your typing. Make sure you spell 
the names of functions and field arguments correctly. Make sure that 
you gave the correct number and type of arguments to functions 
and transforms. Make sure that all parentheses balance. 
(MacGraphX will add extra parentheses at the end of formulas, as 
needed, to balance parentheses.) 

Scale Errors 
When using manual scaling on an axis, you might see this error: 

• The manual scale parameters could not be accommodated. 

If you see this error message, MacGraphX couldn't giv~ you the 
requested manual scaling, and therefore resorted to automatic 
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scaling. To fix the problem, open up the axis info dialog box that 
was most recently changed, and examine the scaling values entered. 
Make sure that the scaling interval is smaller then the difference 
between the minimum and maximum limits of the graph data 

Save Error 
In saving your data, you may see the following error: 

• There is not enough room on disk to save the file. 

Try to save your file again, but use a disk with more free space. 

Printing Errors 
In printing, hardware or software problems may occur. The most 
common problem is caused by not having the proper printer 
resource files in your System folder, such as the "ImageWriter" or 
"LaserWriter'' file. Note that a printer resource file is listed as a 
"Chooser document" in the System folder. The errors are: 

• Unknown print error. 

• Saving spool file error. 

• Unimplemented control error. 

• 1/0 abort error. 

• Not enough room in heap for printing. 

• Printer not found or closed. 

• Connection just closed. 

• Write request too big. 

• Request already active. 

• Bad connection refnum. 

• No free connect control blank available. 

• Postscript error. 

• Printer timeout. 
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If you see one of these errors, use the Chooser desk accessory to 

verify that the correct printer is selected. Verify the physical 

(hardware) connections between your computer and the printer; 

check the network if necessary. Increase the memory allotted to 

MacGraphX (see "Memory Errors," above). Increase the free space 

on your disk (if your printer is spooling to disk). 

File Errors 
In saving or opening a file, an error with the file system may occur. 

The most common cause of errors is a bad medium, such as a 

damaged track on your hard disk. The file errors are: 

• Unknown file error. 

• No default volume. 

• Bad drive number or negative count. 

• Bad file reference number. 

• Bad volume name. 

• External file system error. 

• 1/0 error. 

• No such drive. 

• No such volume. 

• File not found. 

• File already open for writing. 

• Attempt to open locked file for writing. 

• Too many files open. 

• End of file error. 

• File not open. 

• Disk full error. 

• File locked. 
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• Software volume lock. 

• Hardware volume lock. 

• Read/write permission doesn't allow writing. 

• Duplicate file name and version. 

• Directory full error. 

• File busy error. 

Most of the errors listed above won't really ever happen, hut they 
are listed here for completeness. If you get a file error, use one of 
the available software tools to check your disk for physical 
problems. Unlock your disk, as necessary. Run a disk optimizing 
program (such as Disk Express from ALSoft) to reclaim unused disk 
space. 
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Glossary 
The following is a glossary of chart terminology. 

Annotations -Text or numbers added to a graph indicating field 
values or names. 

Baseline - The line from which bars or areas are drawn. 

Curve Fit - A line that indicates an approximation, trend, or 
mathematical model of the data in a scatter charts. 

Data Frame - The frame that encompasses all data values. 

Dependent Axis -The (usually) vertical axis of a graph that 
measures variables by showing values increasing from bottom 
to top. Non-numeric values also may be shown along the 
axis. If vertical, also known as they axis. 

Error Bars - See "Hi-Lo Lines.·· 

Far Axis - The normally invisible axis on the "far•· side of the graph, 
that is, the top or right side. 

Far Axis Labels - Text or numbers along a far axis showing values 
or names. Axis labels correspond to each major tick. 

Field Elements - Any part of a graph representing fields. This 
includes a bar, part of a stacked bar, piece of a pie, or mark. 

Graph-A series of points, a line, a curve, or an area that represents 
the variation of a variable in comparison with that of one or 
more other variables. 

Graph Frame - The rectangular frame that surrounds all field 
elements, encompasses the data frame, and overlaps the 
dependent and independent axes. 

Hi-Lo lines - Lines which correspond to the difference between the 
highest and lowest values in a field group. They are used to 
make the data range easier to see or to indicate the accuracy 
of measurements. Hi-Lo lines are sometimes called "Error 
Bars." 
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Independent Axis -The (usually) horizontal axis of a graph that 
usually measures time, or some other sequential variable, by 
showing values increasing from left to right. Non-numeric 
values also may be shown along the independent axis. If 
horizontal, also known as the x axis. 

Interval - The distance between two major grids or ticks on an axis. 
Intervals are usually divided into smaller, unlabeled measures. 

Legend - Box containing information identifying fields in a graph. 
The legend is sometimes called the ··Key." 

Major Grid lines - Long lines that delimit the major intervals within 
the data frame. There are dependent and independent major 
grid lines. 

Major Tick - A short line marking a major interval on an axis and 
running perpendicular to that axis, touching it. There are 
dependent and independent, near and far, major ticks. 

Margin - Space between the data frame and the graph frame. 

Marks - Small points representing values in a scatter, line, or area 
chart, or at each end of a hi-lo line. Marks can vary in shape 
and size. 

Minor Grid lines - Long lines that subdivide the major intervals 
within the data frame. There are dependent and independent 
minor grid lines. 

Minor Tick - A short line subdividing a major interval on an axis 
and running perpendicular to that axis, touching it. There are 
dependent and independent, near and far, minor ticks. 

Near Axis - The axis on the .. near•· side of the graph, that is, the 
bottom or left side. 

Near Axis labels - Text or numbers along a near axis showing 
values or names. Axis labels correspond to each major tick. 

Placement Frame - The rectangular frame that surrounds all items 
of the graph, and specifies where the gr..tph appears on the 
page. All visual elements must be inside the placement fr..tme. 
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Second Independent Axis - A subdivision of the field that is 
displayed on the independent axis. Note that this is not a 
second axis line. 

x Axis - Another name for the horizontal axis. The x axis is usually 
but not always the independent axis. 

y Axis - Another name for the vertical axis. They axis is usually but 
not always the dependent axis. 
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3-D drop shadow 30, 45 
hiding 71 

3-D Shadow 128, 185 

ABS 191 
ACOS 193 
Addition 196 
Align 110, 176 
Align Horiz 115, 175 
Align Vert 115, 175 
Alignment 89, 119, 178 
Anchor to Frame 109. 176 
anchored objects 56 
AND 197 
Annotate Type 117. 181 
Annotation Gap 117, 182 
Annotation Place 117, 182, 147 
annotations 116, 212 
Areas 185 
argument 137 
arguments 134, 136 
Arith Fens 191 
Arithmetic Oprs 196 
ASIN 194 
ATAN 191 
ATA 2 194 
Auto 182 
average 89 
axes 

even spacing between 
inter. als 101 

hiding 66 
patterning 68, 74 
scaling and formatting 

102 
selecting 66, 68 
showing 61, 62, 74 
transposing in the graph 

window61 
widening 61. 62, 74 

Axis Info dialog 150 
Axis Labels 213 
axis labels 

aligning 69, 77 
formatting 26 
hiding 68 
numeric formatting 69. 

118 
rotating 63 
selecting 26, 62, 63. 68, 77 
staggering 118 

axis titles 
hiding 40. 55, 70 
selecting 40, 55, 70 

bar graph 
creating 36 
second independent axis 

with35 
Bar Offset 64 
Bar Offset, Wedge Offset, Line 

Offset 186 
Bar Order 128 
Bar Size 127 
bars 

coloring 58, 59 
patterning 58, 59 
reordering 24. 25 
shading 149 

baseline 101, 178. 212 
basic concepts 

cells 8 
data frame 9 
data window 7 
dataset 8 
desktop 6 
docking window 6 
entering data 9 
field 8 
field indicator 10 
graph frame 9 
importing data 9 
legend 12 
near and far sides 51 
objects 10 
on-line help '52 

overlaid graphs 52 
palette 11 
placement frame 9 
power selection keys 10, 

205 
Preferences dialog 53 
record 8 
resizing handles 10 
searching 51 
selecting graph objects 10 
selecting a range of 

records 9 
selecting fields 9 
sorting 51 
transposing axes 52 
windows and icons 6 

Bkgd 121, 199 
Blank !Draw) 124, 165 
Bottom 177 
Bring to Front 116, 177 

call-outs 152 
cells 8. 80 

clearing 87 
copying 86 
cutting 86 
pasting 87 

Center 177 
CF Manual Recalc 103, 184 
CF Recalc Nmv 103. 184 
Chooser 109. 132. 133.210 
Clean Up Icons 187 
Clear 81, 87, 108, 159, 160 
Clipboard 87, 159. 160, 161. 

187 
Close 154 
Close Window 79, 187 
Color 120 200 
Color menu 187 
Color Picker dialog 122, 123. 

200 
Color Wheel 200 

Scroll Bar 200 
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Color Position 123, 187, 189 
Color Reversal 124, 187 
Communicate 157 
Comparison Oprs 196 
Complete Grid 113, 183 
Constants 191 
constraining tool 203 
continuous variable 141 
coordinates indicator 109 
Coordinates Window 201 
Copy 86, 159 
cos 193 
Create Graph dialog 93 
CubicSpline 189 
Currency O 181 
Currency 2 181 
Curve Steps, Steps 
Curve Fit 102, 103. 138, 184, 

212 
cubic spline 103 
linear 103 
logarithmic 103 
polynomial 103 
recalculating 103 

curve fits 102, 137, 138, 140, 
188,189 

Curve Fits dialog 189 
custom colors 122 

ramped color 123 
Cut 86, 108, 159 

data 134. 162 
entering 

field by field 14 
in a preset dataset 83 
record by record 13, 

83 
exporting 90 
fields and records 

adding 84 
importing 14, 84 
overlapping data frame 

101 
Data Export 158 
data frnme 9,177,204, 212 

hiding 58, 65 
selecting 41, 55, 58, 65, 76 

Data Front 115,175 
data types 85 
data window 7. 18, 79 

arrow keys 81 
closing 79 
columns, resizing 89 
fields, renaming 86 
grow box 89 
moving around in 81 
opening 79 
resizing 90 
selecting cells, fields. and 

records 82 
text formats 89 
zoom box 20, 90 
dataset 79, 134, 135 

dataset 8 
DATE 195 
Dare Fens 194 
DAY 195 
Define Curve Fit dialog 102, 

138,184,188 
Define Fields dialog 83, 84, 85, 

86,134,136,137,162,163. 
188 

Define Number Format dialog 
179 

Define Search dialog 88, 164 
Define Sort dialog 88, 163 
Delete 87, 161 
Delete Graph 174 
dependent axis 19, 102, 106, 

112,167,170,212,214 
selecting 62 

dependent axis title 
changing 120 
hiding 27, 28 
selecting 27 

dependent field, defining 16, 
21,35,37 

desktop 6 
dialogs, accessing 95 
Disk Express 211 

Division 196 
docking window 6, 79, 130 
draw tools 120, 124, 198, 202 
Drop 121, 128. 199 
drop shadow 28, 44, 121, 128 

coloring 29, 44 
hiding 64 
patterning 58, 59 
specifying 29 

Duplicate 83, 87. 108, 160, 161, 
188 

Duplicate dialog 87, 160 

Edit 159, 188 
Enter 81 
entering data 9 
entry cell 80 
Equal 196 
Error Bars 173. 212 
errors 207 

dialog entry 207 
file 210, 211 
formula 208 
MultiFinder 207 
printing 209 
save 209 
scale 208 

Escape 81 
EXP 191 
Exponentiation 196 
Export 157 
Export Data 90, 157 

FALSE 191, 196 
Far Axis 178, 212 
far axis labels 212 

selecting 69 
showing 69 

far dependent axis 
selecting 74 
showing 74 

Far Labels 178 
Far Major Ticks 178 
Far Minor ticks 178 
far sides 68 
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Fast 124, 201 
field 8 
Field Elements 212 
field indicator 10 
Field Info dialog 173, 174 
field labels 181 
field lines 

coloring 46, 47 
patterning 46, 47 
widening 45. 46 

field names 173, 182 
Field No Recalc 164 
Field Order 186 
Field Size, Wedge Size, Line 

Size 18 
fields 80, 85, 107, 134. 162. 167. 

178,188,206 
defining 92 
indenting 66 
selecting in the graph 

window 45, 58. 63, 64 
sorting 88 

File 154 
Fill 121, 199 
Fill Field 87, 188 
Fill Field dialog 87, 161 
fill patterns, changing 41 
Fill Recs 161 
fills and colors 149 
Finder 207 
Fit to Window 116, 130, 187 
Fixed0, Fixedl... 181 
Fld No Recalc 84 
Flipped 182 
font 178 

changing 23, 38, 56, 57, 62, 
63, 70 

enlarging 57, 70, 71 
formulas 83, 134 

natural order, 165 
order of evaluation 135, 

136 
recalculating 84 

Forward Shadow 128, 185 

frames, moving and resizing 
separately 111 

Full Graph 106. 125, 126, 177 
functions 134, 136, 137, 188, 

190 
FY 196 

General 181 
graduated fill 123 
graph 96, 99, 101, 102, 104, 116, 

165,167,169,212 
creating 15, 17, 22 
defining, four steps 91 
moving 56, 70 

graph frame 9, 177 204,212 
selecting 70 

Graph Info dialog 67. 96, 97 
99,101,169,172 

graph objects 
aligning 110 
anchoring 109 
arrows 203 
Basic Parts 204 
circles 203 
clearing 108 
colors, shapes, and 

patterns 120 
copying 108 
cutting 108 
drop shadow 128 
duplicating 108 
frames, moving and 

resizing separately 202 
Frames and Grids 204 
handles 202 
hidden 108 
layers 115, 116 
lines 124, 203 
modifying 108 
moving and resizing 109 
Near and Far Parts 205 
ovals 203 
pasting 108 
rectangles 203 
resetting attributes 129 

resetting locations 110 
resizing 202 
rounded rectangles 203 
rounded squares 203 
rounding corners 126 
selecting 28, 105. 107 
showing hidden 61 
squares 203 
text, mixing attributes 203 

graph title 
changing 24 
moving 56. 70 
selecting 23. 38, 62 

graph types 
Area 142. 165, 166 
-Bar 143, 165, 166 

horizontal 143 
Line 141. 165. 166 
Pie 145, 146. 165. 167 
Scatter 140. 165,166 
Stacked Bar 144, 165, 167 
Table 146, 165, 167 

graph window 
bar order 128 
closing 105 
delayed screen updates 

129 
deleting 105 
extending 116 
fast redraw 124 
field and group size 126 
mixed text 120 
naming 105 
negative values 97 
numeric formatting 118 
opening 54, 105 
printing 109 
reordering fields 99 
reordering records 99 
saving a PICT file 129 
template 129 
text, wrapping 203 
text and numbers 116 
text formatting 119 
transposing axes 111 
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user-drawn graphics 124 
user text 119 
zooming 116 

graphs 
basic guidelines 139 

Clarity 139 
Simplicity 139 
Validity 139 

enlarging beyond page 
104 

overlaying 94 
Graphs in Front 115 
Graphs to Back 115, 175 
Greater than 196 
Greater than or equal to 196 
Grid 109, 201 

completing 113 
grid lines 148 

adjusting 113 
coloring 43 
hiding 75 
patterning 61 
selecting 30, 42, 61, 67, 75 
showing 61 
widening 31, 42 

Group 126 
Group Size and Pie Size 185 
GROW 
Grow to Frame 112, 176 
GROW% 192 

Hi-Lo lines 125, 129, 173, 212 
length 125 
marks 125, 126 

Hi Delta 126 
Hi Mark 125 
Hi Mark/Lo Mark 177 
Hide 108, 176 
horizontal (x) axis 91, 94, 141 
horizontal axis 150, 214 

labeling 152 

icons, windows and 6 
IF 194 
Import Data 9, 84, 155 

independent axis 19, 36, 102, 
106,112,167,170,212,214 

selecting 61 
independent axis labels, 

selecting 57 
independent field 143 

defining 15, 21, 37, 91 
Insert 83, 161 
insertion bar 80 
installing MacGraphX 4 

on a double 800K floppy 
setup 5 

on a hard disk 5 
INT 192 
intervals 101 
!SERR 194 
ISNULL 194 

key 213 

labels, formatting 39 
layout window 130, 132, 198 

cut, copy, paste, and clear 
133 

number of pages 132 
page numbering 133 
page orientation 132 
placing graphs 132 
printing 133 
text and graphics 133 

Left 177 
legend 12, 43, 129, 167, 172, 

177,213 
aligning 72, 77 
changing fonts in 59 
default columnar 

configura"tion 76 
enlarging 77 
enlarging text in 59 
formatting 129 
giving a clear background 

to 69, 73 
giving a clear boundary to 

60, 73 
Hi-Lo lines 125 

moving 60, 65 
selecting 44, 59, 63, 64, 71, 

77 
widening 73 

Legend Info dialog 76, 125, 
129, 172 

Length Adjust 113, 124, 183 
Less than or equal to 196 
letterhead window 130 

footer 130 
Line 103, 121, 199 
line graph 37 

creating 38 
Line Shift 127, 186 
Line Width 124. 141. 183 
LinearFit 188, 189 
Lines 102, 182 
LN 192 
LNFit881 189 
Lo Delta 126 
Lo Mark 125 
Load dialog 15, 84, 155 
LOG 192 
Logical Fens 194 
Logical Oprs 197 

MacGraphX 
launching 18 
minimum requirements 4 

MacGraphX File 158 
Major Grid 178 
Major Grid Lines 213 
major intervals 213 
Major Tick 213 
Manual Recalc 164 
Margin 213 
Mark 121, 199 
Mark Type 126, 142, 183 
mark types, changing 48, 49, 

75 
marks 142, 213 

selecting 48, 75 
maximum 89 
measures 213 
Memory Error 207 
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MG.XSTisf folder 161 
MGX File 157 
MGX Import 157 
MGX Stationery 157 
Middle 176 
Minor Grid 178 
Minor Grid Lines 213 
Minor Tick 213 
minor ticks 101 
MOD 192 
Mode 120 
MONTH 195 
Move To Top 88, 162, 164 
MSMail Open 157 
MSMail Send 158 
Multiplication l 96 

NIA 163 
iatural order 100 

near and far sides 51 
Near Axis 178. 213 
Near Labels 118, 178 
Near IVlajor Ticks ] 78 
Near Minor Ticks 178 
near sides 68 
New 154 
New Format 86, 179 
New format dialog 118 
New Graph 94, 124, 129, 165 
None 181 
Normal Size 116, 187 
NOT 197 
Nor equal 196 
Note/Msg, dialog 174 
NthDiff 188 
null values 87 
. 1um Format 86, 118, 179. 181 
number line 141 
numeric formats 86 

new86 
preset 86 

objects 10 
object class 206 
Object Classes 205 

Offset 127 
Offset dialog 128, 186 
on-line help 52 
Open 154 
Open command 19 
Open Window 79, 105, 130, 

187 
Operands 134 
Operators 134, 188 
Options 96, 99, 101, 102, 104, 

116. 125,129,132,133,167, 
173 

OR 197 
overlaid graphs 52, 115 

Page Setup 154 
palerre 11, 108, 120, 122, 124, 

128,130.131, 132. 133,198 
commands 198, 199, 200 
measures 198, 201 
modes 201 
moving 11, 28, 198 
pattern 201 
selectors 198, 199 
tools 198, 202 
zoom box 11, 24, 41, 108, 

198 
Paste 86. 159 
Pattern 120, 128 
Percent 0. Percent 2 181 
Percent of Tot 181 
percentages 96 
PI 191 
PICT file 129. 158 
Pie Size 127 
Place Graph 132. 17 1 

placement frame 9. 104, 177, 
204. 213 

selecting 71 
PMT 196 
PolyFit 190 
power selection keys 10. 205 

modifier keys 206 
Preferences 158 

Preferences dialog 53. 114. 
120,158 

Print 108, 133, 154 
PY 196 

quadratic curve fit 103 
Quit 159 

ramped color 
direction 123 
patterns with 123 

RAND 191 
RA\'g 188 
Recalc 164 
Recalc Now 164 
recalculation 

automatic 95 
manual 84 

records, 8 
copying 86 
cutting 86 
duplicating 87 
finding 88 
moving 88 
pasting 87 
searching 89 
selecting 15, 21, 35. 37, 91 
sorting 20 

multiple fields 88 
summarizing 89 

registered user, becoming 5 
Remove Layer 115. 175 
Reser Attributes 67. 129, 176 
Reset Graph Order 176 
Reset Location 11 O. 176 
resizing 10 

modifier keys 112 
symmetrically 111, 202 
using arrow keys 112 

Return 81 
Revert To Saved 154 
Right 177 
RLag 179 
RLagOl.1 189 
Rotation 119. 178. 179 
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ROUND 192 
Round Corners 126, 185 
RunAverage 189 
Running % 182 
Running Tot 182 
nmning totals 95 
RunTotal 189 

Same as Field 181 
Same Points As Graph 103. 

184 
Save 154 
Save As 19, 54, 154 
Save PICT 129, 154 
Save Stationery 154 · 
scale 150 
scatter chart 102 
Sci2, Sci4 181 
Search 88, 162, 164 
searching 51 
Second Independent Axis 214 
second independent field 92 

defining 35, 92 
second tutorial file 54 
Select All 106, 177 
selecting fields 9 
selecting graph objects 10 
selecting range of records 9 
Send to Back 116, 177 
Setup 132 
Shadow Horiz 128, 185 
Shadow Vert 128, 185 
Show 108, 125, 176 
SIN 193 
Singular Objects 206 
Size 178 
Sizes dialog 64 
slices 145 
Sort 88, 162, 163 
sort cursor 88 
sorting 51 
Special Menus 188 
SQRT 192 
stacked bars 145 
Stagger 118. 182 

standard deviation 89 
statistical functions 89 
Style 178 
Subtraction 196 
Summarize 161 
Surround Shadow 128, 185 
Swap Graph Layers 115, 175 
SYLK 90, 157 

Tab 81 
tab-delimited files 85 
tab-delimited text 90 
TAN 193 
technical support line 5 
Template 129,171 
Template dialog 129, 175 
text 121, 178, 199 

changing alignment 57 
enlarging 56 
formatting in the graph 

window23 
selecting 70 
underlining 23, 38 

text-only files 85 
text tool 119 
Tick Length 124, 183 
Tick Position 124, 183 
ticks 

· adjusting 113 
hiding 62, 66 
minimum spacing 114 
selecting 57, 62, 66, 75 
widening 57, 75 

Title 177, 178 
To Grid 176 
TODAY 194 
Top 176 
total 89 
transforms 137, 138, 188, 1_89 

building your own 104, 
138 

parameters 102, 103 
recalculating 84 

Transpose 94,111,174 
transposing axes 52. 111 

in the data window 94 
in the graph window 61. 

113 
Trig Fens 193 
TRUE 191, 196 
tutorial 

length to complete 18 
Tutorial file 19 

underline 
toggling off 56 

Undo 87, 159 
undo buffer 207 
Use Major Count 103, 184 
Use Minor Count 103, 184 
Use Size 103, 184 

Value 181 
\ ertical (y) axis 92, 94, 150, 

214 
labeling 152 

wedges 145 
WEEKDAY 195 
what-if analyses 87 
Window 104, 116, 131, 132, 133, 

167,168.187 
Window Info dialog 104, 116, 

132,133,168 
windows and icons 6 
WKS 90, 156, 157 

x axis 213, 214 

y axis 212, 214 
YEAR 195 

ZDiff 189 
zones 67, 101 
Zoom 116, 130, 131, 187 
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~ _J! ij MacGraphX MacGraphX 
Quick Reference Card Quick Reference Card 

Selecting records and fields 
Shift Extends selection 
Command Toggles selections 
Option-Shift Sorts by field; moves records 
Option Second independent field 

Click "Recs#"to select all records. 
Double-dick on field name for Fields dialog. 

Cursors in the Data Window 

~ 
~ 
■ 

■ 

Record Selector 

All Record Selector 

Dependent (Y) Field Selector 

Independent (X) Field Selector 

2nd Independent (X2) Field Selector 

~ ~ Column Width Resizer 

I; Sort Field/Move Rows 

Selecting graph items 
Shift Add to selection 

Constrains move (vert, horiz, diag) 
Grows rectangle to square 

Command Unlinks frames (move and grow) 
Option Grows symmetrically 
Option-Shift Grows symmetrically (four-way) 

Select handle (dark box) to grow. □ 
Select off the handle to move. 

Resizing graph items with arrow keys 
Option Resize item from lower-right corner. 
Shift Resize item from top-left corner. 
Shift-Option Resizes item symmetically from 

lower-right corner. 

©1990 Bravo Technologies, Inc. All Rights Reserved. 

Selecting records and fields 
Shift Extends selection 
Command Toggles selections 
Option-Shift Sorts by field; moves records 
Option Second independent field 

Click "Recs#"to select all records. 
Double-dick on field name for Fields dialog. 

Cursors in the Data Window 
~ Record Selector 

~ All Record Selector 
■ 

■ 
Dependent (Y) Field Selector 

Independent (X) Field Selector 

2nd Independent (X2) Field Selector 

~ ~ Column Width Resizer 

I; Sort Field/Move Rows 

Selecting graph items 
Shift Add to selection 

Constrains move (vert, horiz, diag) 
Grows rectangle to square 

Command Unlinks frames (move and grow) 
Option Grows symmetrically 
Option-Shift Grows symmetrically (four-way) 

Select handle (dark box) to grow. □ 
Select off the handle to move. 

Resizing graph items with arrow keys 
Option Resize item from lower-right comer. 
Shift Resize item from top-left corner. 
Shift-Option Resizes item symmetically from 

lower-right corner. 

©1990 Bravo Technologies, Inc. All Rights Reserved. 



i Power Menu Command Keys ' I 
I Selection Keys File Graph I 
I N New 1 Scatter I Object Classes 
I 0 Open 2 Line 

g Grid s Save 3 Area 
b Baseline p Print 4 Bar 
1 Label Q Quit 5 Stacked Bar 
a Axis L Load All 6 Pie 
l Ticks Edit 7 Table 
Modifiers z Undo 0 Blank [Draw] 
d Dependent X Cut I Swap Layers 
i Independent C Copy T Transpose 

Major [under '>'] V Paste Objects 
I B Clear [ Show Minor [under '<'] D Duplicate 1 Hide 
n Near I Insert G Grow To Frame 

' f Far K Delete H Bring to Front 
' X x direction (horiz) R Fill Recs J Send to Back 

y y direction (vert) = Recalc Now Window 
Objects F Fields 
p Placement Frame 
[ Graph Frame -I l Data Frame (j] white I k Key (Legend) 
e Title 
h hi (of hi-lo/error bar) • black 

w low (of hi-lo/error bar) I clear 
1...9 fields 1-9 -

i1mmmm1 Pa I et te mmme:Jm 

"C P M 
C P M 

. C PM 
C 

:c 
C PM 

lillll 
Line 
Drop 
Text 
nark 
Bkgd 

Fld•1 

Left :387 
Width :85 

□Grid 

I 1 I ► 

□ Fast 
Color 

11111111111 ► 
Pattern Mode 

■►lIJ ► 

Top :51 
Height :19 

~► 

W Close 
? Help 

Background 
Mode (Color} 

Draw 

m Tools 
Point 

T Text 

D Rect 

0 Oval 

0 Rnd rect 

/ Line 

;, Arrow 

Power Menu Command Keys 
Selection Keys File Graph 

Object Classes N New 1 Scatter 

Grid 
0 Open 2 Line g s Save 3 Area 

b Baseline p Print 4 Bar 
1 Label Q Quit 5 Stacked Bar 
a Axis L Load All 6 Pie 
t Ticks Edit 7 Table 
Modifiers z Undo 0 Blank [Draw] 
d Dependent X Cut I Swap Layers 
i Independent C Copy T Transpose 

Major [under'>'] V Paste Objects 

Minor [under'<'] 
B Clear [ Show 
D Duplicate 1 Hide 

n ear I Insert G Grow To Frame 
f Far K Delete H Bring to Front 
X x direction (horiz) R Fill Recs J Send to Back 
y y direction (vert) = Recalc Now Window 
Objects F Fields w Close 
p Placement Frame ? Help 
I Graph Frame 

(j] l Data Frame white Background 
k Key (Legend) Mode (Color} 
e Title G black 
h hi (of hi-lo/error bar) 
w low (of hi-lo/error bar) ~ clear 
1...9 fields 1-9 - Draw 

mimmiim Pa I et te imiime:Jm m Tools 
Point 

C p M 
C p M 
C p M 

lillll □Fast 

Line Color 

11111111111 ► Drop 
T Text 

C 
C 
C p M 

()I ii 11 d~~ 

Text Pattern Mode 
nark 

■►lIJ ► Bkgd 

F1d•1 

D Rect 

0 Oval 

0 Rnd rect 
Left :387 Top :51 
Width :85 Height :19 / Line 
□Grid ~► I 1 I ► ;, Arrow 

-

~ 
~ 
~ 
~ 
~ 

L-

atu. L 

~ 

~ 



::Ji rz~· 
: rn rs3_ 
L.11 I 

CD~ 
I~ K:"-, 
H 

_J 

'.__J IC~ 
I - ~ I 

I ;__ ___ -

Help & Troubleshooting 
If you experience difficulties when using MacGraphX, try these 
remedies: 

• See the Appendix for a list of error messages and possible 
solutions. 

• Use the on-line help. Double-click on the help window's icon 
in the docking window to bring the help window to the 
foreground. Scroll through the topics presented to find one 
appropriate to the situation. 

• Read the manual. Work through the tutorial again. Skim 
through the table of contents and the index to locate a topic 
appropriate to the problem. 

• If all else fails, call Bravo Technologies' technical support 
line at 415/841-8552, Monday through Friday from 10 a.m. to 5 
p.m. Pacific Standard Time. Have your MacGraphX serial 
number handy. 

Name ______________ _ 
Company ____________ _ 
Address _____________ _ 

Bravo Technologies, Inc. 
P.O. Box 10078 
Berkeley, CA 94709-0078 

Attn: MacGraphX registration 

Place 
Stamp 
Here 



The Fine Print: Copyright & Warranty Information 

B}' opening and using the diskene which contains the MacGr.iphX.,." software, you agree to be bound by the following terms and conditions: 

Copyright 
TI1e software an<l <locumcntation that you now own arc copynghts of Bravo Technologies. Inc. As wi1h a1hcr copyrigh1e<l works. you may not copy 

or rl·produce in any fashion, nor tr.insbtc into anolhcr fom1a1, medium. or language. in whole or in part. the software or <lo umcntation. Br.1vo 

Technologies, Inc., is, of course, grJnling you a license lo cx,:cu1c 1hc sof1warc on your compull'r, in whosc m,:mory 1he progrJm will 1cmpor.1rily r,:sid,:. 

llfacGraphX is nol cop)•-pro1cc1e<l. :ind you arc also gr:1n1,:<l a liccns,: 10 make one backup copy of 1hc program. I lowcvcr, 1he cop)•righl notice (as 

appears on the original disk,:nc) musl app,:ar on all p,:rsonal backup copi,:s so mad,:, and the,e copks should bc lrl'31l'd in the same: fashion as thc 

original softwar,:. Oth,:r 1han th,: limitcd licl·nses we granted you :ihovc. Br.,vo rcscrv,:, and will enforce all of i1s righ1s in 1hc ,of1w:1rc an<l the manual. 

including seeking criminal pcn:illies for its misusc. 

In no case should more than one uscr exccule 1hc software that you purch:1scd at th<: s.,m<: 1im<:: M;icGraphX should 1101 bc us,:d by more 1han one 

person al a liml' over:, shared or nc1workt:d sysll'm, nor should morl' th;in om: copy (original or hackup) he u,cd on diffcrc·nl compulcrs al lhl· ,:1111c lime. 

If the software leaves your po_ssession (s,:lling. giving aw:1y. or lending a copy of 1hc progr.1111). all olhl'r copil'S should bt: cks1royl'd. 

Warranty 
If you discon:r physical defcc1s in the diskcll<: within 1ht: first sixty days aftl'r purchasing lhl' producl. Br:1vo Technologu:s. Inc., will rq1l:1cc 1hc.: 

dl'fl'<'li\'l' il<:m: relum the item along with proof of purchase. O1herwise, this sof1ware is sold ·as is": 13rJ o has l<:slcd the:. of1w:1rc and rcvicwed 1hc 

documcm:ition, but 0r:1vo makes no warranty or rcprcscntalion. either <:xpress or implied, rcgarding the sof1warc', or documcn1:11ion's quali1y. 

p,,rfomunn,. merchantability, or fitness for a panicular purpose. In no event shall Bravo b" liahlc for any <lirc:ct. in<lire 1. spc·cial. incidental. or 

consequl'nti:il damages or lost profits r<:suhing from :1ny dcfccl in lht: softw:irc, diskcnc, or manual. even if advised of the.: pos,ibility of such dam:igt:s. 

0r.l\'o's liabili1y for d:imagcs lo users of the:: progrJm shall in no C:ISl' cxct:ed thc amount paid by the user for 1hc product. In particular. 13r:wo shall have 

no liability for any programs or d:11a SlorL-<l in use with this program, including thl' cos1 of recovering such progrJm. or d:ita Tho.: w:ur.1n1y and rcmed,cs 

sci fonh herein art: cxclusi\'t: and in lieu of all 01hcrs, orJI or wrincn. <:xprt'SS<:d or implied. No llr.1vo dcaler. agcn1. or cmploycc· is :1u1horiwd to make· :iny 

modification. addition, or extension to this warrJnly. Some s1:i1cs do not allow the exclusion or limi1:i1ion of implied warr:inlic:s or li:ibilit)' for incitkn1:1I 

or consequential damages, so th<: above limilation or exclusion may not apply lo you. This warran1y gin·s you specific lt:gal righ1s. and you may also h:ivc 

other righ1s which vary from s1:1tc to stale. 
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